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This Guide is a work in progress. 
 
Your feedback would be highly appreciated (maria.machado@ec.europa.eu)! 
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The European Commission has been promoting the use — and sharing — of open-source software within its Framework 
Programmes on Research and Technological Development — 7th FP and presently Horizon 2020 — as research 
applications developed with EU co-financing must, in many cases, be made available as FOSS. Of particular interest to 
translation, are the projects in the field of Machine Translation and CAT tools like Moses (Euromatrix(Plus), MosesCore), 
MateCat and Casmacat. 
The European Commission Open Source Strategy also stresses that “the Commission services will increasingly 
participate in open source software communities to build on the open source building blocks which are used in the 
Commission's software”. It is therefore in this context that open-source applications like OmegaT are being used in DGT. 
OmegaT (OT) is a free open-source CAT Tool that was developed, by private initiative, originally by Keith Godfrey in 
2000 and that has been vastly improved since then with many contributions (see OmegaT→ Help → About for a list of 
contributors). Didier Briel is its present project manager. OmegaT is now the leader open-source CAT tool. 
OmegaT was used by DGT in 2012 for prototyping prior to the acquisition of a commercial CAT tool at the end of that 
year.  For that purpose, the 2.6.0._3 version of OmegaT was customized and extended to integrate other DGT tools.  
This version of OmegaT is internally referred to as DGT-OmegaT to differentiate it from the public version. Furthermore, 
DGT developed in-house the OmegaT Project Wizard to integrate OmegaT in its workflow. 
In June 2012, DGT-OmegaT and its Project Wizard were made available to all DGT translators interested in trying/using 
it and it has been used by some translators ever since as an alternative to the main DGT CAT tool. 

 

http://ec.europa.eu/research/fp7/index_en.cfm
https://ec.europa.eu/programmes/horizon2020/
http://ec.europa.eu/dgs/informatics/oss_tech/index_en.htm
http://en.wikipedia.org/wiki/OmegaT
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Because DGT-OmegaT has some variations compared to the public version, I wrote a guide to take into consideration 
OmegaT’s in-house new/improved/adapted features and its Project Wizard and also DGT’s workflow and work methods.  
In the meantime DGT has updated its OmegaT version with the 3.1.2 public version and developed in-house the 
TeamBase application which allows the sharing of project memories among translators who can be using either of the 
CAT tools available in DGT.  
So this Guide is now updated to include all the changes and improvements (DGT-OmegaT-3.1.2_3+DGT Extensions 2.3. 
beta update 5).  
To reflect its widened scope, it has also been renamed DGT-OmegaT, its Project Wizard and DGT’s CAT Environment 
— A Translator’s Guide to stress that a CAT tool is just a part of an integrated working environment. 
As the Guide has grown quite a lot — both in scope and size — mainly due to a substantial number of OT new features, 
I also wrote a Quick Guide that can be accessed via the DGT-OmegaT Project Wizard or here.  

 I had also  posted 3 videos  for the 2012 version of DGT-OmegaT (50 minutes on the whole: Video 1, Video 2 and 
Video 3 — DGT-OMEGAT and its Project Wizard in a nutshell) as it is so much easier to show than to explain!  
A substantial part of the videos continues to apply to the new version of DGT-OmegaT. 
 

If you wish to try/use DGT-OmegaT, you can install it from here. Just select this application and click on Install to have 
the latest release of the DGT-customized OmegaT — that includes the Project Wizard and TeamBase — installed in your 
service PC/laptop in a few minutes.  
Furthermore, if you are not a teleworker, but you would like to be able to work at home in your private computer — as I 
sometimes do — you can simply copy/paste DGT-OmegaT to it (or ask for help to do it), taking into consideration, of 
course, that you won’t have access to DGT databases.  
As it is a free open-source CAT tool, there are no extra licence costs involved.  
 

You can request HelpDesk support from the IT Unit as for any other DGT application. 
You can also request training. 
 

The main purpose of this Guide is to introduce DGT translators to DGT-OmegaT and its Wizard in the perspective of 
DGT workflow and work methods. 
This Guide aims to give detailed information about DGT-OmegaT’s features, highlighting those I consider more important 
for translators in our working environment and — hopefully — to help you to easily translate your (single or 
multi-document) projects taking full advantage of its powerful features.  
But this Guide is also meant to be useful for DGT newly recruited translators or trainees who are not familiar with DGT 
workflow and/or any CAT tool. Therefore, it also gives an overview of DGT’s CAT Environment and suggestions on how 
to make the best use of the resources available. 
As this Guide is meant for “absolute beginners” — both in terms of CAT tools and DGT CAT environment — I hope DGT 
old-timers and CAT tool advanced users will forgive me for explaining what may be (for some/many) so obvious…  
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I present here my personal view after using DGT-OmegaT for 3 years in all my translations. However, take into 
consideration that I translate mainly Word, and sometimes Excel and PowerPoint, documents and therefore I have no 
experience with formats like the ones used, for instance, for web pages.  
In this Guide, I assume that you have read the Quick Guide and therefore have a general idea of how to work 
with DGT-OmegaT, its Wizard and TeamBase. The Quick Guide may even be enough if you prefer to keep to the 
essentials.  
However, for large and complex projects, it may be worthwhile to take the time to get more detailed information, at least 
about the features that are (more) important to you.  
Considering that the bulk of my work is translating large multi-document projects, I give a lot of attention to the 
management of complex projects in this Guide.  
As in DGT we have the privilege of having an IT Unit that takes care of all the technical details — installation, plugins, 
scripts, defaults, compatibility, etc. — this Guide focus merely on the translation process and reflects the way I use 
OmegaT to translate documents in Office format — which are the huge majority of documents translated in DGT — and 
of course it is not meant to cover every feature and possible use of OmegaT. 
For this Guide to make sense on its own, it is necessary to repeat basic information already given in the Quick Guide, 
which is further developed in the relevant detailed sections. 
Considering that the preparation and management of projects is very important to make your work easier, I reorganised 
the update of this Guide following a different approach, by starting with the basics and gradually giving more detailed 
information in thematic sections so that you can choose the level of detail you are interested in according to your needs.  
The main parts are: 

Ø An overview of DGT’s CAT Environment  
Ø An overview of DGT-OmegaT main features and how to work with OmegaT and its Wizard  
Ø Detailed information concerning the DGT-OT project structure  
Ø Information about the preparation, creation, update and general management of projects, working in shared 

mode with other translators in real time (TeamBase) and revising with DGT-OT 
Ø A section on “Menus Explained” so that you can have a quick snapshot of all the features available in 

DGT-OT menus, with shortcuts and icons  
Ø Thematic sections on how to explore OmegaT’s features: translation memories and machine translation, 

search features (concordance), terminology, notes, auto-completion, formatting/tags, spellchecker, language 
checker and quality assurance, revision process with variants and attributes customization 

Ø A section on troubleshooting — although OT is a fairly stable and trouble-free application — and a list of 
shortcuts 

Ø An Annex on Machine Translation — taken from the Moses for Mere Moses Tutorial — which gives a general 
view of what Statistical Machine Translation is about, so that you have an idea why Machine Translation 
output is sometimes so surprisingly good … and other times pure rubbish! 

As with OmegaT you can manage very large projects with many documents, many memories and large glossaries, it 
may be really worthwhile for you to explore its full potential, so much so that there are no speed or capacity problems in 
handling them with OmegaT in our service computers. 

 

https://en.wikipedia.org/wiki/Moses_for_Mere_Mortals
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I use some symbols in this Guide to call your attention to certain aspects. 

 To mark features which are fully DGT-specific or have only some adaptations/improvement as compared to the 
public version. It is also used to mark applications (linguistic or documental) which are developed by EU 
institutions. 

 To indicate that it is a feature that is new in DGT-OmegaT 2014 (either DGT-specific or not) as compared to 
DGT-OmegaT 2012, be it a completely new feature or an improvement on an existing feature.  

 
 To indicate that there is further information in another section of the present Guide or on the Internet.  

 

 To indicate that it is a tip or personal comment.  
 

 To indicate that you should pay attention to a particular detail. 

 Troubleshooting: Simple ways to solve problems … hopefully! 
 

DGT-OT Guides (available via the DGT-OT Wizard): 
Ø The DGT-OmegaT-2014 and its Project Wizard — Quick Guide 
Ø DGT-OmegaT 2014, its Project Wizard and DGT’s CAT Environment — A Translator’s Guide (the present 

Guide), which updates the 2012 version. 
Ø DGT-OmegaT and its Project Wizard — A Translator’s Guide (2012). For translators who were already using the 

2012 version and might want to look at it. 
For more information on the public OmegaT features or on features not (sufficiently) covered in this Guide: 
Ø Public OmegaT Guides (available via the DGT-OT Wizard and in the public OmegaT website): 
q OmegaT 3.0 — User's Guide by Vito Smolej (the Guide in the OmegaT Help in pdf format for easier 

consultation) 
q OmegaT for CAT Beginners by Susan Welsh & Marc Prior 

 
Ø Public sources:  
q The public OmegaT website and its very active User Group 
q The OmegaT documentation page also gives you further information on available guides, training videos, 

blogs, etc.  

Take into consideration that DGT-OmegaT has substantial adaptations!  
 

 

http://www.omegat.org/en/documentation.php
http://www.omegat.org/en/tutorial/OmegaT%20for%20Beginners.pdf
http://www.omegat.org/en/omegat.html
https://groups.yahoo.com/neo/groups/omegat/info
http://www.omegat.org/en/documentation.php
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Because I think people are important, I would like to thank: 

Ø First of all Didier Briel and the developers of OmegaT for their remarkable work and for being so attentive 
to translator’s needs… most of them being translators themselves! 

For a list of developers/contributors, see in OmegaT: Help → About OmegaT 

Ø The enthusiasts that publish information, guides and videos that have helped me a lot to understand how 
OT works and made possible this Guide, namely Vito Smolej, Susan Welsh and Marc Prior, Roman 
Mironov, Kos Ivantsov and the many contributors in the OmegaT User Group. 

Ø In DGT: 
v Rytis Martikonis, DGT Director-General, and Dieter Rummel, Head of DGT IT Unit, for being 

open-minded 
v Colleagues from the Informatics Unit:  
§ Alfons de Vuyst, Head of Operational Support and project leader 
§ Thomas Cordonnier, the developer of the adaptations of the public versions of OmegaT to 

DGT and of improvements to the public version 
§ Elio Fedele, the developer of DGT-OmegaT Project Wizard and the Clean Tag/TagWipe 

application 
§ João Rosas, who gave operational support to the testing of OmegaT and worked in the 

development of the CleanTag/TagWipe application. He is also the developer of the Moses for 
Mere Mortals scripts 

v Colleagues from the Portuguese Language Department: for their interest, feedback and questions, 
which allowed me to pinpoint what is more important for a (new) user in our working environment ... 
and also to “discover” features I hadn't noticed before ... and especially:  
§ Hilario Leal Fontes, who was also tester of OmegaT and who contributed a lot to this Guide, 

namely to the Section on Regular Expressions. 
§ Mário Vilar, Helena Lopes dos Santos and Anabela Pombo Rodrigues. 
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In this Section you will find a list of the new features of the present version of the public OmegaT (3.1.2.) and also of 
those that have been added, improved or adapted to integrate it in DGT environment, both in relation to the 2012 
implementation of OmegaT in DGT. 
The DGT-specific new/improved/adapted features are identified with the DGT logo in this list and throughout this Guide. 

 If you look for information in the public OmegaT Guides, take into consideration that some features are different 
in DGT-OmegaT. 

In this Section you also find a list of the applications directly linked to OmegaT which are DGT-specific and are new or 
improved. 
 

 DGT  applications Short description 

 DGT-OmegaT Project 
Wizard 

Integrates OmegaT in DGT workflow by making the link between 
Tradesk, Windows Explorer and DGT-OmegaT. It allows to easily 
create and update multi-document projects with translation 
memories and IATE extractions. Vastly improved from the 2012 
version.   

 TeamBase New server application to share project memories in real time in 
read or read/write mode. 

 TagWipe A tag cleaning script developed in-house for Word documents to 
eliminate useless inline tags. It has been improved from the 2012 
version. 

 
 Project folder — 

Preferences  
Short description 

 _CONFIG-PERSONAL 
folder 

This folder is automatically created — under the OmegaT_Projects 
folder — when DGT-OmegaT is installed. 

 Omegat.prefs and 
uiLayout 

Your preferences are stored in the _CONFIG-PERSONAL folder to be 
easily accessible to you. 

 learned_words and 
ignored_words 

These personal “dictionary” files are also stored in the 
_CONFIG-PERSONAL folder to be easily accessible to you for 
editing. 

 search-memorize List of memorized terms or regular expressions. This file is stored 
in the _CONFIG-PERSONAL folder to be easily accessible to you for 
editing. 

   

 
 Toolbar Short description 

 New icon — IATE Besides the 20 DGT icons — three of which for DGT applications — 
there is now a direct link to IATE full-fledged interface. 
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 Editor pane Short description 

 Improved colour 
markings for 100% and 
below 100% matches 
and MT 

Yellow background colour for below 100% match (now a different 
shade) and green background colour for 100% matches (also a 
different shade). The MT is marked with a grey background as 
before and the TRA/source/Match information remains the same. 
A new feature is that the changes made by the translator (while 
the segment is not validated) are no longer highlighted, thereby 
calling the attention to the parts that were not changed. 

 Auto-populated 
segments from external 
TMXs colour-coded (in 
orange) 

Auto-populated (pre-translated) segments are displayed in the 
Editor with an orange background if the options Save 
Auto-populated status in the Editing Behaviour menu and Mark 
auto-populated segments in the View menu are activated. 

 Display of a second 
source language in the 
Editor (tmx2source) 

Used to help translating from a relay language or to easily view 
terminology in a different target language for reference. 

 Mark segments for 
revision (in red) 

Segments with a login different from the user’s login are displayed 
with a red background if — in the View menu — this option is 
ticked. This option automatically adds View diff in target in the 
Options → External TMXs menu so that track-changes are 
displayed in the target segments in the Fuzzy Matches pane. Used 
for the revision stage. 

 Go To Next/Previous 
Revised Segment 

Allows to quickly go to segments with an ID other than the login of 
the user. Used for the revision stage. Shortcuts: Ctrl+Shift+X/Y. 

 The order of documents 
can be changed 

The order in which the documents for translation are displayed in 
the Editor can be changed in Project menu → Project Files.  

 Segment open for 
translation 

When reopening a project, OT opens the last segment that had 
been edited in the previous session in that project, if any. 

 

 Fuzzy Matches Short description 

 Track-changes Improved display (before it was compare differences) 

 Track-changes in target Option to select track changes in source (default) and also in target 
or in both in the Options → External TMXs: View diff in source and 
View diff in target 

 Order of matches display There are now 3 options: Full text including tags and numbers 
(default); Stemming, no tags and no numbers; No tags and no 
numbers. 

 Repeated segment  
Found in 

In the Fuzzy Matches pane you can also have information about 
the number of occurrences of a particular segment in the external 
translation memories — and also in the project memory — in a 
dropdown menu which lists the memories where that segment 
occurs. 

 Match display template 
— Configure format 

Attributes to be displayed with the segment in the Fuzzy Matches 
pane — which already existed in the OT public version and in 
DGT-OT 2012 — have been improved with new template variables. 
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 View project documents Short description 

 View the source 
document with shortcut 

Already available in the DGT-OT 2012 but without shortcut 
(Ctrl+Shift+H)  

 View the current target 
document with shortcut 

New feature. It automatically creates the current translated 
document and opens it in its native application  
(Shortcut: Ctrl+Shift+G) 

   

 
 Search features Short description 

 Redesigned window The DGT-OT 2012 Search window had been redesigned with new 
features (strings, whole words and lemmas), Search In Source and 
In translation and the possibility of customizing the segment 
attributes (as for the Fuzzy Matches). The Search Directory feature 
had also been separated from it. 

Now in DGT-OT 2014 the Search feature has been further improved 
(see features below) 

 Translated and/or 
untranslated fields 

It is possible to set the search to translated or untranslated 
segments or both. 

 Boolean NOT Besides searching in In Source and In translation with the Boolean 
AND or OR, it is now possible to use the Boolean NOT in the fields: 
In source, In translation, In notes, Author and Translator 

 Glossary It is now possible to Search in the glossaries of the project 

 Notes It is now possible to Search in the notes, if any, of the project 
memory and of the external translation memories.  

 Translator field A new field Translator which allows differentiating between the 
Author of a tmx (which may be the translator or the assistant who 
post-aligned that document) and the translator.  

 Search by file or folder 
field 

It is now possible to limit the search to one memory (tmx) file or to 
a folder with several tmx files, by writing/copying its path and 
name to this field. 

 Memorize It is now possible to memorize searches — for the session, the 
project or all projects — in the fields: In source, In translation, In 
notes, in Search Scope, Author and Translator and for Regular 
Expressions and File or folder. 

 List of memorized 
Regular Expressions 

When DGT-OT is installed, there is already a list of commonly used 
Regular Expressions memorized for all projects for the In source 
field. 

 Match display template 
— Configure format 

Attributes to be displayed with the segment in the Search window 
— which already existed in DGT-OT 2012 — have been improved 
with new template variables. 
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 Search and Pre-Translate Short description 

  This is a brand new DGT-specific feature. 

 From Source Allows searching by some criteria and pre-translating the resulting 
segments by copying source to target. 

 From Match Allows searching by some criteria and pre-translating the resulting 
segments with external memories matches. The match threshold for 
pre-translation can be defined. 

 From Machine 
Translation 

Allows searching by some criteria and pre-translating the resulting 
segments with machine translation output.  

  

 
 

 Search Directory Short description 

 Redesigned Search 
Directory 

In the DGT 2012 version, it was already a separate window. Now it 
has been improved. 

 

 Scripting Short description 

  Brand new OT feature which allows using scripts developed by the 
open-source community around OmegaT. Some have been included in 
DGT-OT or can be selected. See below. 

 Individual project 
memories for Euramis — 
Create Euramis Export 

A DGT adaptation of the publicly available script write_sel_files2TMX 
allows exporting memories by document (without notes and 
alternative translations) with the DGT attributes required to be sent to 
Euramis. Generated by pressing Ctrl+Shift+F8 and selecting the 
documents to have memories exported from. 

 Individual project 
memories for revision 
purposes — Create 
OmegaT Export 

A DGT adaptation of the publicly available script write_sel_files2TMX 
allows exporting memories by document (with notes and alternative 
translations). Used in DGT for the revision process. Generated by 
pressing Ctrl+Shift+F9 and selecting the documents to have memories 
exported from. 

 Open Project Folder Allows opening the project folder from within OmegaT.  
Shortcut: Ctrl+Shift+F1. 

 Open Glossary Allows opening the writable glossary for editing in Notepad++. 
Shortcut: Ctrl+Shift+F2. 

 QA — Check Rules Allows carrying out a series of quality checks for the whole project 
or for the current document. Shortcut: Ctrl+Shift+F3. 

 Show Same Segments Displays a list of segments with source identical to target. 
Shortcut: Ctrl+Shift+F4. 

 Strip tags Removes tags from matches in the target segment in the Editor. 
Shortcut: Ctrl+Shift+F5. 

 Write Notes to File Allows extracting notes to an html file for processing.  
Shortcut: Ctrl+Shift+F6 

 Spellcheck Allows spellchecking in batch in the whole project or in the current 
document. Shortcut: Ctrl+Shift+F7. 

 Write Query Notes to File Allows extracting selected notes to an html file for processing. 
Shortcut: Ctrl+Shift+F10. 
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 Glossaries Short description 

 Target term from the 
project writable glossary 
in bold 

The target term of the writable glossary entries is displayed in bold 
in the Glossary pane. 

 Improved display of 
glossary entries 

The source terms are displayed in blue, the target terms in green 
and the 3rd field in black characters. The third field is now 
displayed together with the respective target term.  

 Entries in alphabetical 
order 

Entries after the writable glossaries entries are displayed in 
alphabetical order. 

 Filtered IATE glossary When creating a project with the DGT-OT Wizard, a filtered 
extraction from IATE is automatically copied to the project 
\glossary folder. 

   

 
 Auto-completion Short description 

  Brand new public OT feature. 

 From Glossary It is possible to use the project glossaries for auto-completion. 

 From Auto-text It is possible to create and use abbreviations for 
auto-completion. 

 From Character table It is possible to insert character/symbols from a (customized) list. 

 From tags Tags can also be inserted selecting them from a dropdown menu 
 

 Tags Short description 

 Insert next missing tag New feature which allows to easily insert (first or) next tags one 
by one. Shortcut: Ctlr+T 

 Validate tags for current 
document 

Now tag validation can be also done for only the current 
document. 

 Tag validation improved The listing of tag mismatches has been improved. 
 

 Statistics Short description 

 Match Statistics per File OT now also provides match statistics for each document with 
the indication of repetitions in documents and between 
documents, thereby giving an immediate snapshot of the work 
involved in each of the documents 

 OT_Stats excel sheet Excel sheet where you can manually copy/record your progress 
in the translation of your project. Can be accessed via the 
DGT-OT Wizard (Stats) or from OT. 
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Translating in the 21st century is — as everything in life now — an activity that integrates a whole series of (IT) resources 
and applications. Therefore, we cannot look at a CAT Tool isolated from the environment in which it is — in a certain way 
— the “maestro” interlinking with other applications, frequently in real-time. 
So to efficiently translate and manage projects using OmegaT in DGT context, it is worthwhile to know its working 
environment as when you translate you are — or can be — in fact using a range of language applications and 
documental resources that you can optimise in different ways. 
Knowing what is available — and their advantages and shortcomings — can contribute a lot to the quality of life of a 
translator! 
So, let’s first have a brief look at DGT’s CAT Environment and the “building blocks” that are used in your daily work and 
which are, to different degrees, integrated with or linked to DGT-OmegaT and/or its Wizard. 

General information on DGT’s CAT Environment: Translation tools and workflow 

 Detailed Index at the end of this Guide with clickable links. 
 

 Studio is the main CAT tool in DGT since 2013 when it replaced Trados Translator’s Workbench. It is a standalone 
application that can be used with TeamBase and other applications to allow translators working on a project to share 
memories in real time. 
 

 The CAT Client is the Wizard developed in-house to integrate Studio in DGT’s workflow.  
 

 OmegaT — the main subject of this Guide — is an open-source CAT tool which has been adapted by DGT for 
prototyping purposes. It is a standalone application that can be used with TeamBase to allow translators working on a 
project to share memories in real time. 
It has been made available to translators in June 2012. It is used by some translators as an alternative CAT tool. It is 
internally called DGT-OmegaT as it has some new/improved/adapted features compared to the public version. 
In the present implementation of OmegaT in DGT, (single or multi-document) projects are created locally, but OT also 
allows working on a server or partially redirecting, for instance, project glossaries or external memories subfolders to a 
server while keeping the main project locally in each translator’s computer. 
 

 The DGT-OmegaT Project Wizard (DGT-OT Wizard) — also an important subject in this Guide — is an in-house 
application which integrates OmegaT in DGT’s workflow by making the link between Tradesk, Windows Explorer and 
DGT-OmegaT, thereby making it very easy and fast to perform most of the project management key operations. 
 

http://bookshop.europa.eu/en/translation-tools-and-workflow-pbHC3212080/
http://www.omegat.org/
http://www.omegat.org/
http://www.google.be/url?sa=i&source=images&cd=&cad=rja&docid=VdtTWzJ-fKZJWM&tbnid=iLUwtxjTl-I2MM:&ved=0CAgQjRwwAA&url=http://picpulp.com/smileys/&ei=aBNmUvbIFOSo0QWTwoD4AQ&psig=AFQjCNECCoDImZVBTI-c93KWVUc3FZ86ow&ust=1382507752391183
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TeamBase — also an important subject in this Guide — is an in-house server application that allows translators working 
as a team sharing memories in real time with colleagues who are working on the same or related projects and are either 
using DGT-OmegaT or the main CAT tool.  
 

The old TWB is still used to translate Recast documents as its Commission-specific format is not accepted by the new 
CAT tools used in DGT. It is also used to translate RUE (confidential) documents.  
 

 Tradesk is DGT’s document management system developed in-house which stores the original documents 
to translate, reference material to be used and the ongoing and released translated documents. 
It is the starting point to create or update OT projects with one or several documents and respective translation 
memories and an IATE glossary. 
 

  Euramis is DGT’s Translation Memories repository which stores all the translations done in DGT for more than 
15 years, as well as in some other EU institutions, and from which retrievals and reference documents are extracted in 
tmx format and to which project memories of translated documents are sent also in tmx format.  
At present, the Euramis central memory contains more than 645 million segments covering all EU official languages. 
Euramis is not publicly available but DGT has published two large corpora in tmx format: DGT Translation Memory and 
DGT-Acquis 

Joint Research Centre website: DGT–Acquis and DGT Translation Memory  
 

 Unlike the public OmegaT, DGT-OmegaT uses machine translation files generated by the in-house MT@EC 
service — based on the Moses open-source Statistical Machine Translation system — which are copied to a separate 
project subfolder (\mt). 

MT@EC: DGT Magazine Languages and Translation 

Moses: Moses and MosesCore research project and TAUS — Machine Translation and Moses Tutorial. 

 IATE (Inter-Active Terminology for Europe) is the EU inter-institutional terminology database. It has been used in 
the EU institutions and agencies since the summer of 2004 for the collection, dissemination and shared management of 
EU-specific terminology. It replaced the old Eurodicautom database — which had been used since 1973 — and 
incorporated all its data. 
IATE contains over 8.4 million terms, including approximately 540 000 abbreviations and 130 000 phrases and covers all 
the 24 EU official languages, as well as Latin. 

Validated entries are made available in the public IATE website and an extraction of it is also made available here. 

https://ec.europa.eu/jrc/en/language-technologies/dgt-acquis
https://ec.europa.eu/jrc/en/language-technologies/dgt-translation-memory
http://ec.europa.eu/dgs/translation/publications/magazines/languagestranslation/documents/issue_06_en.pdf
http://www.statmt.org/moses/?n=Moses.LinksToCorpora
http://www.statmt.org/mosescore/
https://evaluate.taus.net/translate/mosescore/machine-translation-and-moses-tutorial
http://iate.europa.eu/about_IATE.html
http://iate.europa.eu/tbxPageDownload.do
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The operating system currently used in DGT is Windows 7 and the public OmegaT relies mostly on Windows Explorer 
for the management of projects.  
For operations which are not automated via the DGT-OmegaT Project Wizard, Windows Explorer allows to 
copy/paste/move, drag/drop, rename and delete files in a very easy and flexible way.  
In fact, when a project is reopened in OmegaT, it has no “recollection” of how the project was before and just accepts it 
as it is. So any changes made via Windows Explorer are accepted. 
 

 Quest II is a DGT metasearch tool designed to reduce the time it takes translators to find solutions to terminology 
problems by enabling to search, in a single operation, a multitude of DGT’s internal and public terminology sources.  

See profile in Quest interface. 
 

 DocFinder is a DGT application which allows to quickly locate and display an EU official document based on 
references, notably from EU Treaties, legislation and EU bodies’ documents.  
DocFinder is DGT’s implementation of WebExtractor, an application developed in collaboration between Giancarlo 
Piovanelli from the European Economic and Social Committee and João Rosas from DGT. 
 

 Eur-Lex is the online repository of published EU legislation which can be accessed by anyone free of charge here.  
It contains the treaties, secondary legislation and preparatory acts in all the EU official languages, as well as national 
implementing measures and case-law of the Court of Justice of the European Union. It is also possible to consult the 
Official Journal of the European Union. 
 

 Vista is the Commission’s Secretariat-General database that gives access to non-classified Commission 
documents and to related procedural information. Vista is the successor of SGVista.  
SGVista is still available because it contains Council and EP documents as well as interinstitutional files. Vista and 
SGVista are internal systems for Commission staff. 
 

  DGTVista is a DGT document search and viewing engine. It contains all incoming (mainly original texts) and 
outgoing documents (mainly translations) from and to every Commission department since 1994. 
 
 

http://eurlex.europa.eu/
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 Pedit is an in-house Translation Memories Management application which allows the editing of (automatic) 
alignments.  
 

Dragon Dictate or DictaTrans are available and can be used with OmegaT.  
 

 The freeware version of XBench provides simple and powerful Quality Assurance and Terminology Management 
and can be used — as a complement to OmegaT QA features — as it is installed in DGT computers.   
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As the Commission has the power of legislative initiative within the EU, the translation work in DGT is a bit different                          
compared to the other EU institutions.  
Translation work in DGT may be the translation of a one-page press release or a project with a few documents, some 
dozens of pages and involving only 1 translator and 1 reviser. In this case the workflow is very simple.  
However, things can get (much) more complicated with large projects — frequently in (very) technical domains — with 
hundreds (or even thousands) of pages translated over a period of months and frequently with (a high number of) new 
versions while the documents are being translated into (up) to 23 EU official languages. 
These projects usually involve several translators and even several revisers, not to mention that sometimes part of the 
documents in a project may be translated in-house and another part by freelance translators. 
Furthermore, in DGT there is not the bilateral “client — translation provider” relationship in which terminology validation 
is decided once the translation has been accepted by the client. 
DGT is, most of the times, the starting point of legislative proposals. The authors in the Directorate-Generals produce the 
documents, but there are also the lawyer-linguists, the national experts and the Member States representations which 
may be involved, namely in what concerns terminology for sensitive or very technical matters. 
Besides that, legislative proposals have a life of their own and a substantial part may involve a co-decision procedure in 
which the Council and the European Parliament — and of course their respective Translation Services — are involved. 
Terminology — like the language — evolves all the time and, for our work, there is the further complexity of legislation 
and terminology in many domains that evolve in this interinstitutional context.  
So, things are all but straightforward and — as in DGT the translators are the managers of their projects — the flexibility, 
user-friendliness and speed of OmegaT in what concerns, namely, the creation and updating of projects, the prioritising 
of translation memories, the use of machine translation and of small or large glossaries (including IATE extractions), is of 
particular importance to DGT translators. 
 

Nowadays, CAT tools follow a multi-document project approach. You work with projects, which may have one or any 
number of documents in various formats — with hundreds or even thousands of pages on the whole — with their 
respective retrievals and reference document memories (tmx files) from Euramis, MT output, glossaries (an IATE 
extraction), dictionaries, monolingual reference documents and any other material — technical or administrative — you 
may need to translate/manage your project.  
In DGT-OT, the documents are treated in a single project in a speedy way, even when there are successive new versions 
during the translation of the project. Each document is individually identified so that you always know where you are. 
 

The original documents can be: 
v   One, some or all documents of large packages (for example, European Semester, Budget, Rail Package, 

Multiannual Financial Framework) with different dossier and part numbers (Example: RTD-2014-80020-00-00 + 
RTD-2014-80020-00-01 + RTD-2014-80021-00-00 + RTD-2014-80023-00-00). 

v  Documents of dossiers with numerous parts (like a model contract with several parts),  
v  SRC files (typically Excel or PowerPoint files with tables, graphs) to be integrated in Word documents, 
v  New versions of documents (quite frequent), 
v  Several small documents which you may want to gather in a project (like a number of replies to parliamentary 

questions, cartouches) even if unrelated, just to save time, 
v  Any combination of these.  
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If your documents have a subfolder structure, OT will keep it. You can also easily change the order in which OT displays 
the documents of your project in the Editor for translation. 
In the present implementation of DGT-OmegaT, the source Office documents are not converted to xliff format. Therefore 
you have as source files the original documents and OT saves your translation to the project memory. 
 

The documents to translate may be in different formats (Word, Excel, PowerPoint, x(html), etc.), but they will all be 
displayed the same way as “raw” text in the Editor pane. This is now a standard approach in open-source and 
commercial applications and therefore you no longer work with formatted documents.  
 

The Commission has some special formats. With Budget documents, there is no problem, you can use OmegaT. 
However, as the budget documents are pre-treated and partially translated from previous budgets, those documents will 
have to be post-aligned. 
With Recast documents, it is not possible to use OmegaT or DGT main CAT tool and you will have to use the old TWB. 
 

Projects can be easily created locally, directly in OmegaT, in the case of documents that cannot be transmitted via the 
network (SECEM documents). 
 

All the documents in your project are, by default, automatically merged and treated as a project unit. The 
auto-propagation of the translation of identical source segments (non-unique segments) is done automatically in all the 
documents of your project — in a background operation you don’t notice — and those segments are displayed greyed.

Due to the EU requirement that legislative proposals in all language must be publish simultaneously, in DGT there is a 
high percentage of new versions when the translation into (up) to 23 EU official languages is already ongoing.  
In OmegaT, you can update your projects with new versions very easily without the need to create a new project.  
For projects that may have, for example, dozens of documents — and sometimes several new versions for some or all of 
them — and hundreds of pages, the possibility of simply adding the new version and deleting the previous one in a few 
clicks and in a few seconds/minutes makes project management a fast and easy task. 
 

In DGT, sometimes there are documents in 2 (or more) languages. You can translate these multilingual documents in a 
single project without the need to divide the document by source languages. However, the project memory — which will, 
by definition, be multilingual — should not be sent to Euramis. 
 

Due the number of combinations between the 24 EU official languages, sometimes it is necessary to translate 
documents via a relay language or with the help of a relay language. 
With OmegaT you can easily use a relay language as a complement, having both the original language and the relay 
language displayed (one below the other) in the Editor as source segments. This feature may also be useful if you want 
to see how a particular document has been/is being translated into another language, for terminology consistency 
purposes, for instance.  
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OmegaT is a CAT tool which may not be high on looks nor in the myriad of options … but which is very user-friendly and 
simple to use and — surprisingly — very sophisticated in its own way! 
In this Section is given general information on its more important features … that you may want to explore further in the 
relevant detailed sections according to your work method and needs.  

Detailed Index at the end of this Guide with clickable links. 
 

 
Screenshot 1 — OmegaT panes: Editor, Fuzzy Matches, Machine Translation, Glossary, Notes, Multiple 

Translations and also the TransTips (Translation Tips) feature. Dictionary and Comments panes minimized.  
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As in DGT the translators are the managers of their projects, it is important that the management be simple, fast and 
user-friendly. 
The public OmegaT has basic management features. This is not a shortcoming, it is just the approach taken: not to 
duplicate what can be easily done using a File Manager system like Windows Explorer. 
For DGT, this is definitely an advantage because it allows our IT Unit to easily integrate OmegaT in DGT workflow in a 
very flexible way, interlinking with Tradesk and Euramis and other applications. 
For that purpose, DGT developed in-house the DGT-OmegaT Wizard which helps you to quickly manage your projects. 
 

 
Screenshot 2 — DGT-OmegaT Project Wizard window and features 

 
You can also easily work in shared mode (by interlinking with TeamBase), update projects with new original documents / 
new versions of documents already in the project and/or new memories, delete documents/memories from the project, 
add glossaries (e.g. an extraction of IATE), organise translation memories and archive finalized projects. 
The final part of the workflow — sending (ongoing or finished) translated documents to Tradesk and the document 
memories to Euramis — is in the pipeline. But it is simple and fast to do it manually.  
The DGT-OT Wizard also triggers automatic backups (every 10 minutes) of your active project to a server (your space in 
the H: drive) in a background operation you don’t see and without interrupting your work. 
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The DGT-OT Wizard will create the DGT-OmegaT project in a subfolder of the  
C:\Users\{your login}\AppData\Local\DGT\OmegaT_Projects default folder.  

 Make it a favourite in your computer! 
DGT workflow is based on extractions (retrievals) from Euramis and MT output, both available as tmx files via Tradesk. 
The DGT-OT Wizard creates the OT project with the original document(s) ¾ wiping useless tags in the process 
(TagWipe) — and the respective memory (tmx) files available for download in Tradesk: retrievals, aligned reference 
documents and machine translation, if any (pre-processed for EN→ other languages), and also an IATE extraction. 
The DGT-OT Wizard creates the project making TagWipe and segmentation rules project-specific. Therefore, if any of 
them are changed/improved by the IT Unit during the translation of a lengthy project with (many) new versions, there will 
be no change in those rules for your particular project and you won’t have unduly untranslated segments. 
In DGT, the DGT-OT Wizard is the access point to OmegaT (OT it is not accessed directly). 

 
Screenshot 3 — Typical structure of a DGT-OmegaT project also including folders/files created during the 

translation of the project  
 

You can update your project at any time during the translation process with new original documents and/or aligned 
reference memories and glossaries without the need to create a new project… unless you choose to do so.  
If you update your project with new documents or new versions of documents already in the project, when you reopen 
the project, the 100% segments (including formatting) that you had already translated — which are stored in your project 
memory — will be automatically displayed in the Editor pane as translated without any other action on your part. 
You can add as many subfolders as you want to the project folder ¾ for example, to have monolingual reference 
documents which can be used for Search purposes or to gather any other information, either technical or administrative  
¾ but you must not delete or rename any of the subfolders or files that were automatically created for each 
project.  

  If you do, OT may not work properly… or at all!  
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The Open Project Folder feature is a new OT feature that enables you to access the project folder from within OmegaT, 
opening it in Windows Explorer. It is an alternative to using the DGT-OT Wizard for some management operations.  
However, some continue to be best performed — or are really a must! — via the DGT-OmegaT Wizard, namely creating 
and updating projects, working in shared mode in real time (TeamBase) and having automatic backups every 10 
minutes. 

You can share memories in real time using the DGT TeamBase application. With it, you can control when and how you 
want to work in share mode — in read/write or only read mode — depending on your work method.  

 
Screenshot 4 — TeamBase window 

 
With the DGT-OT Wizard, you (or any another translator) can create a TeamBase memory for a project which is, in fact, 
just another translation memory fed with a copy of the segments validated by the translators connected to it in 
Read/Write mode. The results are displayed in the Fuzzy Matches pane and identified with the usual attributes 
preceded by “TeamBase” so that you know where the segment came from.  
Both 100% and partial matches are immediately available to all the translators linked to a particular TeamBase memory. 
You can share your translation — segment by segment in real time — from the very beginning of your translation just by 
connecting to the TeamBase memory of your project and, if you want, of other projects that may be ongoing (Read/Write 
mode).  
You can also decide to only share your segments when you consider that they are already sufficiently “good” to be of any 
use to others, but even so you can receive segments translated by others (Read mode). This feature is particularly 
useful if you first do a fast draft translation which you afterwards improve.  
TeamBase memories are bilingual — created for each language pair — and can be accessed by any translator who is 
translating a project with that language combination, be it in one Unit, in the whole Language Department or in other 
Language Departments… if they are using TeamBase too, of course. 
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In OmegaT, there is a Machine Translation pane which displays MT output separately therefore never “mixing” human 
and MT translation in the Fuzzy Matches pane (where translations retrieved from Euramis are displayed) nor in the 
Search window.  
The MT files are automatically stored in the \mt subfolder when the project is created with the DGT-OT Wizard. 
In DGT, machine translation is produced by the MT@EC service which is run by DGT. 
 

In OmegaT, the project memory (project_save.tmx) — which contains all the segments you have translated — is stored 
in a separate project subfolder (\omegat) and the reference/retrieval translation memories are stored in another 
subfolder (\tm), thereby making it easy (and safe) to manage all the project files — and notably the aligned reference 
document files — you want to use (or no longer use) for a particular project.  
 

OT gives you complete control over the external reference memory(ies) you want to use for pre-translation. You just 
have to copy one or more tmx files to the \tm\auto subfolder of your project and the 100% (including tags) segments will 
“auto-populate” your documents.  
A new OT feature is that those segments will, by default, be highlighted with an orange background to call your attention 
to the fact that they were automatically transferred to your project memory. They will remain so highlighted unless you 
modify those segments.  
You can use pre-translate before starting translating a project or at any time in the middle of the process. In the latter 
case, only untranslated segments in your project memory will be pre-translated. Segments you had already translated in 
your project will remain untouched. 
    When you Update a project with a new version of an original, there is no need to pre-translate as your 

translated segments are all in the project memory and will be automatically inserted in the new versions (if they 
are a 100% match including tags) without any action on your part.  

You can also pre-translate — or copy source to target in batch — in filtered segments of your project using the new 
DGT-specific Search and Pre-translate feature. 

    When using Euramis memories for pre-translation, take into consideration that they may be of post-aligned 
documents and therefore they may contain misaligned segments! 

With OmegaT you can easily organise your reference external memories ¾ i.e. memories other than your project 
memory ¾ for a particular project in any way you want.  
You can have several "reference" memories and rank them — or give them penalties — according to your preference 
(either individually or by groups in subfolders) so that the first results displayed come from those you give priority to.  
In the Fuzzy Matches pane, matches will be displayed by match rate first and then by the order of priority, if any, you 
have given to your reference memories. You can organise them easily via the DGT-OmegaT Wizard — or directly in 
Windows Explorer — just by moving, copying or deleting files in the \tm project subfolder.  

 For complex documents/dossiers with many reference documents of different priority (for example, EU Treaties 
have precedence over Regulations and Directives, but these have precedence over Communications, Reports, 
etc), this can save a lot of time and assure consistency with previous main reference legislation!  
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OmegaT allows the use of translation memories with the same source language but with a target language different from 
the one of your particular project. This may be useful, for instance, to check terminology in a different target language if 
there is already a previous translation of the same (or of a similar) document that can be used as reference.  
In order to have matches you only need to have the respective tmx files in the \tm subfolder. OT accepts any memory 
without “censorship”. 

 If you use this feature, you may give a penalty to these memories if you want! 
 

OmegaT also allows the use of a (reference) external translation memory with the source language identical to the 
source language of your project and the target language of the reference memory different from the target language of 
your project, displaying it in the Editor below the original source segment. 
Example: You have an LT document to translate into PT and your knowledge of LT is not perfect (or far from it)… but 
there is already a LT-EN translation of the same document. In this case you can create a LT-PT project and use the 
LT-EN external translation memory to have the EN relay language displayed in the Editor below the LT original segment. 
In this way you can see both the LT and EN as original segments. 
You can also use this feature just to display a translation into any another language for terminology purposes. 
 

If you are working on a project with several other translators and — besides using TeamBase to share segments in 
real-time — also want to share external memories, you (and your colleagues who are also working on that project) can 
do it by redirecting the location of the project \tm subfolder in the Properties menu. 
This way, if you have a coordinator for that project, reference memories can be organised “centrally” to be used by all 
translators/reviser(s). The project memory of each translator’s project will remain in the \omegat folder stored locally in 
your/their computers. 
 

In OmegaT, you can use as many glossaries as you want. If you have one or more glossaries you wish to use in your 
project, you can just copy it/them to the project \glossary subfolder to use as read-only.  
As OmegaT can use very large glossaries without a significant impact on its speed, you can even have glossaries of 
more than a million entries (with 3 fields: source, target and a comment). 
The display of entries in the Glossary pane has been improved in DGT-OmegaT. 
 

When you create or update a project with the DGT-OT Wizard, if you accept the default for IATE, you will have a filtered 
IATE extraction (source term and target term) automatically added to your project to be used as a read-only glossary.  
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The first time you create a terminology entry in your project, OT will automatically create a glossary for that project (in txt 
format), which is the writable glossary.  
You can also define one — and only one — glossary that you already have as your writable glossary, i.e. the glossary in 
which your new entries will be stored. For that glossary to be read by OT as writable the simplest way is to (re)name 
“glossary”. 
 

The Open Glossary feature (Ctrl+Shift+F2) enables you to open — in Notepad++ — the writable glossary file from 
within OmegaT so that you can modify or delete entries, in a batch operation. 
 

The terms/strings with a blue linear and bold underline (by default) mean that there is an entry in one of the glossaries 
(displayed in the Glossary pane) of your project.  
By right clicking on the mouse, the translation(s) of that term/string will be displayed in a dropdown menu. You can select 
to insert it at the position of the cursor in the target segment in the Editor by clicking on it. 
 

If you are working on a project with several other translators and — besides using TeamBase to share segments in 
real-time — you also want to share glossaries, you (and your colleagues who are also working on that project) can do it 
by redirecting the location of the project \glossary subfolder in the Properties menu. You can share the non-writable 
glossaries and each translator can have its own writable glossary accessible to all the translators working on that project. 
This way, if you have a coordinator for that project, glossaries can be organised “centrally” to be used by all translators.  
 

OmegaT glossaries can be used directly in XBench for QA purposes. 
 

You can have as many dictionaries as you want/can find, either bilingual or monolingual. There are dictionaries freely 
available on the Internet that can be downloaded — both monolingual and bilingual (of uneven quality) — for most of the 
EU languages. There is a Dictionary pane where terms present in the dictionaries are displayed. 
By default, there are no dictionaries available when installing DGT-OmegaT. 
 

OT provides statistics for the documents within your project and match statistics for the whole project.  
In this new version, it also provides match statistics for each document with the indication of repetitions in documents 
and between documents, thereby giving you an immediate snapshot of the work involved in the translation of each of the 
documents. This feature is also very useful to distribute the documents when there are several translators involved in the 
translation of a project. 
OT also provides statistics of how much you have already translated and what remains to be translated. Besides, it 
displays and continuously updates the number of (unique) translated/non-translated segments, by document and for the 
whole project. 
When you create a project with the DGT-OT Wizard, you also have automatically copied to your project main folder an 
Excel sheet — OT_Stats  — in which you can manually copy/record your progress in the translation of your project.  
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When creating a project, the DGT-OT Wizard will do an automatic backup of it to your personal space in the H: drive: 
H:\CAT\OmegaT_Projects. This copy is to be used in case there is a problem/crash in your computer. 
This backup is automatically updated every 10 minutes — in a background process without interrupting your work — for 
the active project defined in the Project field of the DGT-OT Wizard.  

 So don’t close the DGT-OT Wizard after opening a project! 
Furthermore, OT itself does automatic backups of your project, by default every 3 minutes, which are saved locally in the 
\omegat subfolder of your project, so the risk of losing any of your work is minimal.  
If you are a teleworker, OT will not slow you down as it is not a resource-hungry application and backups are done in a 
fast background process without you noticing it.  

When you have finished the translation of your documents — or while translation is still ongoing — you can send them to 
Tradesk using the Upload feature in Tradesk. The automation of this process is in the pipeline! 
 

When you have finished translating your documents and have used OT until the very end (revision included, if any), you 
can send the individual document memories to Euramis with the correct DGT attributes, both in single document and 
multi-document projects. The automation of this process is in the pipeline! 
 

As when a project is opened in OmegaT, it has no “recollection” of how it was before, you can just copy/paste a project 
folder to another location of your computer or to another computer via Windows Explorer and open the project as usual 
in the other location. 
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In the present implementation of OmegaT in DGT, original documents are not converted into xliff files. They are directly 
processed by OmegaT from the source formatted files present in the project \source subfolder.  
To understand how OT works — and what to watch out for ! — here is an illustration of the process. 

 
Figure 1 — Opening and reopening projects and creating and recreating translated documents 

After creating a project, every time you open it, your original document(s) will be segmented and processed and the 
segments that you may have already translated (saved to the project memory in the project \omegat subfolder) that 
have a 100% match (including tags) are displayed in the Editor pane.  
The 100% match segments in your project memory are never displayed in the Fuzzy Matches pane. In this pane are 
only displayed matches from the external translation memories in the \tm subfolder or below 100% matches from your 
project memory. 
As every time you reopen a project OT repeats the segmentation and processing operations, when you add or delete 
documents in your project, OT will “accept” the different set of documents and will display in the Editor pane the 100% 
translated segments stored in your project memory.  

 In OmegaT, this is not considered a pre-translation. Pre-translation is when you use external memories ¾ that 
you copy to the \tm\auto subfolder ¾ to automatically transfer to your project memory all the segments with a 
100% (including tags) match in that/those memory(ies).  

 Those segments will be transferred (“auto-populated”) to your project memory and displayed in the Editor and 
(by default) highlighted in a background colour to call your attention to it when you open that project or do 
Reload.  
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The translated segments in the project memory which, for the new set of documents, have a match lower than 100% will 
be displayed in the Fuzzy Matches pane as “orphan” segments. For an equal match, they will be displayed first. 
When you do Create Translated Documents or Create Current Translated Document, OT will, respectively, convert 
all the documents or the active document to the format of the native application and store it/them in the project \target 
subfolder. 
When you repeat this operation — recreating the translated document(s) — all the translated documents previously in 
the \target subfolder will be deleted. 

 So be careful not to make changes in the translated documents in this subfolder as they are deleted if you 
recreate the translated document(s).  

 A good idea is to save the documents you want to change in their native applications to a new folder that you can 
create in your project (for instance, Documents_for_revision) and/or upload the translated document to Tradesk.  

You can generate the formatted document(s) as many times as you want, taking into consideration that any changes you 
make directly (formatting or content) in the document native application will not be transferred to the OmegaT project 
memory. 

  So, don’t make any changes in the translated documents in their native application unless you are sure you don't 
want to use OT again for the translation of that particular document/project.  

When you finish the translation of one or more documents in your project, you must use the Tradesk Upload feature to 
have the documents copied to Tradesk to be released. 
You can also send the individual document memory(ies) to Euramis if you have finished your translation — including 
revision, if any — using OmegaT. If not, the document(s) will have to be post-aligned. 

 



  

 
34 

In this Section is given general information on the more important features just to give you a general idea about the OT 
editing features … that you may want to explore further in the relevant detailed sections according to your work method 
and needs.  

 Detailed Index at the end of this Guide with clickable links. 
. 

All the documents in your project are automatically merged and treated as a unit by default.  
OT numbers the segments of the documents sequentially from the first segment of the first document to the last segment 
of the last document and displays the name of each individual document in the Editor ribbon so that you always know 
which is the document you are working on. 
When you start translating, OT will auto-propagate the translation of non-unique segments (repetitions), if any, 
automatically — in a background operation you don’t notice — for the whole project. 
If you want to inactivate auto-propagation, in the Project → Properties → Edit Project menu, untick 
Auto-propagation of Translations. 

 If you do it when you are in the middle of the translation of a project, the segments that were already 
auto-propagated will remain so. Only non-unique segments that were not translated before will not be 
auto-propagated. 

If documents are added to or deleted from the project — by adding or deleting them to/from the \source folder — when 
the project is reopened or you do Reload, OT merges again the new set of documents. 
For a new version of a document previously in the project (and the previous version is deleted from the project) with 
alternative translations — i.e., the same source segment has 2 or more translations, which are known as “alternative 
translations” — those alternative translations will be correctly inserted in your new text if the new non-unique 
segments are preceded and followed by the same segments (equivalent to “perfect match” in OT).  
 

OT cannot have several documents open at the same time, but as it treats your project globally, its powerful Search 
feature will search in all the documents inside your project — no matter how many they are — and the Fuzzy Matches 
pane will display matches from all the documents in the project.  
You can also do Search/Replace and Search and Pre-Translate in all the documents of your project.  
 

Source and target segments are displayed vertically one on top of the other. This applies to the Editor, the Fuzzy 
Matches and Machine Translation panes. 
There are several options to display segments in the Editor: display only target or source and target segments; mark 
non-unique segments, segments with notes, translated segments, non-translated segments, revised segments, 
modification info, etc..  
You can choose at different stages of your translation to have them displayed differently just by clicking or unclicking the 
relevant option in the View menu.  

 Personally, I prefer this display, by far, to the table (side-by-side) display as it is less tiring for the eyes… 
especially when translating for long hours! 
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In OT, there are 2 segment statuses: untranslated and translated. All translated segments are stored in the project 
memory and are available for Fuzzy Matches. 
If you leave the target segment empty, the original will be used when the document is created in its native application. 
So, if a particular segment is not to be translated, you don't have to copy the source text to the target segment ... but you 
can do it if you want. 

  If you do not copy the source to the target segment, in the statistics, namely in the count displayed in the OT 
window below with the translated and untranslated segments, those segments will be counted as untranslated, of 
course.  

 If you delete the text in an already translated segment using the option “Set Empty Translation” in the Edit 
Menu, in the translated document in the native application there will be an empty line at the place of that segment. 

 

Besides the editing function in OT described in this Guide, you can also edit your segments using the general shortcuts 
Ctrl+A, Ctrl+C, Ctrl+V, Ctrl+X, Ctrl+Z, Ctrl+Y. These only apply to the segment open for editing in the Editor pane. 
 

The segments you translate in a project are identified with your login, date and hour and saved in the project_save.tmx 
file in the project \omegat subfolder.  
When you change the translation of a segment, the previous translation is discarded, which means that after validating 
the segment you cannot go back to the previous translation. 
All the segments in the project memory have your login with the exception of segments that have been pre-translated 
(auto-populated). Those segments are identified with the login recorded in the translation memory used for 
pre-translation unless you open that segment and change it. If you don’t change it, the segment identification will remain 
unchanged too. 
When revision is made in OT, the segments changed by the reviser will have the login of the reviser, of course. 
 

Segments from translation memories are, by default, identified with the name of the \tm folder and subfolders (if any), 
the name of the file, the date, the name of the translator (if available) and the match rate.  
The translator can change the attributes both for the display in the Fuzzy Matches pane and in the Search window. 
 

The differences between the source segments and less than a 100% matches in the translation memories are now 
displayed in a more user-friendly way as track-changes in the Fuzzy Matches pane.  
The translator can also choose to see the track changes in the source or the target segments, or in both. The display of 
track changes in the target segment is used in the revision process.  
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There are three match estimates available: 
Ø Match percentage (taking into account tokenizers) 
Ø Default OmegaT match: number of matched words — with numerals and tags ignored — divided by the total 

word count  
Ø OmegaT match, including numbers, tags 

Example: 100/91/95%. As you have also to guarantee that formatting will be correctly displayed in the documents in their 
native applications, always look at the lowest percentage. 
 

OT preferences are 1-level. You can easily change them any time you want. OT will “remember” your last preferences 
when you reopen it, either with the same project or with another project. 
The only exceptions relate to Filters and Segmentation, which can be defined at general or project level, but DGT 
translators don’t have to worry about it as the IT Unit takes care of these technical aspects. 
 

You can open the original document you are translating — in its native application — directly in DGT-OT by selecting 
View Source file in the Project menu. 
 

There is no (real-time) preview. However, you can open the (finished or incompletely) translated document you are 
working on — in its native application — directly in DGT-OT by selecting View Target file in the Project menu. You can 
edit it if you want. 
The segments you have not translated yet will be in the source language in the native application. 
 

You cannot print the document as seen in the OT Editor. You can only print it from its native application. 
 

You (if you are the translator) — and your reviser — can do all the revision work using OT, although some manipulations 
will be necessary as the workflow is not automated.  
If OT is used for revision, you and the reviser can include notes in problematic segments and “communicate” through 
them and also add or change entries in the project writable glossary.  
The segments that have been changed by the reviser can be searched with a new DGT feature — Next/Previous 
revised segment — and are highlighted with a red background to call your attention to them.  
Furthermore those segments are displayed with track-changes in the target (instead of the source) segments — in the 
Fuzzy Matches pane — so that you can easily see the changes made by the reviser and accept them or not — if you 
(as the translator) have the last word, of course.  
However, in OT you cannot accept only part of the changes in a particular segment: it’s either the whole revised segment 
or your whole previous translation … and therefore it may involve some typing.  

 On the other hand — as the track-changes are displayed in the segment in the Fuzzy Matches pane and not in 
the Editor — you don't have to do anything if you accept a revision as the text is always "clean"! 
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Inline formatting is displayed in the form of tags (Example: <t0/>).  
You will only see what is called “inline tags” (i.e., tags inside the segment) and not all the tags related to styles or to the 
whole segment.  
By placing the cursor over each tag, you will see its description (in a very cryptic way!). It is mostly useful to see if it is a 
footnote … which is not to be missed!   
If you want, you can also translate with Remove Tags activated, which means that you won’t have any tags at all in the 
documents … but afterwards you (or the Unit Secretariat) will have to add the formatting, if any, manually in the 
document generated in its native application.   
In this new version of OmegaT, the management of tags has been substantially improved and new features have been 
added.  
You can easily validate tags in batch whenever you choose with the Tag Validation feature.  

 
Screenshot 5 — Tags validation by document or for the whole project 

You can also have OT warning you, before opening the next segment for translation, if it finds that there are tag 
mismatches between source and target of the active segment. By default this option is not activated. 
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You can access these DGT applications directly in DGT-OmegaT just by clicking on the respective icon or using the 
shortcuts.  
 

In OmegaT, it is really worthwhile to explore the whole potential of OT’s sophisticated Search feature! 

 
Screenshot 6 — Search window 

You can search — by exact search, keyword search and regular expressions, strings, whole words and lemmas; use the 
Booleans AND, OR and NOT; by author and translator, by date — in source or/and target segments in your project 
(translated and/or untranslated) and/or in the translation memories and/or in glossaries and/or in notes.  
A new feature in DGT-OT is that for a number of settings, you can also memorize searches to be reused in that session, 
in that particular project or in all projects. This is particularly useful for Regular Expressions. Some are already available 
by default and you can add others if you want. 
Another new feature in DGT-OT is that you can also limit the search to a translation memory or to a folder with several 
translation memories.  
In the same window, you can also filter, by those criteria, segments in your project and have them displayed in the 
Editor pane for editing, by clicking on Filter at the bottom of the Search window. 

 Filtering in OT really refers to the editing of the searched terms/strings in the project memory and therefore it is — 
obviously — only applicable to searches in the project memory. 

 

Contrary to the public version, in DGT-OT this feature is not integrated in the Search Project window and has a window 
of its own with added features. 
With it, you can search monolingual documents in the formats accepted by OmegaT (e.g. Office and PDF) using the 
Search Directory feature.  

 This may be very useful — and can save you a lot of time — when you have monolingual or unaligned documents 
(for example, national legislation, standards) that are relevant to your project.  
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You can do a Replace Interactive (one by one) or a Replace all in all the documents of your project using most of the 
options available in Search Project and “preview” the segments affected before launching the Replace All operation. 
This feature has been improved in DGT-OT with some new options. 
 

This is a brand new feature specific to DGT-OT which allows you to search by some criteria and pre-translate the 
resulting segments — either copying source to target or pre-translating them using the external memories matches or 
machine translation output.  

  This can be very useful, for example, when you have documents with hundreds or thousands of segments only 
with numbers that you may want to translate in a batch to have them counted as translated in statistics … and to 
automatically go to the next segment for translation without stopping in those segments.  

 Please note that in case you have more than one match with the best score, this screen provides no way to decide 
which one will be inserted (it depends on memory ordering, see Section F.4.3. for more details). You can check in the 
screen what will be inserted before confirming. 

OT automatically detects segments that are repeated 2 or more times in the document(s) in your project and the first 
time you translate one of these occurrences it automatically and instantaneously auto-propagates it — backwards and 
forwards — in all the other non-unique segments in a background operation you don’t see.  

By default, those segments are also colour-coded (in grey) to call your attention to them. If the translation is later 
changed in any of the identical segments’ occurrences, all the other segments will be automatically changed without any 
need for search, search/replace on your part… but also without warning!   
 

If you want the translation of a particular instance of a non-unique (repeated) segment to be different and not changed 
automatically when any other of its occurrences is changed, you can define it as an alternative translation which will be 
kept unchanged in that particular segment even if any other of the non-unique segments is changed.   
If a segment has alternative (different) translations in a project, they will be displayed in the Multiple Translations pane 
with the indication of the default translation and the alternative translation(s) with the previous/next segments and the 
number of the document in which they occur, making it a sort of “perfect match”. 
 

These are segments that you already translated — and which are therefore in your project memory — but which no 
longer exist in the documents in your project.  
This may happen when you delete — for some reason — a document from your project or when you update a project 
with a new version of one or more documents and delete the previous version.  
These segments will be displayed in the Fuzzy Matches pane and identified as “orphans”. They are displayed first 
according to the match rate. 
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Footnotes are treated as end notes and are always displayed at the end of the relevant document (not at the end of the 
project if it is a multi-document project).  
There is no indication or visible "link" (besides a non-descriptive tag, if you are translating with tags) between them and 
the respective paragraph. However, they will be correctly displayed in the translated documents … as long as you have 
inserted the respective tag in the relevant segment. 

     If you forget to insert a footnote tag when you are working with tags (default), that footnote will not be displayed 
in the translated document in its native application.  
However, if you are working with Remove Tags activated — and as in this mode there are absolutely no tags — 
the footnote number will be displayed in the translated document at the end of the paragraph and the text of the 
footnote at the bottom of the relevant page. 
 

You may want to write notes while translating regarding a particular segment (for instance, concerning terminology 
problems to solve, colleagues or experts consulted/to consult, mistakes in the original) in the Notes pane when that 
segment is open.  
Segments with notes are highlighted (by default) with a background colour (pink) to call your (or the reviser’s) attention 
to them.  
Neither this highlight nor the actual notes will be transferred to the documents in their native applications. However, you 
can “export” all your notes to a file, if you want to discuss them with another colleague/reviser/terminologist.  
You can also identify your notes in a way that allows you to export different kinds of notes. For instance, notes for the 
terminologist or for the reviser. 
 

Auto-completion is a brand new OmegaT feature which allows to complete words from glossaries or auto-text (your own 
list of abbreviations for instance), to add (special) characters and also to insert tags. 
 

OmegaT has evolved a lot in the last 2 years and there is a very active community of developers contributing to its 
improvement. To facilitate the use of features that are developed around OmegaT there is now the Scripting menu, 
which allows the users to select some applications that perform certain operations not (yet) integrated in the general 
OmegaT version.  
In DGT-OmegaT a few have been selected which are available by default (with shortcuts), but you can also add others 
from the available list. 

 You can even add your own scripts… if you know how! 
 

The spellchecker uses the LibreOffice spellchecker and has been complemented by a script — Spellcheck — that 
allows you to correct spelling — and ignore and add words to the spellchecker — in the whole project. 
You can check the spelling in all the documents of your project or in the active document and update your dictionaries of 
learned_words and ignored_words. 
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In this update, contrary to the public OT — in which these “dictionaries” are project-specific — in DGT-OT the 
learned_words and ignored_words “dictionaries” are saved — for each language combination — in a single file in the 
_CONFIG–PERSONAL subfolder of your OmegaT_Projects folder to be used in all your projects.  
These are text only files that you can easily edit if you want to add, words or list of words in batch (provided by the 
Linguistic Coordination of your Language Department, for example) or to delete words. 
 

OmegaT — as many open-source applications — relies on the interaction with other applications and in DGT you can 
use XBench which is installed in all DGT computers if you want to do a more in-depth quality check. 
But now, with scripts like QA — Check Rules and QA — Show Same Segments, you can already perform in OmegaT 
a substantial number of quality checks at any stage in the translation process. 
  

Some of the file formats, specialized for translation work, for instance PO, allow the inclusion of comments from the 
requester. This way the translator can be provided with the context about the segment to be translated or be given 
instructions about it. This is something that is not used in DGT documents for the moment, as far as I know. 
 

OT does not allow easily merging or splitting segments in the Editor. It can be done but it requires some manipulations.  
Segmentation is always a problem although the segmentation rules have been greatly improved to match Euramis/MT. 
But they are not perfect ... namely with poorly formatted original documents.  
But if you just translate the split or merged segment as shown in the Editor, it will be converted correctly in the document 
in its native application (even if it implies changing the order of elements in your translation).  

 Section D.1.17. if you really want to merge or split segments. The most practical way is to change/correct the original 
file and update the project. 

  It has an advantage: you can even merge paragraphs if you want! 
 

In OmegaT you can omit formatting — with the exception of footnote-related tags — that is present in the source 
segment but you cannot add formatting which does not exist in the source segment. You will have to add that formatting 
in the final translated document in its native application.  

 You can use the Note feature to remind you to add the formatting later by generating a list of format-related 
notes.  
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You can resize the different windows/panes as in any other Windows application, by dragging the margins using the 
mouse.  
You can also undock and change the position of the different panes (Editor, Fuzzy Matches, Glossary, etc.), but I 
suggest that, when you start, you accept the defaults.  
If you have changed the OT display and you don’t like it — and you feel at a loss — you can go back to the default 
display by selecting Restore Main Window in the Options menu. 

                                      
                        Minimize  Undock  Maximize                                Restore 

Screenshot 7 — Icons to minimize, undock, maximize and restore panes 
 
Minimizing is done as in Windows by clicking on the respective icon at the top right side or right-clicking on the mouse 
and selecting the minimize option.  
Maximizing is done likewise by clicking on the pane’s name at the bottom of the OT window and by clicking on the 
Restore icon or right-clicking on the mouse and selecting that option.  
If you want to change the position of a pane, just click on the undock icon of the pane you want to move and, clicking on 
the blue header, drag it to the position you want (you will see a greyed area showing where the pane will be positioned). 
Release the mouse button when it is in the position and of the size you want. 
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Functions and shortcuts: As in most applications, you can use the menus (with the full features) or the shortcuts (for 
many operations). Below are listed some of the most frequently used.  

 Part Q for a full list. 
DGT icons: DGT IT Unit has added some icons for the most common operations, which are self-explanatory (place the 
cursor over them and a descriptive text will appear).  
A new icon has been added to give direct access to the full-fledged IATE interface. 
 

 
        1      2     3      4       5     6       7      8      9    10    11     12     13   14    15    16     17    18    19    20     21   
 

Function Icon Shortcut Information 
New project 1  A new project is usually created with the DGT-OT Wizard 
Open project 2 Ctrl+O Projects are usually opened via the DGT-OT Wizard 

Reload 3 F5 If you add or delete documents, or if you change your 
preferences, in an OT project 

Close project 4 Ctrl+Shift+W To close the project, but not OmegaT. 

Undo last action 5 Ctrl+Z 
To undo the last action, but only in the segment open in the Editor 

  OT has no Undo last action for operations like Replace all 
or any other. 

Redo last action 6 Ctrl+Y 
To redo the last action, but only in the open segment in the Editor 

  OT has no Undo last action for operations like Replace all 
or any other. 

Search project 7 Ctrl+F To search terms/strings — with many options — in the whole 
project 

Search and Replace 8 Ctrl+K To Search/replace — all or one by one — in the whole project. 
Go to previous 
segment 9 Ctrl+P To close and save the segment to the project memory and to open 

the previous (translated or untranslated) segment for editing. 

Got to next segment 10 Ctrl+N 
To close and save the segment to the project memory and to open 
the next (translated or untranslated) segment for editing The 
equivalent of Return. 

Go to next 
untranslated segment 11 Ctrl+U To close and save the segment to the project memory and to open 

the next untranslated segment for editing. 
Go to the next  
translated segment  Ctrl+Shift+U To close and save the segment to the project memory and to open 

the next translated segment for editing. 

Replace with match 12 Ctrl+R To replace the target segment with the match selected (in bold) in 
the Fuzzy Matches pane. 

Insert match 13 Ctrl+I To insert in the target segment, at the position of the cursor, the 
match selected (in bold) in the Fuzzy Matches pane. 

Replace with Machine 
Translation 14 Ctrl+M To copy to the target segment the machine translation output that 

is displayed in the MT pane or to replace what is there. 
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Function Icon Shortcut Information 

Insert Next Missing Tag  Ctrl+T To insert (the first or) the next missing source tag in the target 
segment at the position of the cursor. 

Insert missing source 
tags 15 Ctrl+Shift+T To insert all the missing source tags in the target segment at the 

position of the cursor. 

Validate tags 16 Ctrl+Shift+V 
To show the list of segments with missing/different/surplus tags in 
the target segment. Clicking on the segment number, OT jumps to 
that segment in the Editor for editing. 

DocFinder 17 Ctrl+Shift+D Highlight the reference to search and it opens DocFinder. 
Quest 18 Ctrl+Shift+Q Highlight the term/string to search and it opens Quest 

IATE 19 Ctrl+Shift+L To open IATE full-fledged interface with all search options and 
allowing the creation of new IATE entries. 

Euramis 20 Ctrl+Shift+E Highlight the term/string to search and it opens Euramis 
full-fledged interface with more search options. 

Quit 21 Ctrl+Shift+Q To quit the project and OmegaT 
Project files  Ctrl+L To display the list of documents in the project 
Create Translated 
documents  Ctrl+D To create all the translated documents in their native applications. 

OT stores them in the project \target subfolder 
Create Current 
Translated Document  Ctrl+Shift+D To create the translated document open in the Editor in its native 

application. OT stores it in the project \target subfolder 
Open project Folder  Ctrl+Shift+F1 Within OmegaT, to open the project folder in Windows Explorer 
Insert glossary entry  Ctrl+Shift+G To create a new glossary entry  
Open writable glossary  Ctrl+Shift+F2 To open the glossary in Notepad++ to change or delete entries. 

Go To Next/Previous 
Revised Segment  Ctrl+Shift+X 

Ctrl+Shift+Y 

Used in the revision process for the translator to check the 
changes made by the reviser displaying — in the Fuzzy Matches 
pane — the track-changes in the target segment. 

Spellchecker  Ctrl+Shift+F7 To detect spelling mistakes in the whole project and to add 
learned/ignore words for that target language for all projects. 

Quality check  Ctrl+Shift+F3 To carry out several levels of quality check in the whole project 

Auto-completion  Ctrl+space To display and insert Glossary Entries, Auto-Text Entries, Missing 
Tags and characters/symbols from the Character Table 

Auto-completion — 
cycle  Ctrl+Page ↑↓ 

To cycle between Glossary Entries, Auto-Text Entries, Missing 
Tags, Character Table 

 

Besides the editing functions in OT, you can also edit your segments using the general shortcuts below. These only 
apply to the segment open for editing in the Editor pane. 

Function Shortcut Information 
Select all Ctrl+A Selects all the text in the open segment and highlights it in blue 
Copy text Ctrl+C Copies the selected text to be afterwards pasted into another segment (as OT 

“remembers” it even after the segment is closed) or into another application 
Paste text Ctrl+V Pastes the copied text into another open segment in the Editor or into another application. 
Delete text Ctrl+X Deletes the highlighted words in the segment open in the Editor. 

 Take into consideration that the highlighted text is also deleted from the project 
memory when you validate that segment, i.e., when you open that segment again you will 
not get back your previous translation. 
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This Section gives you a quick overview of the translation and revising process using DGT-OmegaT and its Wizard in 
order to make this more detailed Guide understandable on its own. 
Here is used an example of a standard workflow — which will probably cover the majority of your needs — with a 
standard multi-document project.  

 Relevant sections form detailed information (Detailed Index with clickable links at the end of this Guide). 
The starting point to create (or update) a project with one or several documents (with the same or different dossier 
numbers) is always to use the Local copies option in Tradesk to copy to your computer the original documents to be 
included in the project.  
By default, they are copied to the C:\Users\{your login}\AppData\Local\Local Documents — no 
backup\DGT\Dossiers folder.  
To manage your project, you can click on the buttons or use the shortcuts (ALT + character underlined, for example 
ALT+A). 
If the first character of each option is not underlined, just click on Alt to activate the shortcuts. 
As OmegaT doesn’t accept the Office 2003 formats, if you have an “old” document still in that format, either use the ORC 
document in Tradesk (if it is a Word document) or open that/those document(s) in their native application(s) and do a 
Save as in the 2010 Office format (xlsx, pptx) before creating the project. 
 

The process to create and update a project is very similar as shown below. 
 

1 — In Tradesk, do a Local copy of the document(s) to include in your project which will be automatically copied to 
the Dossiers folder (Local Documents — no backup — DGT — Dossiers ) in your computer.  

2 — Click on the DGT-OT Wizard icon — – in your desktop (automatically created in the installation of OT) to 
open it. 

 If it is not your first project, click on Clear before starting the creation process. 
3 — Select the source and target languages from the dropdown menu (if not already defined). 
4 — Click on Add — which by default will open a Windows Explorer window in the Dossiers folder — to select the 

original document(s) previously copied to your computer.  
 You have to select them one by one, even if they are in the same folder. If they are in different folders, navigate 

the folder structure to reach and select all the original documents. 
5 — In the Windows Explorer window, click on Cancel or press ESC when you have finished selecting the documents. 
6 — By default, the DGT-OT Wizard will give to the new project the number of the first document you added to the list, 

but you can change it — in the Project field — writing a name meaningful to you. 
7 — An extraction from IATE will be included in your project unless you untick the IATE box. 
8 — Click on Create and the DGT-OT Wizard will create the OmegaT project.  
9 — Click on Open (which is displayed in green when the project has been created) and it will open that project in 

OmegaT.  
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To update a project with a new original document or a new version of an original already in the project: 
a —   Close OmegaT if it is open. 
b — In the DGT-OT Wizard, check that the project you want to update is the active project in the DGT-OT Wizard.  
 If not, click on Select to select that project and make it the active project.  
c —  Repeat steps 1, 4 and 5 of the Section A.8.1.1 above.  
d —  If you are updating the project with a new version of a document already in the project: 

i) Click on Browse,  
ii) Select the \source folder and delete the document(s) you will be replacing with a new version, 
iii) Close the Windows Explorer window. 

e —  Click on Update and the DGT-OT Wizard will update the active project with the new document(s), wiping useless 
tags from Word documents, if any, copying the translation memories available in Tradesk and updating the IATE 
extraction. 

f —  Click on Open and it will open that project in OmegaT. 
 

1 — OT starts by displaying the list of the documents in your project. Click on Close to accept the opening of the first 
segment of the (first) document. You are now ready to start the translation of your first project.  

 If you want to translate another document in a multi-document project, just press Ctrl+L (or select Project Files 
in the Project menu) and the list will be displayed again and you can select another document.  

 You can also change here the order in which OT displays the documents in the Editor by highlighting the name of 
a document and clicking on Move First, Move Up, Move Down or Move Last.  

 If you close and reopen that project, OT “remembers” the last segment you edited and will open that segment for 
editing (instead of the first segment of the first document). 

2 — To see the statistics of your project before beginning your translation, select — in the Tools menu — the option 
you want: Statistics, Match Statistics or Match Statistics per file. Those statistics will be stored in the project 
\omegat subfolder. 

     Getting Statistics is a fast process, but Match Statistics (per file) can take a while if you have a really big 
project (hundreds of pages). The good thing is that you can do it any time!  

3 —  There are some preferences that you may want to change right away: 
v Menu: Options → Font:  

  Font type and size by default:  Font — Dialog; size — 18 
v Menu: View:  

  How the segments are displayed/highlighted (only target, also source, identification, etc.)  
v Menu: Options → View Options:  

  Include the first non-unique segment when marking non-unique menus: By default not activated 
v Menu Options → Editing Behaviour Options:   

  Minimal similarity (of automatic insertion of matches): by default 80% 
  Stop at segments with multiple translations: by default not activated 
  Go to Next Untranslated Segment stops when there is at least one alternative translation: by default not activated 
  Validate tags when leaving a segment: by default not activated 
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4 — OT displays the first segment to be translated and, by default, if there is a Euramis match above 80% (or a 
different threshold of your choosing), it will be automatically inserted in the segment open for translation.   

5 — If you want to use Machine Translation (which is displayed in the MT pane) even when a Euramis match has 
been automatically inserted in the target segment, just press Ctrl+M to replace the text there by the MT output.   

 If there is no match within the defined threshold, OT will automatically insert the MT output (default). You can 
deactivate the automatic insertion in Options → Editing Behaviour, by unticking Insert Machine Translation.  

 It is here that you can also select the Minimal Similarity threshold for the automatic insertion of Fuzzy Matches.   
6 — OT will display matches in the Fuzzy Matches pane up to the number of matches defined in the Options → 

External TMXs options menu (default: 10). You can change this number to more or less (up to 50 matches). 

    OT will display matches even below the minimal similarity threshold defined the Editing Behaviour menu up to 
the number of matches defined. This may be useful sometimes as it may allow you to see matches at 
sub-segment level.  

 To insert in the target segment a fuzzy match other than the first (higher) match displayed in bold in the Fuzzy 
Matches pane, position the cursor on the fuzzy match segment you want to use, double click on it (it will turn to 
bold as the selected segment) and use the shortcuts Ctrl+R or Ctrl+I. 

 You can also right click on the mouse and choose the option you want from the drop down menu: To Insert 
Match into Translation or To Replace Translation with Match or press Ctrl+{number of fuzzy match} (only 
for the 5 first matches) followed by Ctrl+R or Ctrl+{number of fuzzy match} and clicking on the Replace with 
Match icon.  

7 — Translate/correct your first segment and press Enter to validate it — saving it to your project memory — and to 
open the next segment for translation. 

8 — If you want to go to another segment (far) above or below, just scroll/go to that segment and double click on it to 
open it for translation. OT will save the previous segment to the project memory and open the new selected 
segment for editing.  

9 — You can copy/paste, drag/drop between the Fuzzy Matches, Search and Editor panes and from applications 
outside OmegaT.  

10 — To access DocFinder and Quest or to access Euramis and IATE directly, just highlight the term/string/OJ 
reference you want to search and click on the icons or use the shortcuts (Ctlr+Shift+F, Ctlr+Shift+Q, 
Ctlr+Shift+E, Ctlr+Shift+L, respectively). 

11 — To insert a tag, position the cursor where you want the tag to be inserted and press Ctrl+T. OT will insert the first 
or next missing tag in that position. You can also right-click the mouse and choose the tag you want from the 
dropdown menu.  

 Other options are: pressing Ctrl+Space to use the Auto-Completion feature to choose the tags in the dropdown 
menu (this is especially interesting for paired tags (bold, underline, italics)); or clicking on Icon 15 — Insert 
Missing Source Tags — to insert all missing tags at the position of the cursor; or copy/paste or drag and drop 
the tag(s) from the source segment. 

 If, in the open target segment in the Editor you have a match with tags and you want to get rid of all the tags for 
some reason, press Ctrl+Shift+F5 (or select Strip tags in the Tools menu) to have the target segment cleaned 
of tags so that you can edit a “clean” segment … probably to add different tags. 

12 — To search terms/strings in the project memory and/or the retrievals/reference translation memories and/or the 
glossaries and/or the notes, highlight them in the Editor pane, press Ctrl+F and press Enter to accept the 
defaults — or select the settings you want — in the Search window.  

 OT will search for terms according to those settings. There are many options really worth exploring! 
 If the search results are from your project memory, you can click on the number at the beginning of each segment 

and OT will open that segment in the Editor for editing.  
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13 — You can Search / Replace all or one by one (Replace Interactive) by pressing Ctrl+K or clicking on Search and 
Replace in the Edit menu. You also have some options. 

14 — To create a glossary entry, highlight the source term you want, press Ctrl+Shift+G (or go to the Edit menu and 
click on Create Glossary Entry) and fill in at least the first 2 of the 3 fields available: source term and target term; 
the 3rd field is optional and you can add there whatever (amount of) information you want.  

 If it is the first entry you create in that project — and you have no previous writable glossary in the \glossary 
folder of your project — OT will automatically create a glossary for the project.  

 If you want to delete or change an entry in your writable glossary, press Ctrl+Shift+F2 (or select that option in the 
Tools menu) to open the glossary in Notepad++ for editing. 

15 — The terms/strings with a blue linear and bold underline in the open segment in the Editor mean that there is an 
entry in one of the glossaries in the \glossary folder of your project (which are displayed in the Glossary pane). 
By right-clicking the mouse, the translation(s) of that term/string will be displayed in a dropdown menu 
(TransTips).  

 You can select to insert a particular translation at the position of the cursor in your target segment by clicking on 
it. The terms displayed in bold in the Glossary pane are from the writable glossary. 

16 — To use the Auto-Completion feature, press Ctrl+space and cycle through the options by repeatedly pressing it 
or pressing Ctrl+Page Down/Page Up to select the option you want.  

 To add a new entry for auto-text (abbreviation), select Options → Auto-completion → Auto-text and add your 
new entry.  

 To add a character to the character table, select Options → Auto-completion → Character table. 
17 — Alt Codes: For a non-breaking space type Alt 255 or Alt 0160, for a non-breaking hyphen Alt 0173, for a n-dash Alt 

0150, for m-dash Alt 0151 and for quotation dash/horizontal bar Alt 196 (for more, see List of Alt Key Code Symbols 
and Characters; AINSI Codes).  

 You can add these to the Auto-completion → Character table or to the Auto-text list to easily insert them.  
18 — After finishing your translation, or at any time during the translation process, click on the icon 16 (Validate tags) 

or press Ctrl+Shift+V and check if OT detected anything wrong/missing.  
 By clicking on the number of the segment on the left in the window that is displayed, OT will jump to the segment 

in question and open it in the Editor pane and you can correct it if needed.  
 The Validate tags check is sometimes overcautious. There are tags that you may ignore... but others not!  
 If there is a tag at the very beginning or end of a segment, or tags before and after a full stop in segments that 

should have been split, don’t even think of what they mean, just insert them, in the same position, in the target 
segment or otherwise it may happen that your translated documents will be corrupted.  

 But, don’t worry, just correct the problem and recreate the documents and hopefully there will be no problem. 
 Also if, by mistake, you insert the same tag twice in the target segment, it may happen that your document will not 

be correctly generated in its native application. 
 Concerning paired tags — e.g. for italics, bold, underline — if you insert only one of them, the formatting in that 

sentence will probably be defective. However, if you do not insert both, the only problem is that the particular 
word/string will not have any formatting when converted to the document’s native application. 

 Concerning footnotes, if you do not insert the tag in the target segment, the footnote will not appear in the 
translated document in its native application, although you have translated it. So, be careful! 

 However, if you are working with Remove Tags activated — and there you obviously cannot insert tags — the 
footnotes will be in the right place at the bottom of the right page and the number of the footnote will be at the end 
of the right paragraph … which may not be the right position. You will have to check and, if necessary, change it 
in the translated document in its native application. 

http://www.alt-codes.net/
http://www.alt-codes.net/
http://necco.ca/dv/miscellaneous.htm
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19 — You can do the Spellchecking in your whole project (or in the document you are working on) by clicking on 
Ctrl+Shift+F7 or selecting it in the Tools menu.  

 Here you can also add learned_words or ignored_words to your dictionary. Or you can do it in the Editor — 
one by one — by right clicking on the mouse and selecting Ignore all or Add to dictionary. 

20 — You can do a quality check of your project — QA Check Rules — by clicking on Ctrl+Shift+F3 or selecting it in 
the Tools menu. You can choose the type of “errors” you want to detect by ticking/unticking each box. 

21 — To create the translated document(s) in their native application(s), press Ctrl+D to generate all the target 
documents or Ctrl+Shift+D to generate only the document you are working on. They are generated in the project 
\target subfolder.  

    Don’t forget to check that you have no previous target documents opened in their native applications as in that 
case OT will not be able to generate the updated target documents in the \target subfolder. 

    It is better to do Validate tags before creating one or more translated documents. But if you don’t, OT will 
generate them — even if without some formatting — except if essential tags are missing (see point 18 above). If 
so, correct them and generate the translated document(s) again. 

22 — If you want to view the document you are currently translating press Ctrl+G (or select View target file in the 
Project menu) and OT will generate the translated document and display it in its native application. 

     If you have one or more translated documents open in its/their native application(s), the operation cannot be 
completed. So, close all translated documents in their native applications before doing it. 

23 — If you want to view — or copy to another location for editing — any translated document(s) in your project, open 
the project folder (Ctrl+Shift+F1 or select that option from the Tools menu), select the \target subfolder and 
there you have the translated document(s) you generated in its/their native application(s). 

    You can generate the formatted document(s) as many times as you want, taking into consideration that any 
changes you make directly (formatting or content) in the generated target document(s) will not be transferred to 
the OmegaT project memory.  

24 — Every time you repeat the Create (Current) Translated Document(s) command, OT will delete all the 
documents (if any) in the \target subfolder and generate the (updated) translated document(s).  

   If you are, for example, working in a project with a (large) number of documents and/or with different deadlines — 
and you make changes in it/them directly — it may be “wise” to create a new subfolder in your project and save 
your document(s) to that subfolder or Upload it to Tradesk so that they are not replaced by any subsequent 
creation of translated documents.  

25 — To copy the translated document(s) to Tradesk — at any moment during the translation or to be sent to the 
requester — or to send translated document memories to Euramis,  Sections A.8.3. and A.8.4. below. 
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If you want to copy the translated documents (even during the translation process) to make them available to everybody 
in Tradesk or to finalize them and send them to the requester: 
1 —  Check that you have no translated documents from that project open in their native applications.   
2 —  In OT, do Create (Current) Translated Document(s) (Ctrl+(Shift+)D).   
3 —  In Tradesk, Upload the document(s) you want from the project \target subfolder (or from any other subfolder if 

you have copied it/them to another folder).  
 

If the translation is finished (revision included, if any) using OmegaT, you should send the individual memory(ies) to 
Euramis. For the moment, you must do it manually: 
1 — Generate the memory(ies) to be sent to Euramis by clicking on Ctrl+Shift+F8 (or Tools → Scripting → Create 

Euramis Export) to generate individual memories of your documents with the attributes required by Euramis. 
  Those memories are saved in the \euramis subfolder of your project.  
2 — Open the Euramis interface and select the individual memory(ies) to be sent to Euramis in the abovementioned 

subfolder. 

    To see to which Euramis Memory are your particular document(s) to be saved, when in doubt, see the Euramis  
→ Statistics & Managers → List to see Where to Save a document from a given DG, service or Cabinet 

3 —  You will receive an email with the confirmation that the memory of your document(s) has been saved. 
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If your reviser wants to use OT to revise your document(s) — and if you have done all your translation work using OT, of 
course — it can be done but with some manipulations on your part as there is currently no automated revision workflow.  
Take into consideration that, in OT, there are no track-changes in the (open or closed) target segment(s) displayed in the 
Editor. There are only track-changes in the segments displayed in the Fuzzy Matches pane which, in the revision stage, 
are from the “draft” translation that is being revised and possibly from other external memories. 
As it is possible to display track-changes in the target segments too, the translator who is checking the changes made by 
the reviser — to accept them or not — can see the track-changes in the target segment in the Fuzzy Matches pane for the 
segment that is open in the Editor. 
Also take into consideration that, if you — as the translator — have the last word, you cannot accept some of the reviser’s 
changes and reject others in a particular segment. You can either accept all the changes made by the reviser or change 
manually the ones you don’t accept. Or you can also reinsert your initial translation (from the Fuzzy Matches pane) and do 
the partial changes to your initial translation manually … depending on what involves less typing work. 

 On the positive side, as the track-changes are displayed in the segment in the Fuzzy Matches pane and not in the 
Editor, you don't have to do anything if you accept all the changes the reviser has made in a particular segment — 
which is probably the most common situation — as the text is always "clean". 

Here is presented a standard workflow of a single or multi-document project that is translated by 1 translator and revised by 
1 reviser and the whole project is sent for revision at the same time… which is the most frequent situation. 

Part N for a detailed explanation of the process and variants for complex/large projects involving 2 or more translators, 
and/or more than 1 reviser and/or a number of new versions while the project is being revised. 
 

 

In Windows Explorer:  
1 —  Select the OmegaT_Projects folder which is under C:\Users\{your login}\AppData\Local\DGT. 
2 — Do a copy of the project you want to send for revision to that same folder by highlighting the project folder name 

and pressing Ctrl+C and Ctrl+V.  
3 — Rename the new project folder thus created (which Windows Explorer automatically renamed 

{name-of-the-project} copy).  

  You can name it, for instance {name-of-the-project}-FOR-REVISION. 
      This way, your original project will remain intact and you can always reuse it if you want. 
 

In Windows Explorer, in the copy of the project for revision: 
4 —  Open the project folder. 
5 — In the \tm folder of the project, create a new subfolder — for example called 0-DRAFT-translation — thereby 

giving it the maximum priority in the display in the Fuzzy Matches pane when the reviser does its revision work. 
6 — Do a copy of the project memory (project_save.tmx file) in the project \omegat subfolder to this new subfolder. 

  Don’t delete the project memory from the \omegat subfolder.  
7 —  Copy the project to a location on a server that you have agreed with your reviser or which is the location used in 

your Unit/Language Department to exchange projects (or copy it to a USB key). 
8 — Inform the reviser that the project is ready for revision and indicate the location. 
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1 —  In Windows Explorer, copy to the OmegaT_Projects folder the project for revision prepared by the translator that 
was copied to the server (or copy it from the USB key provided). 

2 — Open the project as usual via the DGT-OT Wizard to have automatic backups every 10 minutes. 
3 — The process is the same as in translation mode. You can view the segments in the Editor — with Display 

Source Segments activated in the View menu (default) — and only open the ones you want to change. 
 You can also open all the segments and validate them with Return. In that case, only the segments you change 

will be identified with your login. The others will remain with the login of the translator. 
4 — In the Fuzzy Matches pane you will always be able to see the segment open in the Editor as translated by the 

translator, identified — in the case of the example above — by 0-DRAFT-translation (name of the subfolder). 

     As OmegaT only keeps the last modified translation in the project memory — and therefore eliminates from it the 
translator’s target segment if you make any changes to it and validate it — this way you can always recheck later 
the segments you revised against the initial translation displayed in the Fuzzy Matches pane. 

5 — If you want to see the original document, press Ctrl+H to view it in its native application. If you want to see the 
current translated document in its native application, press Ctrl+G any time during the revision. If you have 
already made changes, the translated document will already have those changes. 

6 — You can see the Notes that the translator may have written and you can “communicate” with the translator writing 
your comment/answer or creating new notes.  

7 — In the Glossary pane, you will see the entries from the glossaries in the project — or at least from the IATE 
extraction automatically created with the project.  

 If the translator had a writable glossary, you will see the entries from that glossary in bold in the Glossary pane 
and you can also add new entries to the writable glossary or edit the glossary — to change one or more entries 
— by pressing Ctrl+Shift+F2 and editing it in Notepad++.  

8 — If you want to check the changes you made in the project documents with track-changes, you can — in Options 
→ External TMX Options menu — tick the box View diff in target.  

 Of course, you will have to open the segment to see the track-changes displayed in the target segment(s) in the 
Fuzzy Matches pane. 

     If you do that, don’t forget — after finishing the revision — to change again this setting if you are afterwards going 
to do translation (and not revision) work. 

9 — If, at the end of the revision, you want to quickly check the changes you have made, just filter those segments by 
doing a Search by Regular Expressions, writing a dot (“.”) in the field In translation and your login in the field 
Translator. 

 Only the segments you have changed will be displayed in the Search window and you can view them in a batch. 
You can also filter them for editing in the Editor or just click on the number of a particular segment to open it in 
the Editor. 

    Don’t forget to tick the box in those 2 fields (and to untick them when you no longer need it). 
10 — When you finish the revision, rename the project (for instance, {name-of-the-project-REVISED). 
11 —  If you have the last word and you release the translation, just finalize your project sending translated documents 

to Tradesk and translated document memories to Euramis. 

  Sections A.8.3. and A.8.4. 
12 — If the revised translation is to be finalized by the translator — or if you want to give the revised translation to the 

translator for information purposes only — copy the project to the same server location and inform the translator. 
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If you are the translator and you have the last word:  
1 — Copy to your computer the revised project from the server location.  
2 — Open the project as usual via the DGT-OmegaT Wizard to have automatic backups. 
3 — To easily see the segments that have been changed by the reviser, in the View menu activate Mark Revised 

Segments to have those segments marked with a red background. You can scroll the segments in the Editor to 
see those that were changed.  

4 — To see the changes made by the reviser segment by segment, use the feature Go To Next/Previous Revised 
Segment (View menu) or use the shortcuts Ctrl+Shift+X and Ctrl+Shift+Y, respectively. 

 OT goes to and opens for editing the next or previous segment that is identified with the login of another user, in 
this case the reviser’s login.  

5 — Alternatively, if you want to quickly check the changes made by the reviser without opening all the changed 
segments in the Editor, just filter those segments by doing a Search by Regular Expressions, writing a dot (“.”) 
in the field In translation and the reviser’s login in the field Translator.  

  Don’t forget to tick the box in those 2 fields (and to untick them when you no longer need it). 
 Only the segments the reviser changed will be displayed in the Search window and you can quickly check them. 

If you want, just click on the number of a particular segment to open it in the Editor … or filter them all for editing 
in the Editor. 

6 —  You can accept the changes made by the reviser, reinsert your own translation from the Fuzzy Matches pane — 
as your translation is displayed first — and/or do partial changes to any of them.   

7 — Finalize your project sending translated documents to Tradesk and translated document memories to Euramis.  

  Sections A.8.3. and A.8.4. 
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For projects in which there is a substantial number of repeated (non-unique) segments, auto-propagation can be a very 
interesting feature.  
However, it is important to understand how it works to take the best advantage of it as, in OmegaT, auto-propagation is 
done in the whole project — both backwards and forwards — in a background operation that you don’t see … but also 
without any “warning”! 
As in DGT we frequently have projects with a significant number of repetitions, this OT feature is explained right away in 
this Guide so that you can fully benefit from it … in a safe way! 

 Auto-propagation may seem a bit confusing at first, but it is a feature that is really important! 
By default, the DGT-OT Wizard creates the projects with auto-propagation activated. If you don’t want to have it in your 
project, in the Project → Properties → Edit Project menu, untick the Auto-propagation of translations option.  
Non-unique segments are identical source segments (100% including tags) that are repeated in a project — be it within 
a document and/or between documents in the case of multi-document projects. 
 

 

Screenshot 8 — Non-unique segments in the whole project displayed greyed — Unique segments in the 
whole project displayed in black 

 

When translated in the first occurrence, these segments have, by default, the status of default translation and 
auto-propagation — i.e. translation — is automatically done in the whole project changing the status of the other 
non-unique segments from non-translated to translated and all these non-unique segments are counted as translated 
in the Statistics. 
If the translator defines, in a particular segment, a translation as an alternative translation — thereby dissociating that 
particular segment from the other identical source segments in the project — the translation of that particular segment 
will not be changed if any of the other occurrences is changed. 

Those segments are marked with a greyed font as being non-unique, independently of being the default translation or 
an alternative translation. 
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You may choose not to have the first occurrence marked as a non-unique segment and only have them marked from the 
second occurrence onwards (default) or have it greyed in the first occurrence too. 
It depends on your preferences or the phase in your work: you may want to be alerted to the fact that a particular 
segment is repeated in the text if you want to see the context of the other occurrences or you may prefer to see it just as 
a new segment.  
You can change this easily in the Options → View Options menu by ticking Include the first non-unique segment 
when marking non-unique segments any time you want. 
 

 

Screenshot 9 — View Options menu 
An alternative translation of a segment is defined by right-clicking on the mouse and selecting the option Create 
alternative translation from the drop-down menu displayed. 
In the example below of a listing of products quoting the EU Combined Nomenclature, “– — — — Other” can be 
translated in Portuguese in 4 ways depending on the context of a particular CN heading.  
In the case of this particular segment, the default translation is “– — — — Outros” as displayed at the top of the 
Multiple Translations pane, and there are 3 alternative translations — “– — — — Outro”, “– — — — Outras”, “– — — 
— Outra” (gender and number differences in PT) displayed with the number of the document in which they appear and 
the previous and next segments. 
 

 

Screenshot 10 — Non-unique segment with alternative translations 
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If the same sequence of previous, non-unique and next segments matches any of the combinations already defined as 
alternative translations, the default translation will not be auto-propagated. 
By default in DGT-OT, this applies to all the documents in the project which have that particular combination of segments 
considering that we have frequently new versions of documents which, therefore, will have a different number but in 
which you might want multiple translations to be recognised. 
In the case of a new version of a document previously in the project (and the previous version is deleted from the 
project), and if there are alternative translations, they will be correctly inserted in your new text if the new non-unique 
segments are preceded and followed by the same segments (a “perfect match”).  
However, if you want you can define that alternative translations apply only to segments in the document where they 
were first defined by unticking the option Ignore file context when identifying segments with alternative translations 
in the Options → File Filters menu. 
You can also change your mind at any time, and turn an alternative translation into a default translation by right-clicking 
on the mouse and selecting the option Use as default translation from the drop-down menu displayed. The new default 
translation will be auto-propagated to all the non-unique segments that have no alternative translation defined. 

 So be careful and take this into consideration if you change your mind! 
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OmegaT relies basically on a system of highlights and text colours to indicate segment status and other information so it 
may be worthwhile to understand how it works to take the best advantage of it.  
In the Editor, by default, the open segment displayed for translation is identified with the match rate (with and without 
formatting penalty), if there is a match from the external translation memories, or with MT if it is the output from machine 
translation.  
When you translate and validate a segment, it is saved to the project_save.tmx memory in the project \omegat 
subfolder. If you open it again, that segment is, by default, identified with your login, date and hour displayed above the 
open segment.  
When you change the translation of a segment, the previous translation is discarded, which means that after validating 
the changed translation you cannot go back to a previous version of that target segment. 
All the segments in your project memory are identified with your login with the exception of pre-translated segments, if 
any. 
If you use Pre-Translation — by adding a memory to the project tm\auto subfolder — your project memory will be 
“auto-populated” with 100% match segments (including formatting) coming from the memory(ies) you copied to that 
subfolder. 
Those segments are identified in your project memory with the login recorded in the translation memory used for 
pre-translation — which may be the login of another translator — and are displayed with an orange background (default) 
in the Editor to indicate that they were pre-translated (“auto-populated”).  
Those segments will remain so identified in your project memory unless you open and change them. If you don’t change 
them, the segment identification will remain unchanged too. 
When revision is performed in OmegaT, the segments changed by the reviser will have the login of the reviser, of course. 
In the Fuzzy Matches pane, by default, each segment is identified with the name of the \tm subfolder where the file with 
that segment is stored (if any), the name of the tmx file, the date and hour of creation, the name of the source document, 
the match rate (with and without tags) and the login of the translator (if any).  

 Part O if you want to the DGT attributes and the way they are displayed.  
By default, the match segments are displayed with track changes in the source segments. But track-changes can also 
be displayed in the target segments. This feature is used in the finalization stage when the translator — if s/he has the 
last word — checks the changes made by the reviser in order to accept them or not. 
As you have a number of options — and because it is so much simpler to show than to explain — here is an overview of 
what it looks like. Some of these features are DGT-specific and are marked with the DGT logo. 

 As you can see in the screenshots below, working with DGT-OT can be quite colourful! 
 

View Preferences — Default — Open segment already translated identified with the translator’s login and date. 
Display source segments (with a blue background) activated and Mark translated segments inactivated.  
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View Preferences — Segment already translated displayed with Mark translated segments (with a light green 
background) activated. Translator and date identification for the open (and already translated) segments activated 
(default). 
 

 
 
 

View Preferences — Mark translated segments (with a light green background) and Mark non-translated segments 
(with a light yellow background) activated. Display Source Segments activated. 

 

 
 
 
 

View Preferences — Mark translated segments and Mark non-translated segments activated. Display Source 
Segments inactivated — Translator and date identification for all translated segments activated. 
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View — Preferences — Default — Non-unique segments greyed. Non-unique segments can be greyed in all 
occurrences or only from the second occurrence onwards depending on the option selected in Options → View → 
Include the first non-unique segment when marking non-unique segments (unticked by default) 
 

 
 
 
 
View — Preferences — Segments with notes highlighted in pink (when not open for editing) (default) 
 
 

 
 
 
 

View — Preferences — Default — Mark Auto-populated Segments activated — The segments auto-populated 
(pre-translated) marked with an orange background when not open (default). The translator’ login from the reference 
document used for pre-translation (in this case costami) will remain unchanged if the translator (in this case machame) 
does not change that particular segment. 
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Fuzzy Match — 100% matches highlighted with a green background in the target segment in the Editor 
together with the number of the segment and the 3 match rates (with and without formatting/numbers) 

 

 
 
 
 

 

Fuzzy Match below 100% highlighted with a yellow background in the Editor, with the number of the 
segment and the 3 match rates. 
Fuzzy Matches with track changes in the Fuzzy Matches pane comparing the segment in the translation 
memories and the new document: strike-through in red for text not present in the new document and 
underlined blue coloured text for new text.  

 

 
 
 
 

 

 
Edited Fuzzy Match below 100% highlighted with a yellow background except the changes as they are 
made by the translator (as long as the segment is not validated).  
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Machine Translation highlighted with a grey background and identified with “MT” after the segment number. 

 
 
 

 
 
Edited Machine Translation highlighted in grey except the changes as they are made by the translator 

 

 
 
 

 View — Preferences — Segments with a red background (when the segment is closed) for the revision 
stage when the option Mark Auto-populated Segments (default) is activated and Mark Revised 
Segments is activated too (2nd segment below). When the segment is open, it turns to a greenish colour 
(3rd segment below). 
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View — Preferences — Segments with a red background (when the segment is closed) for the revision 
stage when the option Mark Revised Segments is activated and the Mark Auto-populated Segments is 
deactivated. When the segment is open, the colour turns to green. 

 

 
 
 
 
Editor — It can get quite colourful as several colour codes will mingle!  
 In this example, segment colours for auto-populated segments (from Pre-Translate) plus other marks: 

· 1st and 2nd segments: auto-populated only;  
· 3rd segment: auto-populated + a note;  
· 4th segment: auto-populated and open for editing. 

 

 
 



  

 
63 
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Before looking at the OmegaT project structure, let’s first see the folder where your OT projects — and also your 
preferences files — are stored. 
The OmegaT_Projects folder is created by the DGT-OT Wizard when OmegaT is installed for the first time in your 
computer in the C:\Users\{your login}\AppData\Local\DGT\ folder.  
It is here that the OT projects are created by the DGT-OT Wizard. 
When DGT-OT is first installed, the DGT-OT Wizard will also automatically create the following subfolders: 

Ø _PROJECT-ARCHIVE (empty): Where you can store your finished projects just by dragging and dropping 
them from the main OmegaT_Projects folder so as not to have — over time — a long list of projects 
already finished.  
You can also simply delete finished projects as there is a copy of them in your H:drive (unless you delete 
them too!) 

Ø _PROJECT- MEMORIES (empty): Where you can copy the memories of the documents finalized with OT 
and sent to Euramis. 

  Considering that Euramis strips all formatting from the segments it stores, it may be interesting to 
save here all the memories of projects that you have finished with OT for later reuse. 

 For example, if new versions of already released — and heavily formatted — documents arrive, it 
would be a waste of time to reinsert all the tags again… which is what you would have to do if you 
retrieved that document memory from Euramis… and you wanted to use OmegaT of course. 

Ø _CONFIG-PERSONAL: Where you will have all your preferences, memorized searches and dictionaries 
with learned and ignored words. This allows you to easily change them if you want. 

 
 

Screenshot 11 — The _CONFIG-PERSONAL subfolder in the OmegaT_Projects folder.  
 

  This folder is very important and you should be careful not to delete it as it contains files which 
store all your preferences — so that when you close and reopen the same or a different project — 
OT “remembers” your preferred settings and also some other information. 

 However, if you delete it by accident, the default preferences will be restored when you reopen the 
DGT-OT Wizard… but you will lose your preferences. 
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To easily manage (complex) projects, it may be worthwhile to take the trouble to understand the structure of a 
DGT-OmegaT project. So, let’s look at it in detail. 
When you create a project with the DGT-OmegaT Project Wizard, this is the project structure that is automatically 
created.  

 
Screenshot 12 — Project created automatically by the DGT-OT Wizard. 

 
The project is created in the C:\Users\{your login\AppData\Local\DGT\OmegaT_Projects folder.  
You can access it via the DGT-OT Wizard (click on Browse), from within OmegaT with Ctrl+Shift+F1 (or via the menu 
Tool → Open Project Folder) or in Windows Explorer directly. 

 These folders and files should not be deleted as otherwise OT may not work properly (or at all!). 
But you can organise your external translation memories and create other folders freely as, when you open the project, 
OT will accept it without any “recollection” of how it was before. 
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During the translating of the project, other folders and files may be automatically created, namely the \euramis and 
\export–omegat subfolders and the files {name of project}-level1.tmx, {name of project}-level.tmx, {name of 
project}-omegat.tmx as shown in the screenshot below. 
You can also create project subfolders, for instance, to use monolingual reference documents for search purposes or to 
copy translated documents without revision/with revision to a new folder you create as the translated documents in the 
\target folder are automatically deleted every time you do Create Translated Documents. 
So a real-life project will/may have this kind of additional folders and files. 
 

 
Screenshot 13 — An example of the structure of a DGT-OmegaT project during the translation process 

  
Now let’s see what is the purpose and content of each folder/file. 
 

This is an essential file to open the project. If this file gets corrupted somehow, you will not be able to open the project 
and OT will display an error message. 

 Therefore, don’t touch it!  

 If this file gets corrupted (something which happens very, very rarely in my experience) don’t panic!  
  See Part P on Troubleshooting. 
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The folder where your original formatted document(s) to be translated are kept. In DGT implementation of OmegaT, 
there is no conversion of the original documents into the xliff format. 
In the case of docx originals, these documents are cleaned of tags with the DGT TagWipe application. 
If you have documents with a subfolder structure, OmegaT will keep it. This is especially useful for web page projects. 

 

The folder where your formatted translations in their native applications are generated when you do Create Translated 
Documents or Create Current Translated Document.  
If you have documents with a subfolder structure, OmegaT will keep it. 

When the project is created with the DGT-OT Wizard, the TagWipe application is automatically made project-specific so 
that if, while translating/updating projects, TagWipe is changed/improved by the IT Unit, your project will not be affected 
and you will not have unduly untranslated segments.  

 

This is a very important folder as it is here that OT saves your translated segments and also some other information. 
Contrary to the public OmegaT, this folder does not contain the learned_words and ignored_words files as in DGT-OT 
these files are unique — for each language pair — and saved in the _CONFIG–PERSONAL folder to be used for all 
projects.  
Here is a screenshot of what the \omegat folder may look like. 

 
Screenshot 14 — Files in the \omegat subfolder 
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During the translation of the project, the \omegat subfolder may/will contain: 
 

a) project_save.tmx: The project memory file where the segments you translate in OT are stored.  
This is what an OT project memory looks like: 

 

 
Screenshot 15 — Example of an OT project memory 

   This project memory includes segments that may be “orphans”, i.e., that you translated in that project 
but which no longer exist in the original(s) if you replaced one or more documents by newer versions. 

   The project memory prevails over all the external memories, i.e., the segments contained in this 
memory are the ones which are displayed in the Editor pane and used to create the translated 
documents.  

   There is only one exception however:  \tm\enforce subfolder below. 
  b) project_save.tmx{time-stamp}.bak: Backups that OmegaT does periodically of the 

project_save.tmx file in the same folder (therefore locally in your computer) and every time you save 
or close your project.  

   They are time-stamped and can be used if the project_save memory gets corrupted for some reason.  
   This is an OmegaT feature. It has nothing to do with the backup the DGT-OT Wizard does to your 

space in the H: server to ensure that — if your computer has a crash — your work will not be lost as 
the project memory is saved outside your computer. 

  c) project_stats.txt: Every time you select Statistics in the Tools menu OT saves the statistics results 
within the project — between source documents — in this folder. If you run Statistics again, this file 
will be replaced with the new data.  

    That is why in DGT we have created the OT_Stats Excel sheet to record how a project evolves! 
  d) project_stats_match.txt: Every time you select it in the Tools menu, OmegaT saves in this folder the 

results of the match statistics with the memories in the \tm subfolder and the segments translated in 
your project memory, if any. If you run it again, it will replace the previous file. 

  e)   project_stats_match_per_file.txt: Every time you select it in the Tools menu, OmegaT saves in 
this folder the results of the match statistics per file with the memories in the \tm subfolder and the 
segments translated in your project memory, if any. If you run it again, it will replace the previous file. 
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  f)  segmentation.conf: When the project is created with the DGT-OT Wizard, the segmentation 
rules of your project are automatically made project-specific so that if, while translating/updating large 
projects, the segmentation rules are improved by the IT Unit, your project will not be affected (and you 
won’t have unduly untranslated segments). 

  g)  files_order.txt: File where OT stores the order of the source documents in the project if you 
reordered them using the Move buttons in the Project Files list. You can change that order at any 
time.     

  h)   files_entry.properties: When you reopen a project, OT “remembers” the last segment you edited 
in the last session before closing that project. This means that OT, instead of opening the first segment 
of the first document in the project as before, it will open a segment somewhere in the middle of your 
project … if you had edited something before, of course.  

 

This is a DGT-specific folder as DGT doesn’t use the MT systems available in the public OmegaT.  
This folder is where the Machine Translation files are automatically copied to when you create a project with the DGT-OT 
Wizard.  
In OT, machine translation is displayed separately in the Machine Translation pane and is never mixed up with human 
translation. 

 

Where the external memories — Euramis retrievals and aligned reference documents (in tmx format) — are kept. 
By default, the DGT-OT Wizard will copy to the \tm subfolder all the pre-processed files in Tradesk (in the dossier \pret 
folder), with the exception of machine translation files, of course.  
You can create subfolders if you want to organise your translation memories and you can also add or delete memories in 
this folder.  
It is also in this subfolder that TeamBase saves the link to a shared memory on a server (example below: 
T-MJM-EN-PT.properties) when you are working in shared mode with one or more fellow translators. 
 

 
 

Screenshot 16 — The \tm subfolder when a project is created with the DG-OT Wizard (the subfolders — with the 
exception of the \auto subfolder — were created afterwards by me)  

Reference documents memories  
(extension download — DWN) 

Retrievals memories (extension RET) 

Memory with extraction of titles from 
Eur-Lex (extension Celex) 

Reference documents memories 
organised by subfolders/subjects 

 

Link to TeamBase when translating in 
share mode 
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This is what an external (Euramis) memory looks like: 

 
Screenshot 17 — Example of an external (Euramis) memory 

When a project is created (directly in OT or via the DGT-OT Wizard), the subfolder tm\auto is also automatically created. 
This is the subfolder (created empty) you can use for Pre-Translation (auto-population) purposes, either before 
starting translating or during the translation process.  
The tmx files you copy to this subfolder are used to pre-translate the documents in the \source folder when you open the 
project or do Reload. 

 

This subfolder is not automatically created when the OmegaT project is created (either via the DGT-OT Wizard or 
directly in OT). You have to create it manually in Windows Explorer if you want to use this feature. 
The target segments in the files in this subfolder will be displayed in the Editor as a second source segment.  
 

This subfolder is not automatically created when the OmegaT project is created (either via the DGT-OT Wizard or 
directly in OT). You have to create it manually in Windows Explorer if you want to use this feature.  
The segments in the files in this subfolder are the only ones that have priority over the project memory and — unlike the 
files in the \tm\auto subfolder — will even replace any segments already translated (saved in the project_save.tmx) 
and will continue to replace any segments you change afterwards.  

 So, if you use this feature, don’t forget to delete this memory/folder, otherwise it will keep overriding the segments 
you change afterwards and which have a 100% match in this memory. 

Where the glossary(ies) are stored. You can place here glossaries you already have and want to use in a project.  
When you create a project with the DGT-OT Wizard, it will automatically (by default) copy to this folder — if you have not 
unticked that option in the DGT-OT Wizard — an IATE extraction (source and target) and those terms are displayed in 
the Glossary pane and used by the TransTips and Auto-completion features. 

  You can also place the glossaries in any other folder outside the project folder if you change the respective path in 
Project → Properties menu. 
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Where dictionaries are placed if you want to use any. When a project is created using the DGT-OT Wizard, for the 
moment there is no dictionary copied to the project. 

  You can also place dictionaries in any other folder outside the project folder if you change the respective path in 
Project → Properties menu. 

 

This is a folder that is only created if you run the script Create Euramis Export in order to generate individual translation 
memories of your documents with the correct attributes to be sent to Euramis. 
This memory has all the segments of a particular document without orphan segments and notes and without alternative 
translations. 

 

This is a folder that is only created if you run the script Create OmegaT Export in order to generate individual translation 
memories of your documents with alternative translations and notes (and without orphan segments) to be used in the 
revision process. 

 After you finalize your translation — and if you use OT until the end of the process (revision included) — you can 
generate with this script individual memories of your finalized translated documents and store them in the 
_PROJECT–MEMORIES subfolder if they have alternative translations and notes. 

 

When you create the target documents with the Create Translated Documents/Create Current Translated Document 
command, OT generates 3 further memory files in the main project folder (  Screenshot 13 above and Section B.3. 
below): 
Ø  {project–name}–level1.tmx  
Ø {project–name}–level2.tmx 
Ø {project–name}–omegat.tmx 

These three memory files contain all the translated segments in the documents in the \source folder when the translated 
documents are generated. 
Unlike the project memory (project_save_tmx), these memories do not contain “orphan” segments, i.e. those segments 
that no longer exist in the documents in the \source folder when you generate these memories... and which may not be 
fully revised! 
These memories also do not contain the notes that may be in the project_save.txm memory. These memories are not 
accepted by Euramis as the DGT attributes are not encoded in the format required by Euramis. 
 

When you create a project with the OmegaT Project Wizard, it will also copy to the main project folder an Excel file — 
named OT_Stats{name of the project} — in which you can record:  

a) The project statistics in an easily human-readable format; and  
b) The progress in your work if you want to have an idea of how many words/characters/pages you translated 

per hour/day/week or any other period.  
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Because it may be a bit confusing to have so many memories of a project — i.e. of your translation work — here are the 
main features of each so that you can choose what to use or to keep. 

 Considering that Euramis cleans all the formatting in the segments it stores, I recommend that you keep, at least, 
a copy of the memory you sent to Euramis and/or the memory generated by the Create OmegaT Export and 
save them in the _PROJECT–MEMORIES folder.  

 These tmx memories have all the formatting and, if you have heavily tagged documents which some time later 
may have a new version, you can use them for Pre-Translation with formatting included. 

 
Memory Folder in the 

project 
Global / 
by doc 

Format 
(tags) 

Alternative 
translations 

Notes Orphan 
segm 

Euramis 
format 

Segm ID 

project_save \omegat Global Yes Yes Yes Yes No May have 
several 

 Generated by 
Create OmegaT Export 

\export_omegat By doc Yes Yes Yes No No May have 
several 

 Generated by 
Create Euramis Export 

\euramis By doc Yes No No No Yes The one 
selected 

{project–name}-level1 Main project 
folder Global No Yes No No No May have 

several 

{project–name}-level2 Main project 
folder Global Yes Yes No No No May have 

several 

{project–name}-omegat Main project 
folder Global Yes Yes No No No May have 

several 
 

tmx memory Description 
 
project_save 

 
The project_save.tmx file contains all the segments that have been saved in the memory since 
you started the project (therefore including orphan segments). This file always exists in the 
project. Its contents will always be sorted alphabetically by the source segment. 

 
 Generated by 

Create OmegaT 
Export 

 
A DGT adaptation of the publicly available write_sel_files2TMX script allows exporting 
memories by document. Used in DGT for the revision process. Generated by pressing 
Ctrl+Shift+F9 and selecting the document(s) you wish to have memories exported from. 

 
 Generated by 

Create Euramis 
Export 

 
A DGT adaptation of the publicly available write_sel_files2TMX script allows exporting 
memories by document with DGT attributes encoded in Euramis format. Used in DGT to send 
memories to Euramis. Generated by pressing Ctrl+Shift+F8, choosing the translator’s login and 
selecting the document(s) you wish to have memories exported from. 

 
{project–name}–
level1 

 
One memory for the whole project which contains only textual information (i.e., without tags). 
Can be used in other CAT tools. Generated when pressing Ctrl(+Shift)+D. 

 
{project–name}–
level2 

 
One memory for the whole project which encapsulates OmegaT specific tags in correct tmx 
tags so that the file can be used with its formatting information in a translation tool that 
supports tmx level 2 memories, or OmegaT itself. Generated when pressing Ctrl(+Shift)+D. 

 
{project–name}–
omegat 

 
One memory for the whole project which includes OmegaT specific formatting tags so that the 
file can be used in other OmegaT projects. Generated when pressing Ctrl(+Shift)+D. 
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For simple projects, it is enough to create the project with the DGT-OT Wizard and have the standard translation 
memories by default available in Tradesk, as well as the IATE extraction. 
However, for large/complex projects, it may really be worthwhile to take the time to organise the project before starting… 
or organising it or updating it with new information later on. This workflow is DGT-specific. 
 

The starting point to create (or update) any project with one or several documents (with the same or different dossier 
numbers) is always to use the “Local copies” option in Tradesk to copy to your computer the original documents to be 
included in the project (by default they are copied to the Local Documents → no backup → DGT → Dossiers folder).  
You can use the Tradesk feature Local Copies to copy the originals to your computer one by one. Just select the 
document in the list of your current jobs and click on that option. 

 
Screenshot 18 — Tradesk list of current jobs 

 
But if you have several documents in the same dossier, the fastest way is to select the icon for Dossier (in the 
Screenshot above) and do Local copies of all the documents you need in a single operation. 

 
Screenshot 19 — Tradesk list of documents in a dossier 
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In Tradesk you also have the Note feature which is the means of (interinstitutional) communication and where 
sometimes you have instructions from the Planning or from the author. 
You can add notes about matters/problems related to: 
Ø The original and in that case you write the note in the General section as it applies to all languages 
Ø Your language and in that case you select the section for your language. 

 
Screenshot 20 — Tradesk note for each dossier 

 

In Tradesk you also have the Match Statistics by document. 

 
Screenshot 21 — Euramis Match Statistics per document available in Tradesk 
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Frequently, there are some reference documents for each document/dossier which are pre-processed either 
automatically (because they are referred in the original documents) or which are detected by the Pre-Processing Team. 
They are listed in Tradesk under Euramis → Available legislation. 
If you wish, download them before creating a new project. But you can also — at any time — request aligned reference 
documents in Tradesk and Update your project via the DGT-OT Wizard and those new memories will be added to your 
project. 
 

 
Screenshot 22 — Example of a list of reference documents available in Tradesk for a particular document 
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During the translation of a project or when you have finished translating one or all the documents in a project, you can 
use Tradesk Upload Product feature to copy translated documents to Tradesk. For the moment this operation is not 
automated. 
To copy translated document from your local project to Tradesk: 
1 —  In Tradesk, click on Upload Product (See Screenshot 18) 
2 — Click on Browse 
3 — Select the OmegaT_Projects folder (under C:\Users\{your login}\AppData\Local\DGT\), the project you want 

and the \target folder or any other folder where you have the documents you want to copy to Tradesk 
4 — Click on Upload 
If there are several documents to copy to Tradesk, repeat this operation for each of them. 
 

 
Screenshot 23 — Copying (uploading) documents translated in OT to Tradesk 
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Although we think of Euramis as one (giant) Translation Memory database, it is in fact divided into several databases as 
shown below.  

 
Screenshot 24 — Euramis databases 



  

 
79 

The fact that Euramis is composed of several databases has implications in terms of retrievals, i.e., retrievals are 
pre-processed only with segments from the Euramis databases which are considered relevant depending on the 
requester service/DG/Cabinet, as shown below. Take into consideration that this may change over time! 
You can consult this list here. 

 
Screenshot 25 — Translation memories consulted in an Automatic Retrieval for documents from a given DG, 

service or Cabinet 
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Retrievals from the Euramis databases related to the documents to be translated are automatically extracted, as well as 
titles from legislation and whole reference documents (if match percentage is important). These files are automatically 
copied to your project when it is created via the DGT-OT Wizard. 
In the example below, it is indicated in the Euramis report the matches from those Euramis databases: Legis-Process, 
Legis-Juris, Normative Memory and High-Frequency segments databases. 

 
Screenshot 26 — Euramis databases used in pre-processing for a particular document 

 

If you want to have retrievals from other Euramis databases, you can request them via Euramis — Translation Memory 
— Retrieval where you can select up to 5 databases, the match rate and the number of matches that are retrieved. 
You may also have to do it manually, for example, in the case of multilingual documents for which there is no 
pre-processing. 

Screenshot 27 — Requesting Euramis retrievals manually 
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You can also request in Euramis aligned documents to be used in your project as reference memories. You can choose 
to have them sent: 
Ø To the \pret folder of the relevant Tradesk dossier and, in that case, those memories will be automatically 

copied to your project when you create or update it using the DGT-OT Wizard, or 
Ø By email and in that case you have to copy those tmx files manually to the \tm folder of your project. 

 

 
Screenshot 28 — Euramis Document Search to request aligned memories of reference documents 

 
If you have several reference documents to request, the most practical thing to do is to select the option Copy file to 
pret and afterwards Update your project in the DGT-OT Wizard. 

 
Screenshot 29 — Requesting aligned documents from Euramis to be sent by email or to the \pret dossier folder 

in Tradesk 
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When you finish the translation of a document and send it to the requester — if you finished your translation in OT, 
revision included, if any — you should send the individual memory to Euramis with the correct Euramis attributes. 
For the moment, you must do it manually: 
1 — Generate the memory(ies) to be sent to Euramis by clicking on Ctrl+Shift+F8 (or Tools → Scripting → Create 

Euramis Export) and selecting the document(s) for which you want to generate memories.  
 Those memories are saved in the \euramis subfolder of your project.  
2 — Open the Euramis interface and select the individual memory(ies) to be sent to Euramis in the abovementioned 

subfolder. 

    To see to which Euramis Memory are your particular document(s) to be saved, if in doubt, you can — in  Euramis 
→ Translation Memory → Statistics & Managers → List — see Where to Save a document from a given DG, 
service or Cabinet 

 

 
Screenshot 30 — Present list of DGs, services and Cabinets with respective Euramis database 
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3 —  You will receive an email with the confirmation that the memory of your document(s) has been saved to 
Euramis… or you will receive an error message. In that latter case, check that you have selected the right Save 
to translation memory option and resubmit it. 

 

 
 

Screenshot 31 — Euramis Save to Translation Memory menu 

In the file confirming the storing of your documents in Euramis, it is specified the number of segments kept. 
In fact, Euramis — besides cleaning all formatting information — also eliminates segments with identical source and 
target and some other segments as seen below in the example of an Euramis report. 

 
Screenshot 32 — Euramis Save to Translation Memory report 
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For Word documents in the language pairs EN → other EU languages and some other language pairs, MT is 
automatically pre-processed for each document and is available in Tradesk and automatically copied to the \mt subfolder 
when you create or update a project with the DGT-OT Wizard. 
For other language pairs, you must request machine translation manually from the MT@EC service 
 

 
Screenshot 33 — MT@EC web interface 

 
To request machine translation: 
1 —  In Tradesk, do a local copy of the original documents if you haven’t done it yet. 
2 —  In the MT@EC website, select the documents for which you want machine translation, the language pair and 

the output format.  

 Don’t forget to select the output in tmx format.  
3 —  You will receive the MT file by email.  
4 — After creating the project, copy the tmx file(s) to the \mt subfolder of your project. 

https://mtatec.ec.testa.eu/mtatec/
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OmegaT itself has basic management features. This is not a shortcoming; it is just the “philosophy” that project 
management is basically done via a File Manager — like Windows Explorer — that everybody already knows. 
In DGT some of the more frequent project management operations have been automated via the DGT-OT Project 
Wizard to interlink it with the DGT document management system (Tradesk).  
However, when you have confidential documents, you cannot use the DGT-OT Wizard and you will have to create the 
projects directly in OmegaT.  Section D.3. 
With the new version of OmegaT, it is already possible to directly access the OT project folder with the shortcut 
Ctrl+Shift+F1 (or via the menu Tools — Scripting) — which you can use instead of the Browse feature in OmegaT. 
The rest of the process is, mutatis mutantis, similar to what is explained for managing projects with the DGT-OT Wizard. 
Nevertheless, using the DGT-OT Wizard is a “must” for: 

Ø The creation of projects with docx tagwiped documents, all the translation memories in Tradesk and an 
automatic extraction of IATE terms  

Ø The updating of projects with new documents/versions and/or new memories in Tradesk 
Ø The automatic backup of projects 
Ø Connecting to TeamBase, changing connection mode and disconnecting from it. 

 Don’t forget to always have the DGT-OT Wizard open and the project you are working on as the active project 
(selected in the Project field) to have automatic backups every 10 minutes to your space in the H:drive… except 
if you are working with confidential documents (SECEM)! 

 

The ease, flexibility and user-friendliness of OmegaT concerning the creation and update of projects is of particular 
importance for DGT translators. 
For basic information on how to manage projects to start translating with DGT-OT right away, in the DGT-OT Wizard just 
click on the Quick Guide button.  

 
Screenshot 34 — DGT-OmegaT Project Wizard window and features 



  

 
87 

In the present Guide is presented detailed information on how you can optimise the management of DGT-OT projects, 
namely creating projects with a set of original documents, translation memories, machine translation output and/or 
glossary(ies); updating projects with new documents or new versions of documents already in the project, deleting 
documents/memories from the project, organising translation memories, archiving finalized projects, preparing projects 
for revision in OT and having (automatic) backups of your projects. 
It is also with the DGT-OT Wizard that you can easily connect to TeamBase to share project memories in real-time with 
colleagues who are working on the same project or on one or more related projects. 
The DGT-OT Wizard is easy to use as, for many of the project management operations, it just opens a Windows 
Explorer window and there you can copy, paste, delete, drag/drop and rename any files you want in the usual manner.  
As the DGT-OT Wizard and OmegaT do not “keep track” of all these operations, you are free to change your project as 
you want and when you reopen it, the DGT-OT and its Wizard will just accept what is there.  
To manage your project, you can click on the buttons or use the shortcuts (ALT + character underlined, for example 
ALT+A). 
If the first character of each option is not underlined, just click on Alt to activate the shortcuts. 
As OmegaT doesn’t accept the Office 2003 formats, if you have an “old” document still in that format, either use the ORC 
document in Tradesk (if it is a Word document) or open that/those document(s) in their native application and do a Save 
as in the 2010 Office format (xlsx, pptx) before creating the project. 

 Never rename the documents changing the doc, xls, ppt extension to docx, xlsx, pptx as if you do so the 
documents will not be converted to the Office 2010 format and will not be read by OmegaT.  

In this section is given general information on how to manage DGT-OT projects. 

 Sections on Translation Memories and Machine Translation, Terminology and Revision for more detailed information. 
 

You can access the following guides from the DGT-OmegaT Wizard: 

DGT Guides: 
Ø DGT-OmegaT 2014 and its Project Wizard — Quick Guide 
Ø DGT-OmegaT, its Project Wizard and DGT’s CAT Environment — A Translator’s Guide — 2014 (the Guide you 

are reading). 

Public OmegaT Guides (take into consideration that DGT-OmegaT has some adaptations) available in the public 
OmegaT website: 
Ø OmegaT 3.0 — User's Guide by Vito Smolej (the Guide in the OmegaT Help in pdf format for easier 

consultation) 
Ø OmegaT for CAT Beginners by Susan Welsh & Marc Prior. 

Information on updates — changes or improvements - in DGT-OT, its Wizard or TeamBase.  

DGT-specific Excel sheet that enables you to record the statistical information and the progress in the translation of your 
project.  
 

http://www.omegat.org/en/documentation.php
http://www.omegat.org/en/documentation.php
http://www.omegat.org/en/tutorial/OmegaT%20for%20Beginners.pdf
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By clicking on Add, you can select the document(s) you want the DGT-OT Wizard to create (or update) your project with. 
If more than one, you must select them one by one in the Windows Explorer window that pops up. If you want to change 
the documents added, you can remove one or more by highlighting its/their name and clicking on Remove. 

To select a project already created, just click on Select and choose from the list displayed the project you want to make 
your active project.  
If you want to see what is inside a project — be it the original documents, the translation memories or any other folder — 
just click on Browse and it will open a Windows Explorer window in the folder of your current project. You can click on 
any of the subfolders to see their content and change it if you want. 
 

Before creating a new project, click on Clear to be able to create a brand new project as otherwise the DGT-OT Wizard will 
update the active project defined in the field Project, if any.  
 

More often than not documents have (many) tags that are useless (some call them the “tag soup”).  
A tag cleaning script — TagWipe — has been developed in-house for Word documents (the huge majority of our 
documents) so that you (mostly) only see the tags that are really necessary.  
If you work with tags in OmegaT (which is the default), keep the TagWipe option activated in the DGT-OT Wizard (which 
is the default too) as otherwise it is highly likely that you will see too many useless tags in OmegaT. 
As the DGT-OT Wizard will now create the project making TagWipe project-specific, if the IT Unit does any 
changes/improvements to TagWipe during the translation of a lengthy project with (many) new versions, there will be no 
change in those rules and therefore you won’t have in your project unduly untranslated segments. 

 If you create a project and there is an error message and the project doesn’t open, it may be due to TagWipe as 
the docx format is very complex — and “creative” — and rare tags can appear (mainly in poorly formatted 
documents) and create problems.  

  See Part P on Troubleshooting to see how to solve the problem…. or ask for help! 
In the case of confidential documents — for which you cannot use the DGT-OT Wizard to create or update projects — 
use the TagWipe application available in your Desktop, identified with the icon . 
To do it, just open the \source folder of your project, highlight the document to be tagwiped and drag it to the TagWipe 
icon in your Desktop. Accept the cleaning of the document. 
 

To take full advantage of the Glossary, Transtips and Auto-Completion features of OT, when you create a project with 
the DGT-OT Wizard, it will automatically copy to your project \glossary subfolder a read-only glossary with a filtered 
extraction from IATE containing the terms potentially relevant to your document(s).  
This file only contains the source term and the target term and OT displays in the Glossary pane all the entries for each 
segment. Furthermore, with the TransTips and Auto-Completion features you can have them displayed also in a 
dropdown menu in the Editor pane.  
This option is activated by default. You can untick it if you do not want — for some reason — to use an IATE extraction in 
your project.  

 If you create a project with an IATE extraction and afterwards you change your mind and don’t want to use it, just 
Browse your project, select the \glossary subfolder and delete that glossary or move it to another location. 



  

 
89 

The starting point to create (or update) a project with one or several documents (with the same or different dossier 
numbers) is always to use the “Local copies” option in Tradesk to copy to your computer the original documents — in 
Office 2010 format — to be included in the project. 
By default, they are copied to the Local Documents — no backup — DGT — Dossiers folder.  

 
Screenshot 35 — Creating a project with the DGT-OT Wizard 

To create a new project: 
1 — In Tradesk, do a Local copy of the original documents.  

2 — Click on the DGT-OT Wizard icon — – in your desktop, if it is not open.  If OmegaT is open, close it. 
3 — If there is a previous project active (with its name in the Project field), click on Clear before creating the new 

project.  
4 — Define the source and target languages (if necessary). 

     Don’t forget to check the language pair. If it is not the correct combination, the DGT-OT Wizard will not import to 
the project the retrievals and MT files as they will not be pre-processed for that other (incorrect) language 
combination!  

5 — Click on Add — which will open a Windows Explorer window — to select the original document(s) previously 
copied to your computer.  

 In multi-document projects, repeat the operation to add them one by one, even if they are in the same folder. If 
they are in different folders, navigate the folder structure to reach and select all the original documents. 

 Click on Cancel or press ESC in the Windows Explorer window when you have finished selecting the documents. 
6 — By default, the name of the new project is the name of the first document added and it is displayed in the Project 

field, but you can change it if you want.  

        In the project you can include all the documents you want regardless of having or not the same dossier number, 
therefore it might be useful to give it a meaningful name.  
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7 — Click on Create. 
 The DGT-OT Wizard will create the DGT-OT project structure in the OmegaT_Projects folder — in System(C) 

— Users — {your login} — AppData — Local — DGT — importing the document(s) to be translated to the 
\source subfolder, the retrieval and alignment files to the \tm subfolder, the MT files, if any, to the \mt subfolder 
and the IATE extraction — by default — to the project \glossary subfolder.  

     If there are any monolingual reference documents in Tradesk, these documents will not be automatically copied 
to the project. You will have to do it manually.  

8 — Click on Open when that button turns green (which means that the create operation is completed) and it will 
open your project in OmegaT. 

9 — A list of the documents in the project is displayed.  
You can — at any time — change the order of the documents.  
By default, the documents are ordered alphanumerically. If you want you can, with the arrows Up, Down, Move 
First and Move Last, change that order.  
OT will create a folder in the \omegat subfolder with that information and it will “remember” it every time you 
open that project.  

       Very useful, when you have documents with different version numbers and you want to order the documents by 
(part) number ignoring the version number.  

 If you have several documents and want to start translating another document first, click on the document you 
want to translate. You can always see the document list displayed again with the shortcut Ctrl+L or by selecting 
Project Files in the Project menu. 

10 —  Close this window to start translating. OT displays the first segment of the first document for editing in the 
Editor pane. 

 If you have already translated a part of the project, OT will open the project displaying for editing the last 
segment you edited in the prevision session. 

 

You can work in share mode with other colleagues who are working on the same project — or related projects — either 
using OmegaT or the main CAT tool. 

 Section D.2. for detailed information on TeamBase. 
To connect to a TeamBase memory: 
1 — In the DGT-OT Wizard, select the project you previously created and with which you want to use TeamBase, if it is 

not the active project.  
2 — Click on TeamBase in the DGT-OT Wizard. 
3 — Select the memory you want from the list displayed in the left column or accept (changing the name or not) the 

TeamBase memory which is automatically suggested for creation.  
4 — Select the mode in which you want to work: Read (receive) or Read/Write (receive/send). 
5 — Click on Connect to Shared.  
6 — You can start working in shared mode for that specific project. 
If you want to connect to more than one TeamBase, just repeat steps 3 and 5 as, in this case, you can only connect in 
Read mode.  
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Updating a project is very similar to creating a project: 
1 — In Tradesk, do a Local copy of the original documents.   
2 — If OmegaT is open, close it.   
3 — In the DGT-OT Wizard, select the project to be updated by clicking on Select, if it is not the active project, and 

choosing it from the list of your projects.  
4 — Define the source and target languages (if necessary). 
5 — Click on Add — which will open a Windows Explorer window — to select the original document(s) previously 

copied to your computer.  
 In multi-document projects, repeat the operation to add them one by one. Click on Cancel or ESC in the Windows 

Explorer window when you have finished selecting the documents. 
6 — If new version(s) of existing document(s) are added, click on Browse, select the project \source subfolder and 

delete the previous version(s) of the original document(s) that are no longer needed.  
 The segments you already translated are stored in the project memory and are automatically inserted in the new 

version of your document(s) and displayed in the OT Editor pane without any other manipulations. 
7 — Click on Update.  
8 — When that button turns green, click on Open and it will open your project in OmegaT. 
 

If you have one or more memories that you want to use for pre-translation, just: 
1 — Create (or update) your project as explained in the previous sections. 
2 — In the DGT-OT Wizard, click on Browse to open that project folder.  
3 —  Copy/drag and drop (from another Windows Explorer window) the memory(ies) you want to use for 

pre-translation to the tm\auto subfolder. 
4 —  Open the project. 
 100% match segments (tags included) will “auto-populate” your project memory and pre-translate untranslated 

segments in your documents. Those segments will be displayed in the Editor and, by default, are highlighted with an 
orange background to indicate that those are pre-translated segments.  

 Section F.7. for more details on pre-translation using the \tm\auto subfolder.  
You can also pre-translate only a (filtered) part of your project.  

 Section F.8. for information on Search and Pre-Translate.  

    When using Euramis memories for pre-translation, take into consideration that they may be memories of 
post-aligned documents and therefore they may contain misaligned segments!  

 As the match rate is calculated between source segments, if there are misalignments in the Euramis memories, 
the target segments may not be “correct”! 
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If you don’t want to add any new documents, but just add aligned reference documents (tmx files) that you have 
requested via Tradesk (Available legislation) or via Euramis (with copy to \pret) after creating the project, the process 
is basically the same as described in Section D.1.5. above.  
Based on the document(s) you Add, the DGT-OT Wizard will copy any new memories in \pret related to the defined 
document(s):  
1 — If OmegaT is open, close it.  
2 — Select the project to be updated by clicking on Select, if it is not the active project, and check the source and 

target languages.  
3 — Click on Add — which will open a Windows Explorer window — to select the original document(s) that you had 

previously copied to your computer and which are related to the new aligned reference memories you want to copy 
from Tradesk to your project. 

 If the memories relate to documents which are part of a single dossier, you just have to add one of the documents 
in that dossier and the DGT-OT Wizard will copy all the new memories to the project. If it relates to different 
dossiers, select one document from each dossier. 

4 — Click on Cancel in Windows Explorer, or press Esc, when you have finished selecting the documents to which 
those memories refer to.  

5 — Click on Update. 
6 — Click on Open and the DGT-OT Wizard will open your project in OmegaT. 

1 — There is no need to close OmegaT or the open project.  
2 — In the DGT-OT Wizard, click on Browse. The DGT-OT Wizard will display the active project folder in Windows 

Explorer.  
3 — Select the \tm subfolder 
4 — Copy to it the memory files in your computer to be included in that project with copy/paste or drag&drop from 

another Windows Explorer window.  
5 — You can resume your work if that project was open. If not, in the DGT-OT Wizard, click on Open.  
 

You can add documents that you have in your computer. In that case: 
1 —  Close OmegaT. 
2 — In the DGT-OT Wizard, click on Browse and a Windows Explorer window is displayed.  
3 — Copy — from another Windows Explorer window — the document(s) you want to the \source subfolder.  

   Take into consideration that if you do not use the OmegaT Wizard (for confidential documents, for example) and 
you copy those documents directly to the \source subfolder of your project, if there are Word documents in your 
project, they will not be cleaned of useless tags (TagWipe is an operation that is performed by the DGT-OT 
Wizard, not by OmegaT).  

  If it is a Word document and it is a confidential project, do TagWipe manually using the TagWipe application 
available in your Desktop as explained in Section D.1.2.7. 

  You can also work with Remove Tags on if your document has too many useless tags.  
  If it is not a confidential project, you can update it via the Wizard and it will run TagWipe automatically.  
  Just do Add with any document in the project and all documents will be tagwiped again.  
4 — Click on Open to open the project in OmegaT.  
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If you have personal/Unit/Department glossaries that you would like to use in your project, you can adapt them to be 
used in OT as read-only or as writable glossaries.  

Part I for detailed information on Glossaries.  
To add one or more glossaries to your project: 
1 — There is no need to close OmegaT or an open project.  
2 — Click on Browse and select the \glossary subfolder.  
3 — Copy/paste the glossary(ies) to that subfolder.  
4 — Resume your work. 
If you want a glossary to be the writable glossary, the simplest thing to do is just to rename it glossary and that will be 
the glossary to where you will add terminology entries for that particular project. 
 

You may have in Tradesk — or available somewhere else — monolingual reference documents that you want to use in 
your project, like national legislation, standards, reports, etc., to search terminology using the Search Directory 
(Ctrl+Shift+K) feature in OmegaT.  
You can use files in all the formats accepted by OmegaT, notably docx and pdf formats. 

Chapter 9 of the Help in OmegaT for a list of accepted formats. 
To copy monolingual reference documents to your project: 
1 — There is no need to close OmegaT or that project if it is open.  
2 — In the DGT-OT Wizard, click on Browse. The DGT-OT Wizard will display the active project folder in a Windows 

Explorer window.  
3 — Create a new subfolder that you name as you wish. 
4 — Open that newly created folder and copy to it the monolingual file(s). 
5 — You can resume your work if that project was open. If not, click on Open.  
 

You can have as many reference memories as you want as OmegaT can handle — without noticeably losing speed — 
many MB of memories in our service computers. 
Sometimes, to manage the “wealth” of information, it is worthwhile to give a priority — or a penalty — to (groups of) 
memories, and especially so in long and complex projects.  

Section F.4. for detailed information. 
To organise your memories: 
1 —  You don’t need to close OmegaT if your project is open.  
2 —  In the DGT-OT Wizard, click on Browse and select the \tm subfolder of the active project you want to manage.  
 There you have all the memories that were automatically copied to your project by the DGT-OT Wizard when the 

project was created or updated.  
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3 —  Rename those external memories — to give them priority individually (Example: 1-Financial-Regulation-
32012R1268–EN-PT.tmx and so on) or create subfolders with the names you want — preceded by a number 
according to the priority you want to give them (Example: 1-Financial-Regulation, 2-Horizon2020) — and copy or 
drag&drop the relevant memories to those subfolders.  

4 —  If you have other local memories that you want to add to the project, just copy them (from another Windows 
Explorer window) to the \tm folder or to the subfolders you created. 

5 —  You can resume your work if your project was open. If not, click on Open in the DGT-OT Wizard.   
 

Sometimes, it is useful to give priority to reliable translation memories over less reliable ones.  
Machine Translation doesn’t need to have a penalty because it is stored in a separate folder (\mt), is only displayed in its 
specific pane and is never mingled with human translations from Euramis. 
To give a penalty to one or more memories, you can create subfolders with names like "penalty–xxx" where xxx is a 
number from 0 to 100.    

Section F.5. for detailed information. 
To give a penalty to memories: 
1 — You don’t need to close OmegaT if you have your project open. 
2 — In the DGT-OT Wizard, click on Browse and select the \tm subfolder of the active project.  
3 — Create a subfolder and give it a name indicating the penalty you want to give (e.g. penalty-30).  
4 — Copy the translation memory file(s) into it.  
5 —  You can resume your work if that project was open. If not, click on Open in the DGT-OT Wizard.   
 

You can also translate multilingual documents in a single project without the need to divide the documents by source 
languages. However, the project memory — which will, by definition, be multilingual — should not be sent to Euramis. 
As these documents usually are not pre-processed, you will have to request Euramis retrievals and machine translation 
manually. 
If there are only a few segments in one of the languages, the simplest thing is to create the project with only retrievals 
and machine translation in the main language pair. If it is worthwhile, you can request it for both: 
1 —  Do a local copy of the document to include in the project. 

2 — In Euramis — Retrievals, request retrievals —  Section C.2.2 — for both language pairs without dividing the 
documents, selecting the language pair and repeating the operation for the other language pair.  

 Those retrievals will only have segments with matches… and there will be no matches for the wrong language pair. 
Choose the option of having the retrievals sent to you by email.   

3 —  In MT@EC, request MT for each of the documents.  Section C.3.  
4 — With the DGT-OT Wizard, create a new project in OmegaT defining one of the language pairs of the project (OT 

has no special code for multilingual documents).   
5 —  Open the emails with the retrievals and machine translation files and copy them, respectively to the project \tm and 

\mt folders.   
6 —  Open the project.   
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A new OmegaT feature is that it now allows the use of a reference translation memory with the source language identical 
to the source language of your project and the target language of the reference memory different from the target 
language of your project, displaying it in the Editor below the original source segment.  

Section F.6. for detailed information. 
You must copy that memory to a subfolder of the \tm folder named \tmx2source. This subfolder is not automatically 
created when the OmegaT project is created (either via the DGT-OT Wizard or directly in OT). You have to create it 
manually. 
To use this OT feature: 
1 —  In Euramis, request an alignment of the document you want to have displayed as source (besides the real original) 

in the Editor pane.  
2 —  Rename it with the target language code (Example: for an EN-PT project, if you want to use an EN-FR translation 

memory to see the French translation besides the EN original, rename the requested memory FR_FR).  
 You can see a list of the language codes either in OT — under Help — or in the Project → Properties menu → 

Source File Language.  
3 — You don’t need to close OmegaT if you have it open in that particular project.  
4 — In the DGT-OT Wizard, click on Browse and select the \tm subfolder of the active project.  
5 — Create a new subfolder — under the \tm folder — named tmx2source.  
6 — Copy the relevant translation memory file into it.  

  You can only have one file in that subfolder. If you are using this feature for several documents in your project, 
either merge the tmx files or use one at a time for the particular document you are translating. 

7 —  You can resume your work if that project was open. If not, click on Open in the DGT-OT Wizard.   

This is also a new OmegaT feature. You may want to give absolute priority to an external memory — even overriding the 
segments already translated and stored in your project memory. This may be the case, for instance, of a revised part of 
one or more documents. 

 Section F.9. for detailed information. 
For that purpose, you can create a subfolder in the \tm folder — that is not automatically created when the OmegaT 
project is created (either via the DGT-OT Wizard or directly in OT) — named enforce and copy into it the memory(ies) 
you want to use: 
1 —  If OmegaT is open, close it. 
2 —  In the DGT-OT Wizard — with that project as the active project — click on Browse and select the project \tm 

folder 
3 — Create a new subfolder named enforce.  
4 —  Copy to that subfolder the memory(ies) that you want to use for this purpose. 
5 — Open the project. Segments that are 100% (including tags) in that/those memories will be transferred 

(auto-populated) to your project memory 

  Afterwards don’t forget to delete that folder from your project unless you want that/those memories to keep 
overriding any changes you may make later to those segments! 
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If may happen that you want to split or merge segments because you have a poorly formatted original — for instance 
with soft returns in the middle of a segment or with tables with segments split in 2 cells — or for any other reason. 
The easiest way is to: 
1 — Open the original document(s) that you copied to the Dossiers folder (Local Documents — no backup — DGT — 

Dossiers) and make all the corrections you want (it will not affect the original in Tradesk, of course). 
2 — Save and close the original document(s). 
3 —  In the DGT-OT Wizard, update the project with the corrected original(s) the usual way, by clicking on Add, selecting 

the corrected documents and clicking on Update. 
 OT will display the original with the changes you introduced as it will segment and process the original again. 

    It has an advantage: you can even merge paragraphs if you want! 

In the DGT-OT Wizard, the approach taken was that, in the huge majority of cases, you will want all the external memories 
available in Tradesk to be copied to your project and, as OT has no problems to deal with large amounts of tmx files, you are 
not prompted about what memories to import to the project when you create or update it. 
So, the DGT-OT Wizard just imports all the memory files in Tradesk \pret folder related to the relevant language pair.  
However, there may be projects in which you may prefer, for some reason, not to use certain memories.  
To easily delete memories from your project:   
1 — You don’t need to close OmegaT if you have it open in that particular project. 
2 — In the DGT-OT Wizard, click on Browse and select the \tm subfolder of the active project.  
3 —  Delete the tmx file(s) you don’t (any longer) want to have in the project. 
4 —  You can resume your work if that project was open. If not, click on Open in the DGT-OT Wizard.   
 

As already explained in previous sections, if you want to copy the translated documents (even during the translation 
process) to make them available to everybody in Tradesk or to finalize them and send them to the requester: 
1 —  Check that you have no translated documents from that project open in their native applications.   
2 —  In OT, do Create (Current) Translated Document(s) (Ctrl+(Shift+)D).   
3 —  In Tradesk, Upload the document(s) you want from the project \target subfolder (or from any other subfolder if 

you have copied it/them to another folder).  
 

As already explained in a previous section, if you want to send translated documents memories to Euramis: 
1 — Generate the memory(ies) to be sent to Euramis by clicking on Ctrl+Shift+F8 (or Tools — Scripting — Create 

Euramis Export) to generate individual memories of your documents with the attributes required by Euramis. 
Those memories are saved in the \euramis subfolder of your project.  

2 — Open the Euramis interface and select the individual memory(ies) to be sent to Euramis in the abovementioned 
subfolder. 

    To see to which Euramis Memory are your particular document(s) to be saved, when in doubt, see the Euramis 
→ Statistics & Managers → List to see Where to Save a document from a given DG, service or Cabinet 

3 —  You will receive an email with the confirmation that the memory of your document(s) has been saved. 
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If your reviser wants to use OT to revise your document(s) — and if you have done all your translation work using OT, of 
course — you can do it but with some manipulations on your part as there is currently no automated revision workflow.  
In a nutshell: 

i. The translator prepares the project for revision and copies it to a server,  
ii. The reviser copies to his/her computer the project for revision, does the revision work and finalizes the project if 

he/she has the last word or, if the translator has the last word, copies the revised project to the server, 
iii. If the translator has the last word, he/she copies to his/her computer the revised project, checks the changes 

made by the reviser — accepting them or not — and finalizes the project. 

  Section A.9. for the general revision workflow which will cover most of the normal work. 

  Part N for a detailed explanation of the revision process and variants for complex projects with more than one 
translator and/or reviser and/or with a number of new versions while the project is being revised. 

Here is only briefly explained the “manipulations” that have to be done to prepare a project for revision in 2 “standard” 
situations: sending the whole project for revision and sending only some documents for revision from a multi-document 
project. 
 

In the more usual case of a single or multi-document project that is translated by 1 translator and revised by 1 reviser 
and all the documents in the project, either one or several, are sent at the same time for revision, the workflow is simple 
as explained in Section A.9. 

To prepare the project for revision, the translator: 
In Windows Explorer:  
1 —  Selects the OmegaT_Projects folder which is under C:\Users\{your login}\AppData\Local\DGT. 
2 — Does a copy of the project to be sent for revision to that same folder by highlighting the project folder name and 

pressing Ctrl+C and Ctrl+V.  
3 — Renames the new project folder thus created (which Windows Explorer automatically renamed 

{name-of-the-project} copy).  

   It can be renamed, for instance {name-of-the-project}-FOR-REVISION. 
      This way, the original project will remain intact and it can always be reused. 
In the copy of the project for revision in Windows Explorer: 
4 —  Opens the project folder. 
5 — In the \tm folder of the project, creates a new subfolder — for example called 0-DRAFT-translation — thereby 

giving it the maximum priority in the display in the Fuzzy Matches pane when the reviser does the revision work. 
6 — Does a copy of the project memory (project_save.tmx file) in the project \omegat subfolder to this new 

subfolder. 

  Don’t delete the project memory from the \omegat subfolder.  
7 —  Copies the project to a location on a server that has been agreed with the reviser or which is the location used in 

Unit/Language Department to exchange projects (or copies it to a USB key). 
8 — Informs the reviser that the project is ready for revision and indicates the location. 
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In the case of a multi-document project that is only partially sent for revision, the translator may not want to send the 
whole project memory because one or more documents in the project may be only in a very “raw” phase and not ready 
for revision and its display in the Fuzzy Matches pane — when the reviser does his/her work — might be misleading. 
The translator can, if he/she wants, send only the memory(ies) of the documents that are ready for revision by extracting 
— from the whole project memory — only the segments from those documents. 

  Part N for a detailed explanation of the whole workflow and variants. 

To prepare the project for revision, the translator: 
In the original translation project in the OmegaT_Projects folder: 
1 — Closes any generated translated documents from that project that may be open in their native applications. 
2 —  Generates the individual translation memories to be used for revision by pressing Ctrl+Shift+F9 (or Tools → 

Create OmegaT Export) and selecting the document(s) to be sent for revision in the window that pops up.  
 OT will generate memory files by document to the project \export-omegat folder. 
3 —  In Windows Explorer, does a copy of the project with Ctrl+C and Ctrl+V (to that same OmegaT_Projects folder) 

and renames it (for instance {name-of-the-project}-FOR-REVISION).  
This way, the original project will remain intact and can always be reused. 
In the copy of the project for revision: 
4 —  In Windows Explorer, opens the project folder. 
5 — Copies the memories generated in the \export-omegat folder to the \tm\auto folder.  
 Optionally can rename it/them (for instance, {name-of-the-document}-DRAFT) so that there is no doubt that these 

are memories before revision.  
6 — Opens the \omegat folder and deletes all the memories there. Usually there will be the project_save.tmx file and 

several backups (example: project_save.tmx.201503121120.bak or project_save.tmx.bak), leaving  the other 
files in this folder as they are. 

11 —  Copies the project for revision to a location on a server agreed with the reviser or which is the location used in the 
Unit/Language Department to exchange projects (or to a USB key). 

12 — Informs the reviser that the project is ready for revision and indicates the location. 
 

When a project is created or updated, an automatic backup is made to your H: drive (H:\CAT\OmegaT-Projects). This 
drive is itself automatically backed up by the IT Unit. 
Automatic backups: The DGT-OT Wizard updates automatically the backup of your active project every 10 minutes. 
In case of problems in your computer, the whole project backup folder can be copied to another computer or to your 
repaired computer and be used without any conversion.  
If it is copied to your service computer, copy the project to the OmegaT_Projects folder in your computer (after having 
reinstalled OmegaT if necessary). If not, you will not have the DGT-OT Wizard, but you can open the project directly in 
OmegaT. 
Manual backups — By clicking on Backup in the DGT-OT Wizard, you can manually update the backup any time you 
want. 
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If you delete, by accident, any file in the OT project and you want to get it back, you can retrieve it from the backup in the 
H:drive.  
The backup that is done every 10 minutes only copies new files or modified files to the H:drive. It does not delete files 
even if they are deleted in the project folder in your computer. 

 So, just open the copy of your project in the H:\CAT\OmegaT_Projects and recopy the files you want to your 
ongoing project. 

 Another way to retrieve deleted files is to Restore them from the Recycle Bin. 
 

Considering that Euramis strips all formatting from the segments it stores, it may be interesting to save — in a dedicated 
folder in your computer — all the memories of projects that you have finished with OT for later reuse. 
For example, if new versions of already released — and heavily formatted — documents arrive, it would be a waste of 
time to reinsert all the tags… which is what you will have to do if you retrieve that document's memory from Euramis… 
and you want to use OmegaT. 

 Remember that in the present implementation of OmegaT in DGT, the documents are not converted to xliff 
format. 

When DGT-OT is installed, it is automatically created an empty folder in the OmegaT_Projects folder named 
_PROJECT-MEMORIES to where you can copy the memories of the documents finalized with OT and sent to Euramis. 
Or you can copy them anywhere else you want, of course. 

 I suggest that you copy to this folder, at least, the memory(ies) you send to Euramis and, if you want to keep 
memories with notes and alternative translations, also the memories generated by the Create OmegaT Export 
script (Ctlr+Shift+F9). 

 

When DGT-OT is installed, an empty subfolder is automatically created in the OmegaT_Projects folder named 
_PROJECT-ARCHIVE to where you can copy the memories of the documents finalized with OT and sent to Euramis. Or 
you can copy them anywhere else you want, of course. 
1 — In the DGT-OT Wizard, click on Select and the OmegaT_Projects folder is displayed.  
2 — Drag and drop to the _PROJECT-ARCHIVE subfolder the finalized project you want to transfer.   

   If later on you want to work on that project again — for example, because you have a new version of a document 
in that project and you want to use it — do the opposite, i.e., drag&drop that project from the 
_PROJECT-ARCHIVE subfolder to the OmegaT_Projects main folder.  

  The active project has to be in the OmegaT_Projects folder so that you can add documents and update the 
project, have automatic backups, etc.  
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You may also want to delete from your local drive projects that you no longer need.  
1 — In the DGT-OT Wizard, click on Select and the OmegaT_Projects folder is displayed.  
2 — Highlight the project you want to delete and double click with the mouse right button and select Delete. 

  If later on you want to work on that project again — for example, because you have a new version — there will 
still be a backup copy in the H:drive … unless you deleted it too!  

 

OmegaT imports and exports memories in an open file format (tmx) that can be used in other CAT tools.  
Therefore you can start translating a document with OmegaT and if, for any reason, you prefer to continue translating it 
in another CAT tool, you can use the OmegaT memory of your project (and vice-versa) without losing the work already 
done. 
 

1 —  Press Ctrl+D to create your translated document to generate the level1, level2 and omegat memories in the 
project main folder.  

2 — Import the level2.tmx file (with formatting) in the other CAT application. 

     You can also import the level1.tmx file (without formatting) if there are problems with the formatting. 

You can also do it the other way around: 
1 —  Export the memory in the other CAT tool to the standard tmx format. 
2 — Copy it to the tm\auto folder of an OmegaT project you had already created. 
3 —  In the DGT-OT Wizard select that project and open it.  
 The Editor window will display all the segments that exist in the memory you copied to the tm\auto folder that 

have 100% matches (formatting included). The others will be displayed in the Fuzzy Matches pane. 
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For projects that are translated by two or more translators — or revised by two or more revisers — it is important to be able 
to share the work that is being done in real time.  
With DGT-OT, the sharing is done using TeamBase, the DGT in-house application which is managed via the DGT-OT 
Wizard.  
With it, you can control when and how you want to work in share mode, depending on your work method and practices in 
your Unit/Language Department.  

 Sections I.1.7. and F.10. if you also want to share glossaries and/or external translation memories with other 
translators/revisers. 

 

 
Screenshot 36 — TeamBase window 

 
A TeamBase memory is a bilingual memory that is created on a server and which receives — in real time — a copy of 
each translated segment validated by the translators connected to it in Read/Write mode.  
In the TeamBase window you have 3 columns which display:  
v All the TeamBase memories available for your language pair, in the left column.  

Here you can connect to a TeamBase in the desired connection mode (the mode displayed in the button) or 
change its connection mode and reconnect again; 
 

v The memory(ies), if any, to which you are connected, in the middle column.  
Here you can check (by highlighting the name of the memory) in what mode you are connected and it is also 
here that you disconnect from the highlighted memory;  
 

v The memories, if any, of which you are the owner, in the right column.  

    When you close a particular project and later reopen it, you will remain connected or unconnected to TeamBase as 
you were before you closed the last session with that project. So check if you want to change anything! 
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You can connect to a TeamBase memory in Read mode only — in which case you receive segments from your colleagues, 
but you do not send your (validated) segments — or in Read/Write mode — in which case you receive segments from your 
colleagues connected to the same TeamBase in Read/Write mode and also send your segments.  

 The selection you make will only affect the active project. Other projects that may be ongoing will remain connected 
(in either mode) or unconnected depending on the option you choose the last time you worked with it/them. 

You can share your translation — segment by segment — in real time from the very beginning by connecting to a TeamBase 
memory previously created for that particular project (or that you create yourself). 
You can also decide to only share your translated segments later when you consider that they are already sufficiently “good” 
to be of any use to others, while continuing to receive segments translated by others.  

      This feature is particularly useful if you first do a fast draft translation which you afterwards improve. 
Usually the “coordinator” of the project will create a TeamBase memory for your language pair to which others can connect 
to. That translator is considered the “owner” of that TeamBase memory and the only one who can delete it (besides the IT 
Unit, of course). 
The TeamBase memory is hosted in a server and it interferes in no way with (the memories of) your project which is in your 
computer. Each translator continues to have its own local project and it will remain “untouched”.  
You will only see — in the Fuzzy Matches pane — the segments coming from TeamBase identified with the usual attributes 
plus “TeamBase” at the beginning. 

 
Screenshot 37 — Matches from TeamBase identified in the Fuzzy Matches pane 

 

The TeamBase memory is created empty and will only have a copy — automatically done in real time — of the segments 
that you and other translators send for sharing by being connected to it in Read/Write mode.  
It is the validation of each segment in OmegaT (with Return) — either of a new translated segment or of a modified or 
unmodified one — that triggers the copy of that segment to the TeamBase memory (besides storing it locally in your project 
memory, of course).  

 The segments you — or your colleagues — translate in Read mode or disconnected will not be sent to the 
TeamBase memory. 

If you are connected in Read/Write mode and you modify a segment that is already in the TeamBase memory, the previous 
translation will be replaced by the new one, i.e. the TeamBase memory only keeps the last translation of a unique segment 
with the same translator’s login.  
So, in the translation of a project, you can modify any segment several times and — in the TeamBase memory — there will 
only be your last translation of each unique segment, which will be displayed in the Fuzzy Matches pane in the other 
translators’ projects and in your own.   
You can connect to other TeamBase memories as there may be several projects ongoing that may be (distantly) related, but 
you can only connect to them in Read mode. Only the first selected memory can be in Read/Write mode. 
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To connect to an existing TeamBase memory: 
1 — In the DGT-OT Wizard, select the project you previously created and with which you want to use TeamBase, if it is 

not the active project.  
2 — Click on TeamBase. 
3 — Select the memory you want from the list displayed in the left column.  
4 — Select the mode in which you want to work: Read (receive) or Read/Write (receive/send). 
5 — Click on Connect to Shared 
6 — You can start working in shared mode for that specific project. 
If you want to connect to more than one TeamBase, just repeat steps 3 and 5 as, in this case, you can only connect in 
Read mode. 
 

To create a new TeamBase memory you have first to create the project using the DGT-OT Wizard, if you haven’t done it 
yet. 
1 — In the DGT-OT Wizard, select the project with which you want to use TeamBase if it is not the active project.  
2 — The name of your project will be automatically inserted in the field at the bottom of the Available Shared 

Memories column. 
 If you want, you can change it to a name that is meaningful to you and your colleagues.  
3 — To work on that project, select the mode in which you want to connect: Read (receive) or Read/Write (receive and 

send). 
 The other translators may choose, at different times, to work in either mode. 
4 — Click on Connect to Shared 
5 — You can start working on your project. 
 

If you want to change from Read/Write to Read only — or vice-versa: 
1 — With the project in question selected in the DGT-OT Wizard, click on TeamBase 
2 — In the middle column, click on the name of the memory you are sharing 
3 — Click on the option displayed — Read/Write or Read — to change the mode.  
4 — Close the TeamBase window. 
5 — You can resume your work. 
If you change from Read/Write to Read, you will no longer be sending the segments you translate from then on to the 
TeamBase memory, but you will continue to receive segments from the others.  
If you change from Read to Read/Write you will start sending the segments you validate after changing the connection 
mode.  

 The segments you may have translated in Read mode or disconnected have not — and will not — be sent to the 
TeamBase memory. 
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You can disconnect from a TeamBase memory at any time: 
1 — With the project selected in the DGT-OT Wizard, click on TeamBase 
2 — Select the name of the memory in the middle column 
3 — Click on Disconnect From Shared.  
You will no longer receive nor send segments from/to that memory.  
If you are connected to more than one TeamBase memory, the other(s) will remain connected. If you want to disconnect 
from all, you have to disconnect one by one. 
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When you create projects directly in OmegaT, you will not have: 
1 — Automatic backups to the H:drive, so take appropriate measures concerning backups. 
2 — Your documents, if they are docx, will not be automatically wiped of useless tags and you will have to use the 

TagWipe available in your Desktop or work in OmegaT with the “Remove Tags” options (in the Project — 
Properties menu) activated if your document(s) have too many useless tags. 

3 — You will not have automatically retrievals and machine translation copied to your project from Tradesk. You will 
have to do it manually. 

You can create the project in your computer or in a USB key, depending on the security instructions.  
 

1 — In Tradesk, copy the originals to your computer. They will be, as usual, copied to the Dossiers folder 
(C:\Users\{your login}\AppData\Local\Local Documents — no backup\DGT\Dossiers) 

2 — In the DGT-OT Wizard, open any project to open OmegaT as in DGT the access to OmegaT is done via the 
DGT-OT Wizard. 

3 — Close the DGT-OT Wizard so that it does not do automatic backups to a server. 
4 — In OmegaT, close the project (Project → Close).  
5 — Create a folder where you want to create your OT project or use the OmegaT_Projects folder (or a subfolder of 

it) in your computer. 
6 — In the Project menu (or with the shortcut or the icon), click on New  

 
Screenshot 38 — Project menu 

7 — In the Windows Explorer window that pops up, select — in the field Save in — the folder in which you want to 
create your project and — in the field Folder name — the name you want to give to your new project. 
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8 — In the Create New Project window, select the source and target languages of your project.  
 It is here that you can also change the location of your project at any time. But for the moment accept the 

defaults. 

 
Screenshot 39 — Edit Properties menu 

9 —  In the Project Files window that is displayed (empty), click on Copy Files to Source Folder, select the folder 
where you have the original document(s) and select the documents you want to use in your project.  

 
Screenshot 40 — Project Files menu 
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10 — OT displays the list of documents in your project. Click on Close to accept the opening of the first segment of the 
(first) document. You are now ready to start the translation of your project.  

 If it is a multi-document project and you want to translate another document, just do Ctrl+L (or select Project 
Files in the Project menu) and the list will be displayed again and you can select the document you want by 
double-clicking on it.  

 You can also change here the order in which OT displays the documents in your project by highlighting the name 
of a document and clicking on Move First, Move Up, Move Down or Move Last.  

11 —  If you have external memories, in Windows Explorer copy them to the project \tm subfolder.  
12 —  If you have machine translation files, create a \mt subfolder (not automatically created) and copy those files to it.  
 

To update or modify a project directly in OmegaT, it is, mutatis mutandis, as explained in Section D.1, but without the 
help of the DGT-OT Wizard to interface with Tradesk and so you will have to do all the operations manually.  
You can access the open project via the Tools menu, under Scripting → Project Folder or with the shortcut 
Ctrl+Shift+F1 and manage your project directly via Windows Explorer. 
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In the Tools menu, you have, among other things: Statistics, Match Statistics and Match Statistics per File. 
These statistics are stored in the project \omegat subfolder and are replaced every time you run the statistics again. 

 Getting Statistics is a fast process, but Match Statistics (per File) can take a while if you have a really big 
project of hundreds of pages. The good thing is that, by default, you can do it any time (during a coffee or lunch 
break) and not necessarily when you create or update a project! 

 

 
Screenshot 41 — Statistics in the Tools menu 

 
As OT will replace the statistics files when you run statistics again, if you want to keep a record of the progress in the 
translation of your project, you can access the DGT-specific OT_Stats Excel sheet via the DGT-OT Wizard by clicking on 
the Stats button.  

 
Screenshot 42 — DGT-specific OT_Stats Excel sheet  
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Furthermore, the statistics of the segments translated and to be translated (unique and non-unique) are displayed in real 
time at the bottom-right of your OT window so that you always know how advanced you are in your work, in terms of 
segments.  

 

15/615 Number of segments — translated vs. total for the current file 

14/551 Number of unique segments — translated vs. total in the project 

615 Total number of segments (including repeats) in the project 

123/146 Number of source and target characters in the current segment 

Screenshot 43 — Real-time statistics displayed at the bottom-right of the OT window 

  Take into consideration that, if you have many segments you want to keep in the original language and you don’t 
translate them, they will be counted as untranslated in the statistics. So you may have a nice surprise at the end! 

In the Tools menu you can select Statistics to see the statistics concerning the documents in your project by segments, 
words and characters — unique and non-unique — with the indication of the segments already translated and to be 
translated. 

 I suggest also that you copy this initial statistics (highlighted in blue below) to the OT_Stats template 
automatically copied to your project by the DGT-OT Wizard (  Section D.4.5. below).  

 

 
Screenshot 44 — Project statistics 



  

 
110 

Also in the Tools menu you can select Match Statistics in order to have statistics for your documents in terms of match 
percentages with the external translations memories in your project, and your project memory if you already started your 
translation, also by segments, words and characters (with and without spaces). 

 Again I suggest that you also copy these initial statistics (highlighted in green below) to the OT_Stats Excel sheet. 

\  
Screenshot 45 — Match statistics 

These statistics give you a (pretty good) idea of the translation work involved. Take into consideration that they are not 
“perfect” and that may be somewhat different from those obtained in other CAT tools.  

 I suggest that you run Match Statistics before starting the project, so that you can have the statistics exclusively 
from the external memories, i.e. without any of your work.  

In fact, when producing the match statistics, OT will take into consideration all the memories: the external memories in the 
\tm folder (and subfolders, if any) and the project_save memory (your translated segments).  
So if, in the middle of the translation process, you run Match Statistics again you will have a mixture of matches from the 
external memories and your project memory. 
According to the public OmegaT Help: 

Ø Repetitions stand for identical segments present several times in the text. The first segment and its 
contents will be classified as "no match", and the rest of them as a repetition of the first.  

Ø If the translation for several identical source segments already exists in the translation memory of the 
project, these segments, together with other, already translated unique segments, will be classified as an 
"Exact match".  

Ø The number of unique segments, if needed, is provided in the standard statistics window, regardless of 
whether they have been translated or not. 

Ø The rest of the categories (50–100%) involves untranslated segments with a fuzzy match. 
Ø Fuzzy matches can come from the /tm folder and from the internal translation memory in /omegat folder, 

as is the case for repetitions and exact matches. The only difference with matches from the project_save 
translation memory is that external TMs cannot give exact matches, only 100%.  

Ø Spaces between segments are not taken into account in the last column. 
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This is a new OT feature that is very useful to detect the documents in a project which have (many) repetitions, if any, 
within the documents in the project. 
These statistics give you a detailed view, per document in the project, of how much new text you will have to translate as 
work progresses. It is also very useful to distribute work if there are several translators (and/or revisers) involved in a 
project.  

 
Screenshot 46 — Match Statistics per File 
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You have automatically copied to your project main folder an Excel sheet template — OT_Stats — in which you can 
record manually your progress in the translation of your project, just by copying/pasting the data in the statistics given by 
OT as shown above. The results are converted to pages (1 page = 1500 characters without spaces). 
You can easily open this Excel sheet from the DGT-OT Wizard or open it from your project folder (Ctrl+Shift+F1) in 
OmegaT.  

 
Screenshot 47 — OT_Stats excel sheet (example)  

In this Excel sheet, you can record statistics in terms of words, segments, characters (characters with and without 
spaces) and pages (1500 characters without spaces): 
1 — Copy the Statistics results shown in Screenshot 44 marked with a light blue line to the corresponding cells in the 

Excel sheet above also marked with a blue line to record the initial statistics before starting translating a project. 
2 — Copy the Match Statistics results shown in Screenshot 45 marked with a green line to the corresponding cells in 

the Excel sheet above also marked with a green line to have the initial Match Statistics before starting 
translating a project.  

3 — As your work progresses, you can select again the option Statistics and copy the results to Latest Statistics in 
the Excel sheet marked with a dark blue line above to see how much you have progressed.  

4 — Furthermore, you can copy the cell marked in violet to the Pages translated section if you want to have an idea 
of how much time it is taking you translate that project by hour/day/week etc. 

5 — You can repeat points 3 and 4 replacing the Latest Statistics as many times as you want. 
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For a medium/large project, if you are using machine translation, you may have repeatedly inconsistent terminology that 
you may prefer to correct in the machine translation file so that it already proposes segments with these inconsistencies 
corrected. 
The most practical way is to use the Euramis Alignment Editor that you can access just by searching for it in the DGT 
Applications. 
1 —  Open the Euramis Alignment Editor 
2 —  Select File → Open 
3 —  The OmegaT projects folder is: C:\Users\{user login}\AppData\Local\DGT\OmegaT_Projects. Select the 

project you want, its \mt subfolder and the MT file to be changed. 
4 —  Use the Search — Search/Replace feature to change the terms/strings you want. 
5 — Save the changed file. 
  

 
 
 

Screenshot 48 — Changing MT output in Euramis Alignment Editor 
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Depending on the way you prefer to work, you can use the Menus to perform all operations or use (some) shortcuts or 
icons. In Part Q you will find a list of all the shortcuts (both from the public version and DGT-specific). You can change 
them… if you are an advanced user.  
In this Section are briefly explained the menus available in DGT-OT so that you can have an overview of all the options 
available and quickly see the ones that are of interest to you. 
As some of the most important features have options in several menus and submenus, they are explained in detail in 
separate thematic sections of this Guide. The most important menus for general daily work are highlighted in green 
below 

 You can print the ones more important to you until you get familiarised with DGT-OT features. 
OmegaT has 7 main menus sometimes with submenus. Each menu/submenu allows carrying out several operations: 

Ø Project:  
v Properties 

§ Segmentation 
§ File Filters 

v Project Files 
Ø Edit:  

v Switch Case To 
v Select Match 

Ø Go To 
Ø View  

v Modification Info 
Ø Tools  
Ø Options:  

v Machine Translation 
v Glossary 
v Transtips 
v Auto-completion 

§ Glossary 
§ Auto-text 
§ Character table 

v Font 
v File filters 
v Segmentation 
v Spell Checking 
v Editing Behaviour 
v Tag Validation 
v Team 
v External TMXs 
v View 
v Saving and Output 
v Proxy Login 
v Restore Main Window 
v Language Checker 

Ø Help:  
v User’s Manual 
v About 
v Last Changes 
v Log 



  

 
116 

This menu allows, among other things, to create, open and update projects, change the order in which the original 
documents are displayed and change project settings. 
For some of these features — besides the shortcut — there is also a DGT icon.  
 
 

  

 

To create a new OT project. This is usually done via the DGT-OT Wizard to 
benefit from the integration with Tradesk. 

Not implemented in DGT. TeamBase is used instead. 

 To display the original (source) document you are translating in 
its native application.  
 

Reload when new source files are added to the project or source files are 
deleted. OT also prompts you if you want to reload when you change your 
preferences 

Manual save. By default, OT does automatic backups every 3 minutes to 
the \omegat subfolder. This has nothing to do with the backups the 
DGT-OT Wizard does of the whole project every 10 minutes to the H:drive. 

To generate all the (finished or incompletely) translated documents in the 
project in their native application. 

Not used in DGT. 

 To generate only the (finished or incompletely) translated document 
you are working on in its native application. The same applies: you cannot 
have translated documents open in their native applications. 

To open the target document you are translating in its native 
application. Be sure that there are no translated documents open in their 
native applications. If there are, OT will get stuck! 

Project submenu that allows changing the project settings 

 Section E.2.2 below. 

Project submenu listing all the files in the project. It allows changing the 
order of display of the source documents in the Editor. 

 Section E.2.1 below. 
 

To close the project without closing OT. 
 

       

To open a project. In DGT, the access to OT is done via the DGT-OT Wizard. 
It is recommended to always open projects via the DGT-OT Wizard to have 
automatic backups every 10 m.  Confidential documents are the exception. 

To add original documents to the project. It is recommended to do it via the 
DGT-OT Wizard to have automatic cleaning of useless tags (TagWipe) and 
an IATE extraction. 

To close the project and OT. 
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After creating a project with the DGT-OT Wizard, the list of documents in the project is displayed. Here you have 
information about the documents in the project: name of the documents, filters used, encoding and some statistical 
information. 
In this menu, you can also change the order in which the documents are displayed for translation in the Editor. 
If you have several documents in your project and you want to start translating a document which is not the first one 
displayed in the list, just click on the number/name of the document you want and OmegaT will display it in the Editor 
pane and open its first segment.  
If you change your mind, just press Ctrl+L (or in the menu Project select Project Files) and you will see this list again 
and you can select another document or change the order again.  
If you had already translated a part of your project, when you open it OT will “remember” the last segment you edited 
and will open it (instead of the first segment of the project). 
 
 
 
 

 
 
 
 
 

 

Number of files in your project Number of unique segments by document — 
non-unique (repeated) segments excluded 

 

 To define the order in which 
documents are displayed in the 
Editor, highlight the name of a 
document and move it up, down, 
first or last in the list  

Documents in your project. By default, documents are displayed 
by alphanumeric order. 

Number of total segments (repetitions included) by document 

Technical information: filters 
and encoding 

Snapshot statistics by segments: 
total and unique segments and 
already translated segments 

Not used in DGT. To copy originals to the project \source folder.  
In DGT, this is usually done via the DGT-OT 
Wizard which automates the process importing 
translation memories and an IATE extraction and 
cleaning superfluous tags (TagWipe) in docx 
documents.  

To close this window. 
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In this menu you can define/change some project settings. In general, you will not have to define any as the DGT-OT 
Wizard creates the project with adequate tokenizers, segmentation and file filters.  
Concerning segmentation, it is by default done at segment-level, but you may want to change it to paragraph-level in a 
particular project. However, take into consideration that segmentation rules in Euramis and Machine Translation are also 
at segment-level and therefore you will probably not have many/any matches from them. 
If you want, you can also change the segmentation rules themselves. The changes made in this menu are 
project-specific. By default, segmentation rules are always project-specific when a project is created via the OT Wizard. 
You can also change here the location of your projects folders, namely the glossaries and external memories location. In 
DGT, the DGT-OT Wizard creates the new projects in the OmegaT_Projects folder and it is not recommended to 
change the project structure… unless you know what you are doing.  
 

 
 
About stemmers. Here is some basic information taken from the OmegaT Help: 
Tokenizers (or stemmers) improve the quality of matches by recognizing inflected words in source and translation 
memory data. They also improve glossary matching. 
A stemmer for English, for example, should identify the string "cats" (and possibly "catlike", "catty" etc.) as based on the 
root "cat", and "stemmer", "stemming", "stemmed" as based on "stem". A stemming algorithm reduces the words 
"fishing", "fished", "fish", and "fisher" to the root word, "fish". This is especially useful in case of languages that use 
pre- and postfix forms for the stem words. 

 Technical setting: Tokenizer  Languages: Defined by the DGT-OT Wizard when creating a new 
project. 

            

By default, segmentation is at segment-level (as in 
Euramis and MT). You can change it to paragraph-level  by 
unticking the box here. It will only apply to this project. 
 

Auto-propagation can be deactivated here. You can 
change this setting at any time in the translation of a 
project, but segments already propagated will remain so.  

You can translate a project without any inline tags by 
activating Remove Tags. It is not recommended to do so 
after starting the translation of a document/project. 

Here you can change the location of the writable glossary 
file. It must be the same as the location of the Glossary 
folder.  

Here you can change the location of the glossary folder. It 
is defined for each project 

Here you can change the location of the dictionaries, if 
any.  

 Section E.2.3. below. 

 Section E.2.4. below. 

Here you can change the location of the external 
memories folder. It is defined for each project. 



  

 
119 

Again, in general, you will not have to change anything in this menu as the DGT-OT Wizard creates the project with the 
adequate segmentation rules for the language pair of your project. 
Segmentation is always a problem although the segmentation rules have been greatly improved to match, as much as 
possible, Euramis and Machine Translation rules. But they are not perfect ... namely with poorly formatted original 
documents. 
The IT Unit tries to improve segmentation rules for the 24 official languages and therefore there are sometimes changes.  
As projects can be updated with new versions or documents, in DGT segmentation rules are, by default, project-specific 
so that, when you update a project you will not have — as orphans/untranslated — segments that you had translated 
before … but which are considered untranslated due to different segmentation rules. 
If you want you can change those rules in this menu and they will be project-specific. To change the segmentation rules 
for all your projects,  Options → Segmentation menu. 

  Chapter 14 on Segmentation of the public OmegaT Help/Guide for more information as this feature is not covered in 
this Guide. 

  Don’t make changes in this menu … unless you are an advanced user and know what you are doing! 
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Again, in general, you will not have to change anything in this menu as the DGT-OT Wizard creates the project with the 
adequate file filters for the documents in your project and so this feature is not covered in this Guide. 
However, here is some basic information taken from the OmegaT Help: 
OmegaT has highly customizable file filters, which enable you to configure numerous aspects.  
File filters are pieces of code capable of:  

    a)  Reading the document in some specific file format. For instance, plain text files;  
    b)  Extracting the translatable content out of the file and  

   c)  Automating modifications of the translated document file names by replacing translatable contents with its 
translation.  

In this menu, you can change the file filters for a particular project.  

But you can also change the file filters for all your projects.  menu Options → File Filters 

 For information on this subject, see Chapter 7 in the OT Help/Guide. 

 Don’t make changes in this menu … unless you are an advanced user and you know what you are doing! 
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This is a very important menu for your daily work! In this menu you have a list — with shortcuts — of OT features for 
editing.  

  Sections on Translation Memories and Machine Translation, Tags, Glossary, Search, Search/Replace, Pre-translate 
and Auto-propagation for more detailed information. 

Besides these shortcuts, the Windows keyboard functions/shortcuts select all / copy/paste, cut-paste and drag and drop 
work within and between OT windows (Fuzzy Matches, Search and Notes windows) and also from and into external 
applications (Google, Euramis, Eur-Lex, etc.). For some operations, you can also use the DGT icons. 

 

Undo/redo, but only within the segment open in the Editor.  

In the segment open in the Editor, to replace the text by the segment in 
bold in the Fuzzy Match pane (by default the 1st match)  
 

To insert the source text at the position of the cursor in the open segment 

 To Search external translation memories —  Section E.3.1. 

To insert or replace with machine translation the text (if any) of the 
segment open in the Editor. 

To insert all the missing tags in the target segment 

Translation that will be auto-propagated to all non-unique segments. 
 

 To Search in monolingual documents (Word, PDF…)  Section E.3.3 

 To search and replace text in the target segments   Section E.3.2. 

Deletes all the text in the target segment open in the Editor. Equivalent to 
Ctrl+X. 

Deletes all the text in the target segment open in the Editor AND that 
segment/line will be empty in the translated document in its native 
application. 

 If Allow translation to be equal to source is not active in the 
Editing Behaviour menu, it allows — for the specific segment 
open in the Editor — to have identical source and target 
segments. 

In the segment open in the Editor, to insert — at the position of the cursor 
— the segment in bold in the Fuzzy Match pane  

To replace the text with the source text in the segment open in the Editor. 

To export the current selection to a text file for processing 

To create a new entry in the project writable glossary 

 To pre-translate  the searched segments —  Section E.3.4. 

Translation that will not be auto-propagated to the other non-unique 
segments. 

  

Submenu to change 
highlighted text case  

Submenu to select the 
Fuzzy Match segment to 
replace/be inserted in the 
target segment in the 
Editor 
 

 

 To insert the next missing tag in the target segment 
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This is a very important window that is activated by pressing Ctrl+F or selecting that option in the Edit menu. 
The Search (concordance) feature in the public OT is very complete and allows to search by a series of criteria.   
In DGT, this feature has been further improved with new features very useful for translators. 

 Part G for detailed information on the many Search options. 
A part of this menu (in green below) can be hidden so that you have more space for the results … if you don’t need 
those options. This applies also to the Search Directory, Search/Replace and Search and Translate windows. 
You can also customize the Attributes of the searched segments displayed in the Search window (your preferences), 
for example to have displayed - in the Fuzzy Matches pane - together with the source and target segments, the notes 
you inserted in the segments you translate. 
You can change them any way you want by clicking on Configure format and choosing the variables — in the Match 
Display Template — deleting, inserting and ordering them the way you prefer. You can easily change it any time you 
want.  

 Part O for detailed information on how to customize the Attributes.  
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This is a very important window that is activated by pressing Ctrl+K or selecting that option in the Edit menu. 
The Search/Replace feature in OT is very complete and allows to search/replace by a number of settings. It has similar 
(but not as many) options as the Search feature.  
In DGT, this feature has been substantially improved. 
A part of this menu (in green below) can be hidden so that you have more space for the results … if you don’t need 
those options. 

 Section G.3 for detailed information on the Search/Replace options. 

 Part O for information on how to configure the Attributes display. 
 

 
 
 



  

 
124 

This is a very interesting feature that is activated by pressing Ctrl+Shift+K or selecting that option in the Edit menu. 
It allows to search terminology/phraseology in monolingual reference documents in the project, if any.  
The Search Directory feature in OT is very complete and allows searching monolingual documents by a number of 
settings. It has similar (but not as many) options as the Search feature. In DGT-OmegaT, this feature has been 
improved. 
A part of this menu (in green below) can be hidden so that you have more space for the results … if you don’t need 
those options. 

 Section G.4. for detailed information on the Search Directory options. 

 Part O for information on how to configure the Attributes display. 
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This is a completely new feature in DGT-OmegaT which allows searching by certain criteria and afterwards 
pre-translating the selected segments. It is activated by pressing Ctrl+Shift+Z or selecting that option in the Edit menu. 
It can be used to search, for instance segments only with numbers and to copy, in a batch operation, the source to the 
target segments. It also allows to pre-translate (from external memories or from machine translation) the selected 
segments. 
A part of this menu (in green below) can be hidden so that you have more space for the results … if you don’t need 
those options. 

Section F.8. for detailed information on the Search and Pre-translate options. 

 Part O for information on how to configure the Attributes display. 
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This is a very important menu for your daily work! To move around in the OT Editor is easy and fast even with large 
projects.  
To open a segment anywhere in your document just double click anywhere on it with the mouse left button. To go to the 
next segment, press Enter or click on icon 10, which will save the translation of the currently open segment to your 
project memory and open the next segment.  
If you want to skip segments leaving them untranslated and continuing with a segment far below, just scroll to the 
segment you want and double click on it. OT will save the segment you were in and open that other segment. 
If your project has more than one document and you are in the last segment of your first document, when you press 
Enter it will open the first segment of the second document. 

To move around the Editor you can use the shortcuts, the icons (  Section A.7) or click on the Go To menu and 
chose an option.  

 
  

It validates the segment you are in and opens the next untranslated segment. 
It is especially useful if you have a new version of a document. 

 It validates the segment you are in and opens the next translated 
segment.  It is useful if you want to check your translated segments while 
skipping segments that you want to remain untranslated.  

The same as Enter. It validates the segment you are in and opens the next 
segment for editing.  

It validates the segment you are in and opens the previous segment. 

If you want to go to a particular segment in any of your documents (and you 
know its number), just write the number of the segment in the field displayed 
and it will save the segment you are in and open the selected segment. 

If you have segments with notes (by default highlighted in pink), you jump to 
them successively opening them for editing. 
To delete a note, just delete all the text (including spaces) in the Note pane 
and it will no longer be highlighted in pink.  

 Now you have shortcuts to do it more efficiently. 

You can go forward or back opening segments by the order you edited them 
in that session with that project. 

 You can go forward or backward opening segments which were 
translated or modified by another user (different login). You also have 
shortcuts. 
This is used in the revision process when the translator finalizes the 
translation by accepting or rejecting the changes made by the reviser. Those 
segments are highlighted with a red background if the option Mark Revised 
Segments — in the View menu — is activated. Track-changes are 
automatically displayed in the target segments in the Fuzzy Matches pane.  
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This is a very important menu for your daily work! 
Source and target texts are displayed vertically one on top of the other. This applies to the Editor and Fuzzy Matches 
panes and to the Search windows. 
OT preferences are 1-level and OT will “remember” the last preferences you set when you close and reopen it, either 
with the same project or with another project. Of course, you can easily change the preferences at any time.  
You can start translating with the default settings, but you may also want to change some of them to suit your 
preferences. 
There are several options concerning the display of the segments in your text. You can choose at different stages of your 
translation to have them displayed differently just by clicking or unclicking that option in the View menu. When the option 
is active, the coloured box is marked with a line around it.  

 

  

If translated, target segments are always displayed. 
Furthermore, translated segments will be highlighted 
with a green background if this option is selected. 

Untranslated source segments are always displayed. 
They are highlighted with a yellow background if this 
option is selected.  

Source segments of translated segments are displayed 
together with the target segments if this option is ticked. 
They are displayed with a blue background (default).  

Segments repeated in the whole project (100% identical 
including tags) are displayed greyed (non-unique 
segments (default) 
 
Segments with notes are highlighted with a pink 
background when closed if this option is ticked (default).  
 

White spaces are displayed with a dot, if this option is 
ticked. 

 Useful for Right to Left languages, which is not the 
case of the EU official languages. 

By default, the segment open in the Editor displays its 
ID — login, date and hour — if already translated in the 
project. You can also see no identification at all, or have 
all segments identified in the Editor by selecting it in 
this submenu. 

 To mark segments pre-translated from an external 
memory present in the \tm\auto subfolder (default) 

 Segments created/modified by another user 
(different login) are displayed with a red background if 
this option is ticked. Used in the revision process. 

 
 

Non-breakable spaces are displayed greyed (default). 
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This is a very important menu for your daily work! 
The Tools menu — and related submenus and options — are explained in detail in the thematic Sections on Tags, 
Statistics, Terminology, Spellchecking, Quality Check and project management. 

 

   

To check and correct tags in whole the project. 

To generate Statistics of the whole project and by document (by 
words/ segments/characters, translated/untranslated)  

 To open the writable glossary in Notepad++ for editing  

 A quick way to open in Windows Explorer — via OT — the 
folder of the project you are translating 

 To extract a list of Notes from the project in html format 
 

 To do a Quality Check for the whole project or the document 
you are working on.  

  To generate translation memories by document to be sent 
to Euramis. 

 To check and correct tags only in the document you are 
working on. 

To generate Match Statistics for the whole project (which include 
the project memory if the translation was already started)  

 To generate Match Statistics for each document in the whole 
project with repetitions in and between documents.  

 To eliminate tags from a fuzzy match in the open segment in 
the Editor  
 

 Scripting menu —  Section E.6.1. below 

 To do Spellchecking of the whole project or of the document 
you are working on. 

  To generate translation memories by document to be sent 
for revision or to be stored  

 To show a list of segments where source and target are 
identical.  

 To extract a list of selected Notes from the project in html 
format 

To generate a list of untranslated segments 
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Scripting is a new feature in OmegaT which allows to easily integrate features developed by the open-source community 
around OT. 
 

 
 
Some are already included in the public OT standard version, others which are available as open-source software have 
been integrated in DGT implementation of OT. Just use the relevant shortcut or choose the desired option in the Tools 
menu.  

 in the previous Section E.6. the scripts already available via the Tools menu. 
In this menu, it is possible to define up to 12 scripts (features). In DGT-OT, 10 are, by default, available as shown in the 
previous section and further explained in the relevant thematic sections of this Guide. 
If you want, you can easily choose from the list 2 other scripts not already defined, by: 
1 — Highlighting the name of the feature in the left column,  
2 — Right clicking on one of the buttons below: "<11>" and "<12>". 
3 — Selecting Add Script. 
The purpose of each script is, in general, briefly explained by its author. Each script is associated to a shortcut as shown 
in the previous Section. 
You can also customize the scripts you want to use by adding and deleting them to the scripting list.  
The options to Add and Remove a script will not delete it from your OT installation. It will just display it or not in the 
Tools menu. 
Some may not be straightforward. Ask for help if you need support! 

 If you have the know-how, you can even add your own scripts! 

  Appendix F — Scripting plugin in the OT Help/Guide for information on scripting and scripting languages. 
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In this menu, you can define a series of parameters. Some of the options — and related submenus — are further 
explained in the relevant Sections on Translation Memories and Machine Translation, Terminology, Auto-Completion, 
Spellchecking and Quality Assurance. 
 

 

By default, to validate a segment 
and open the next segment, you 
press Enter. If you want you can 
change it  and use the TAB to do this 
operation by activating this option. 

By default, when you press Quit, OT 
closes down without asking for 
confirmation. If you want, by 
checking this option, you will be 
asked if you really want to quit and 
you have the option to Cancel. 

 In DGT, the only option is the 
in-house MT@EC system.  In the 
public OmegaT, there are several 
online MT systems available. 

Not used in DGT. 

If you have made changes to the window display and 
want to get back to the default display, just click on this 
option.  

Your login (automatically defined) 

 Section E.7.1 below. 
 
 
 
 

 

Terminology entries from 
the project glossary(ies) 
are displayed in the Editor 
(fuzzy or exact match). 
This feature can be 
deactivated here. 

 
 The Glossary option in this menu provides 

access to Terminology as a Service. TaaS is the 
result of a research project financed under the 7th 
Framework Programme on RTD (http://www.taas-
project.eu/).  For the moment it is not available in 
DGT. 
 

 

 
 
 

 To configure  
Auto-completion  

To define the font and size of OT main window text 
(Editor, Fuzzy Matches, Glossary) and Search and Tag 
validation windows.  

 
 

To check potential language and 
grammar issues, highlighting 
those words with a blue 
underline. You can deactivate it 
here 

 Section E.7.2 below. 

 Section E.7.3 below 

 Section E.7.4 below 

 Section E.7.5 below. 

 Section E.7.6 below. 
To define source and non-unique segments display. 

 
 
 
 

To define how frequently OT saves 
your project to the project \omegat 
subfolder in your computer. 
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In DGT, we have the IT Unit which takes care of these technical aspects. Therefore this feature is not covered in this Guide. 
However, an important option is the Ignore file context when identifying segments with alternative translations. 
When ticked (check it), alternative translations will be auto-propagated in all the files in the project as OT will ignore the 
document identification. If not ticked, alternative translations will only be auto-propagated in segments within the 
document associated with that alternative translation.  
 

 These settings apply to all the OT projects. So don’t change them unless you know what you are doing. 
 

 Section 7 in the public Guide/Help for more information. 
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In DGT, we have the IT Unit which takes care of these technical aspects. Therefore this feature is not covered in this Guide. 

  These settings apply to all the OT projects. So don’t change them unless you know what you are doing. 
 

 Chapter 14 of the public Help/Guide for more information. 
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In DGT, we have the IT Unit which takes care of these technical aspects. Therefore, this feature is not covered in this Guide. 
 

 Chapter 22 of the public Help/Guide for more information. 
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In this menu you have several important options: you can select the fuzzy match minimum rate, the automatic insertion 
(or not) of machine translation, to copy source to target and some other features. 

 Sections on Translation Memories and Machine Translation, Tags and Pre-Translation for more information 
 

 

By default, when there is a match in which numbers 
are different (for instance dates, percentages) OT will 
not try to change them.  You can activate it here, but 
take into consideration that OT sometimes fails. 

If there is no match from translation memories — and 
eventually no MT if so defined — the segment is left 
empty. If you validate the segment without translating 
it, the original text will be taken in the translated 
document in its native application IF Allow translation 
to be equal to source is ticked (default). 

With this option is unticked (default), the source text 
is never inserted in the target segment open for 
editing. 
If this option is ticked, in the Editor, the source text 
will be automatically inserted in the open target 
segment IF: a) Insert Machine Translation is 
deactivated and b) Insert best fuzzy match is 
activated but there is no match with the defined 
minimal similarity. 
 

 MT is automatically inserted if there is no fuzzy 
match/match with the minimal similarity threshold 
(Default).  
 

Fuzzy matches threshold for 
automatic insertion in the target 
segment in the Editor.  
 

In DGT, by default OT accepts equal text in source 
and target (which are saved in the project memory).  
If you untick this option, the option Insert the source 
text will not work. 
 
OT exports data from within the current OmegaT 
project to plain text files for further processing. 
 
 

 By default, tags are protected and can only be 
added or deleted. Here you can allow tags to be 
editable if you want to change them manually.  
 

 Very important when you use Pre-Translation or 
for the revision process. Segments pre-translated 
from the \tm\auto subfolder will be highlighted in 
orange in the Editor (default) — and will remain so 
unless they are changed — if the option Mark Auto-
Populated Segments is activated (the default) in the 
View menu. 
 

By default, the best match from your translation 
memories will be automatically inserted if within the 
defined threshold. You can deactivate automatic 
insertion here. 

You can have OT warning you — when you press 
Enter — that there are tags missing/misplaced in the 
edited segment. You can therefore validate tags 
segment by segment if you tick this option. 
 

This feature is important when you have a project 
in which there are (many) non-unique segments 
which have a different translation. If you tick this 
option, OT will stop (and open) segments with 
multiple translations for you to check. 

You can add a prefix that will be 
displayed at the beginning of 
each automatically inserted 
fuzzy match in the Editor (Ex: 
fuzzy). If used, those entries 
can be filtered. In DGT-OT, by 
default there is no prefix. 
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In DGT, we have the IT Unit which takes care of these technical aspects. Therefore this feature is not covered in this Guide. 
The option Allow translated tags to be in a different order is, by default, deactivated. However, for some languages or 
documents, it may be necessary to check this option to allow tags to be in a different order. In that case, check that there are 
no problems. 
 

 See Chapter 12 — Working with formatted text in the public Help/Guide for information. 
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OT displays the segments in the translation memories — called external TMX — of your project which have matches 
with the currently open segment in the Editor pane (MT output is displayed in a different window and not mixed with 
human translation). 
In DGT, we have the IT Unit which takes care of these technical aspects. However, you may want to change some of 
these defaults, namely the number of segments displayed in the Fuzzy Matches pane and if you want — in the 
revision/finalizing phase — to see the track-changes in the target segments too. 
You may also want to choose the order of display of Fuzzy Matches: giving more importance to content than to 
formatting, for instance. 
You may also want to configure the Attributes display — as for the Search feature. 

 Section O.1. for information on how to configure the Attributes display. 
 
 
 
 
 
 
 
 

  
 
 
 
  

 In the revision phase, you may want — as the reviser — to see the 
track changes in the Fuzzy Matches pane also in the target segments. 
Just click on this option.   

 Your can choose the order in which fuzzy matches are 
displayed in the Fuzzy Matches pane. By default, it is 
displayed by match rate including tags and numbers. But 
you can select one of the other 2 options. 

 

By default, OT displays the first 10 best matches (if any), 
but you can increase that number up to 50.  
 
OT will displays segments with a similarity threshold lower 
than the one set in the Editing Behaviour menu up to the 
number of matches selected here. 
 

 This may be useful sometimes as it may allow you to 
see matches at subsegment level. 

  Match display template which 
defines the way segments are identified in the 
Fuzzy Matches pane. It exists in the public OT 
but has additional variables — some new —  
in DGT-OT. 
 

You can select here the attributes that will be displayed in 
the Fuzzy Matches pane.  

 Section O.1 for detailed information. 
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Here you can define the frequency in which OT will make backups of you project memory to the \omegat subfolder. 
The other features are not used in DGT, as far as I know. 
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The Help Menu gives you access to the public OmegaT Guide by chapters.  

 Take into consideration that DGT version of OmegaT has some changes/adaptation/improvements. 
You have the same information — in pdf format — in the public Guide available in the DGT-OT Wizard. 
The Last Changes section of the public version is not available in DGT-OmegaT. 
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The close relationship between Translation Memories and Machine Translation (MT) is an old one. In fact you may not 
be aware that translation memories were — in the 90 — a by-product of machine translation research developed in the 
IBM Lab where the concept of Statistical Machine Translation was, so to speak, born. 
The prevailing approach at that time was Rule-Based Machine Translation, a lengthy and complex process which is 
language-dependent. It was the basis of DGT’s ECMT service that was available for 28 language pairs (10 of which 
prototypes) in the European Commission until 2010. 
In order to be able to apply statistical techniques to Machine Translation, the researchers developed what became a 
success on its own: the Translation Memories … while Machine Translation went through a limbo phase. 
With publicly available MT services like Google and the release of the open-source Statistical Machine Translation (SMT) 
system — Moses — in 2007 within the Euromatrix research project with co-financing from the European Commission, 
SMT became more widespread — and viable — as it was language-independent and allowed to quickly train language 
pairs with only one requirement: large bilingual corpora … and that the European Commission — and DGT in particular 
— have plenty! 
The new SMT service of the Commission — MT@EC — managed by DGT started to be tested in 2011 and is now 
available to the EU institutions and also to the Member-States administrations, including universities. 
Machine translation output used in DGT-OmegaT is — of course — the output from MT@EC. 
An interesting feature in OT is that human translation matches from Euramis and machine translation output are never 
mixed up. They are displayed in separate panes. This is particularly useful for language pairs in which MT quality is poor 
— or highly uneven — as it allows having the best of both worlds: not to have MT automatically inserted in the segment 
open for editing ... but to be able to see it in a separate pane and eventually use it just by pressing Ctrl+M. 
 

 
 

Screenshot 49 — Human Translation and Machine Translation — separate panes 
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In DGT, Machine Translation is pre-processed for all the EN → other languages Word documents — and for some other 
pairs too — and the tmx file is copied to a dedicated project folder (\mt) — which is DGT-specific — when you create a 
project with the DGT-OT Wizard.  
MT@EC provides machine translation between all the EU official languages — 552 language combinations — some in 
direct mode and others via a pivot language.  
If you want to have an inkling of why MT quality can be so uneven — from very good to rotten — see the Annex on What 
Makes Moses Tick taken from the Moses for Mere Mortals Tutorial.  
Unlike MT services publicly available which are trained with every possible parallel data available (namely on the 
Internet), MT@EC engines are trained with EU corpora, i.e. documents from Eur-Lex and the main EU institutions and 
— of course — with DGT corpora of unpublished translations. In short: our translations from the last 2 decades! 
The quality of MT output — and its usefulness for translation purposes — can be quite different not only between 
language pairs, but also from document to document, depending on the corpora the MT engine has been trained with 
and the document(s) to be translated.  
For instance, for very technical documents in new domains (in EU documents), MT@EC may not have any previous 
material on that domain in its corpora and therefore MT output may be poor. But for other domains where there are lots 
of previous translations, MT output will probably be extremely useful ... even for morphologically very rich languages like 
Finnish, for example.  
So the bottom line is that, even if it may happen that MT output is generally not very good for your language pair, 
nevertheless it may give you useful phraseology or terminology “suggestions” as those segments are, in fact, “snippets” 
(strings from 1 up to seven words) from EU translations. 

 Therefore, don’t discard machine translation altogether if you have a first “bad” experience. With a different 
document, the usefulness of MT may be better … and the separate MT pane in OmegaT enables you to assess 
that in a very easy way. Terminology/phraseology might be useful, even if the general syntax of the phrases is 
rotten! 

By default, MT insertion in the segment open for translation is automatic if there is no Euramis match within the defined 
minimal similarity threshold. But you can easily deactivate it in the Editing Behaviour Options menu and also define the 
minimal similarity for fuzzy matches from Euramis. 
 

 
Screenshot 50 — Defining match rate and automatic insertion of machine translation output  

http://en.wikipedia.org/wiki/Moses_for_Mere_Mortals
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Just to have an idea of MT@EC performance in comparative terms, the MT@EC service carries out (automatic) 
evaluations of the MT performance for EU documents.  
Here is the evaluation for the language pairs EN ↔ other EU official languages, which represent the huge majority of 
translations in DGT. 
This is a dynamic ranking that changes over time, but here is the present “evaluation” given in the MT@EC website: 
 

 EN as source 
language 

EN as target 
language 

 EN as source 
language 

EN as target 
language 

BG Good for understanding The best you can get IT Good for understanding The best you can get 

CS Good for understanding Good for understanding LT Just a rough idea Just a rough idea 

DA Good for understanding The best you can get LV Just a rough idea Good for understanding 

DE Just a rough idea Good for understanding MT The best you can get The best you can get 

EL Good for understanding The best you can get NB Just a rough idea Just a rough idea 

ES The best you can get The best you can get NL Good for understanding Good for understanding 

ET Just a rough idea Just a rough idea PL Just a rough idea The best you can get 

FI Just a rough idea Just a rough idea PT The best you can get The best you can get 

FR Good for understanding The best you can get RO Good for understanding The best you can get 

GA Just a rough idea Just a rough idea SK Just a rough idea Good for understanding 

HR Just a rough idea Just a rough idea SL Just a rough idea Good for understanding 

HU Just a rough idea Just a rough idea SV Good for understanding The best you can get 
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OmegaT allows to easily manage translation memories via Windows Explorer and this is a simple — but powerful — 
feature that is very worthwhile to explore. 
In this Section is gathered — and expanded — information concerning translation memories to give you an overview of 
how to make the best use of it. 
In DGT, Euramis is the translation memories database from which retrievals are extracted to be used in CAT tools.  

 Section C.2. for information on Euramis. 
OT allows you to organise external memories giving them priorities or penalties and this feature is optimised with a very 
powerful Search feature. 
OT also gives you complete control over the memory(ies) you want to use for pre-translation purposes before starting 
the translation of a project or during its translation: 
q  You can use the OT auto-populate feature to: 

Ø Pre-translate your whole project with 100% matches (including tags) in your external memories, by 
simply copying the memory(ies) you want to use for this purpose to the \tm\auto subfolder or to the 
\tm\enforce subfolder. 
 

q   You can also use the brand new DGT-OT feature Search and Pre-Translate to: 
Ø Pre-translate a part of your project searching by terms/strings or by regular expressions and have the 

searched segments pre-translated (in batch): 
§ By automatically copying the selected source segments to the target segments,  
§ From external memories with 100% or a lower match 
§ From machine translation.  

Ø Pre-translate your whole project:  
§ From external memories with 100% or lower match  
§ From machine translation  

 Personally, I don’t recommend the use of this feature to pre-translate a whole document/project 
with lower than 100% matches. Although you will have a prefix with the match rate in the target 
segment, you may not notice some differences and therefore have incorrectly translated 
segments. 

 To pre-translate the whole project from external memories, use pre-translation (auto-populate) 
from the \tm\auto subfolder (pre-translating only 100% matches including formatting).  
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Many translation memories stored in Euramis are from documents that have been post-aligned using the source and 
target published/released documents (in their native formats, of course). These post-alignments are generated 
automatically and may — or may not be — checked by an assistant or a translator. 
Although the error margin of the present aligner is very low, it nevertheless exists! 
These post-aligned translation memories may come from: 
Ø All Eur-Lex documents: a part of those alignments have been checked by assistants or translators, but 

another part is from automatic alignments without human checking.  
Ø DGT released documents: a part of the documents translated in DGT for which, for various reasons, the 

memories stored in Euramis don’t come directly from CAT tool memories.  
Ø Other EU institutions memories: which have memories available in Euramis and for which also a part of the 

memories don’t come directly from CAT tool memories.  
 

 
Screenshot 51 — 100% match — in the source segment — but the alignment is incorrect … or it applies only to 

a specific situation in a specific document! 
 
The match rate displayed in the Fuzzy Matches pane is only as reliable as the external memories are reliable, i.e., 
correctly aligned. So don’t take it for granted that a 100% match is — in all cases — really that in the target language! 

  Therefore always check the translation even of 100% matches unless you are sure they are not from automatic 
post-alignments or that, if they are, they have been thoroughly checked. 
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A new option in OmegaT is that you can define the order in which the match segments are displayed in the Fuzzy 
Matches pane by selecting — in the External TMX Options menu — one of the 3 options for Sort fuzzy matches by: 
Full text including tags and numbers, Stemming, no tags and no numbers or No tags and no numbers. 

 The 3 match rates are not affected. It is only the order in which the fuzzy matches are displayed that will be different. 
 

 
Screenshot 52 — Sort fuzzy matches by in the External TMX Options menu 

 
The option Full text including tags and numbers is the most “accurate” for our purposes as it displays first the 
segments with higher matches including formatting and numbers. This is the “safest” option and that is why — contrary 
to the public OmegaT — this is the default in DGT-OT. 
The options Stemming, no tags and no numbers and No tags and no numbers give priority to content and may be 
interesting to use in some cases. 

  If you have heavily tagged documents and the translation memories — if they come from Euramis — have no 
formatting at all, this may be an interesting option. 

 But it may also be counterproductive on the whole, especially if you use MT output.  
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OmegaT flexibility for organising and giving priorities to external memories — to be used for Fuzzy Matches and Search 
purposes — can really help you in your work and it is therefore worthwhile to give it some attention, especially when 
working with large and/or complex projects. 
 

You can have as many reference memories as you want as OmegaT can handle many MB of memories in our service 
computers without noticeably losing speed. 
Therefore, the approach taken in the DGT-OT Wizard is that most of the time you will want all the translation memories 
available in Tradesk imported to your project, so you are not asked — when creating or updating a project — which 
memory files you want to import to your project. They are all imported!  
But if you have a project with some/many documents and which may have new versions — and therefore updates — it 
may be useful to organise your memories — even if you don’t want to give them priorities — as when you update a 
project the DGT-OT Wizard will copy again to your project \tm folder all the memory files available in Tradesk, both the 
ones already in the project and the new ones. In the example below, I created the: 
Ø \tm\RETRIEVALS subfolder to where I dragged and dropped the retrieval and Celex-titles files (in blue) 
Ø \tm\REFERENCES subfolder to where I dragged and dropped the reference document files (in green) 

 This can save you time if you do an Update of the project with new versions, as you can have the folder display 
ordered by date and easily select, in the \tm folder, the new memories that have been imported (the most recent 
by date) and which you want to keep by dragging them to one of the subfolders — or creating new subfolders — 
and just deleting the files you already have in the subfolders or that you don’t need.  

 This way, you don’t have to reorganise the whole \tm folder every time you do an update! 

\tm folder after creating a project with the DGT-OT Wizard \tm folder organised with subfolders 
without priorities 

 

 

 

Screenshot 53 — Organising the memories in the \tm folder by groups/subfolders 
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In OmegaT, you can give priority to memories by individual tmx files — or, most importantly, by folders containing several 
tmx files (  Section F.4.3. below) — by ranking them via Windows Explorer. 
This is a feature that can save you a lot of time in complex multi-document projects and much more so as it is combined 
with a powerful Search feature. 
As for Fuzzy Matches and Search purposes, OmegaT “reads” the files in the project \tm subfolder by alphanumerical 
order, you can easily define and change the order of the files, if you want.  
You can simultaneously give the files a descriptive name so that you can concentrate on your translation work and not 
have to think of your reference documents by number. 
You can organise the memories automatically imported to your project when you create it using the DGT-OT Wizard 
before you start translating or at any time during the translation. 
Those memories are stored in the \tm subfolder and can be ordered just by renaming them adding a number before the 
file name and also a descriptive name if you want. 
Example: 1-2012-32012R1268_EN-PT-DWN.tmx, etc. or 1-Financial-Regulation-32012R1268-EN-PT.tmx, so that the 
name displayed in the Fuzzy Matches and Search panes is meaningful to you. 
You can rename all or only some of the translation memories as in the example below. The numbered tmx files will be 
given priority. 

 
Screenshot 54 — Ranking individual memories in the \tm subfolder in this case giving priority to some 

memories  
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In OmegaT, you can also give priority to memories by groups/subfolders containing several tmx files by ranking them via 
Windows Explorer. 
This is even better — mainly in complex and large projects — than organising them by individual files as explained in the 
previous section. 

  You can even organise main reference memories of domains you translate frequently — for later reuse — without 
the need to merge memory files … as after a time you may not remember what reference memories you have 
there.  

 This way, you can also update those thematic memory folders by easily adding new memories or deleting old 
ones in Windows Explorer in a few seconds… and always knowing what is there! 

You can organise those memories thematically by subfolders of the \tm folder of the project — to where you can copy or 
drag/drop the tmx files you want — and give those subfolders the name and priority you want. 
In the example below, I created 8 new subfolders in the \tm folder, gave them a priority (number) and a name meaningful 
to me to have the segments from those memories identified in the Fuzzy Matches pane and in the Search window. 

 
Screenshot 55 — Ranking memories by groups/subfolders. In this example, showing the tmx files in the  

2-GATT-Agreement-1994 subfolder 
You can also just copy/paste folders you have in your computer with thematic translation memories and you can change 
at any time the priority and name given to those subfolders without the need to Reload the project — if it is open — as 
OT will take any changes in consideration when opening new segments or doing new searches.  
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In the Search window, the segments are displayed by the order in which the (memories or) groups of memories were 
ranked and you can resize and place this window beside the Editor pane if you want.  

 
Screenshot 56 — Search window with results ranked by order of priority given to reference memories folders. In 

this example is also used the tmx2source feature. 
 
In the Fuzzy Matches pane, the matches will be displayed, first, by order of match rate and, with identical match rate — 
formatting and numbers included by default — by the order of priority you have defined for the reference 
memories/subfolders.  

 
Screenshot 57 — Fuzzy Matches pane with matches displayed in the order of priority given to \tm subfolders 

with the display option Full text including tags and numbers.  
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Furthermore, in the Fuzzy Matches pane you also have information about the number of occurrences of a particular 
segment in the external translation memories — and also in the project memory — by right-clicking on the mouse.  
You can also insert or replace the text in the segment open in the Editor by the text in the Fuzzy Matches pane by 
selecting the desired option in this menu. 

 
Screenshot 58 — List of occurrences in the project with the same segment (in this case 9 more) and options to 

insert or replace translation in Editor. 
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Sometimes, it is useful to distinguish between reliable translation memories and less reliable ones.  
Machine Translation doesn’t need to have a penalty because it is stored in a separate folder (\mt) and is only displayed 
in its specific pane, therefore it is never mingled with human translations from Euramis, either in the Fuzzy Matches 
pane or in the Search window. 
Furthermore, OmegaT accepts translation memories with the same source language and a different target language 
from the one of your project, giving give you results in the Fuzzy Matches pane and in the Search window for those 
other target language(s) too... if there is a (100% or lower) match in the source language, of course. 

  If you want to see those segments displayed as a second source language in the Editor — but in that case only 
when there is a 100% match (including tags) — you can use the tmx2source option.  Section F.6. below. 

So you can have reference memories with a different target language to use as reference for terminology purposes, but 
you may want those segments to be displayed after the project language pair matches. 
In that case, you can give a penalty to one or more of those memories by creating a subfolder (or more than one 
subfolder) with names like "penalty–xxx" where xxx is a number from 0 to 100.  
A percentage penalty corresponding to the numbers will be applied to the matches of all translation memory files within 
such subfolder. For instance, a 100% match will become a 70% match with the example below.  
The 3 percentages (with and without tags) are affected equally so. For example, if the matches were 75/85/90, they will 
become 45/55/60 as the penalty is applied.  

 As OT will display matches in the Fuzzy Matches pane up to the number of matches defined in the Options → 
External TMXs options menu (default: 10) — and even if those matches are below the minimal similarity 
threshold defined the Editing Behaviour menu — you can choose to give a penalty lower than the minimal 
similarity threshold and even so have those matches displayed in the Fuzzy Matches pane. 

 

Memory subfolders in 
the \tm folder 

 
 

 
Screenshot 59 — Display in the Fuzzy Matches pane of matches from segments with a 30% penalty applied, in 

this case the French translation of this same document. 
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This is a new OmegaT feature which may be very useful if you have a document to translate from a language you don’t 
master (very) well and for which there is already a translation into a language that you master. In this case, you would 
probably like to have the possibility of seeing both languages as source languages. 

 Of course that, if you don’t know the original source language at all, there is no point in seeing it and therefore 
just create your project having as source language the translation into the relay language.  

 In that case, you may have to request retrievals and MT as it may not be pre-processed for that language 
combination. 

To have the relay language displayed in the Editor as a source segment, you can now use the tmx2source feature to 
use a (reference) external translation memory with the source language identical to the source language of your project 
and the target language of the reference memory different from the target language of your project, displaying the relay 
language segment in the Editor below the original source segment. 
Example: You have an LT document to translate into PT and your knowledge of LT is not perfect (or far from it)… but 
there is already an EN translation of the same document. In this case you can create the LT-PT project and use the 
LT-EN external translation memory to have the EN relay language displayed in the Editor below the LT original segment.  
This way you will be able to save time as you will see both the LT and EN as original segments. 
 

 
\tm subfolder: 

 
\tm\tmx2source 
subfolder: 

 

 

Screenshot 60 — Translating a LT document into PT with the help of a relay language (EN). The EN translation is 
displayed in the Editor below the original segment as a second source language identified with the relevant 

language code. 
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You can also use this feature just to have the translation into another language displayed for terminology purposes, as in 
the example below in which — for an EN-PT project — an EN-FR alignment of the same document was used.  

 You can also associate the penalty and the tmx2source features as in the example below as in the Editor will only 
be displayed the 100% matches (from the \tmx2source subfolder), while in the Fuzzy Matches pane you can have 
also below 100% matches from the \tm other (sub)folder..  

 This is important because, as translation memories from Euramis are cleaned of formatting, if your document is 
(heavily) formatted and you are using an extraction or alignment from Euramis, you won’t see many segments 
displayed in the Editor as a second source language because the match is below 100% due to formatting!  

 

\tm subfolder: 

 
\tm\tmx2source 
subfolder: 

  

Screenshot 61 — Translating an EN document into PT using the FR translation as reference displayed in the 
Editor as a second source language 

 
The \tmx2source subfolder is not automatically created when the OmegaT project is created (either via the DGT-OT 
Wizard or directly in OT), so you will have to create it manually and copy to it the file renamed with the language code of 
the reference memory target language in the format shown below. 
Just copy the alignment and rename it with the target language code. In the 2 examples above, the memories were 
renamed LT_LT and FR_FR. 
You can see a list of the language codes either in OT — under Help — or in the Project → Properties menu → 
Source File Language. 

 
Screenshot 62 — Project → Properties menu → Source File Language 

You can add this subfolder at any time during the translation of your project and you can also delete it — or move it to 
another location at any time — without the need to Reload the project. 
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The pre-translation feature may be useful if you find a particularly reliable document you want/have to use for 
pre-translation purposes, for instance, if you are translating a legislative act that modifies or repeals a previous one and 
you want to change the previous translation as little as possible in your new document. 
You can pre-translate your whole project using one or more reference memories by copying it/them to the \tm\auto 
subfolder of your project. 
The segments in the memory file(s) copied to the \tm\auto subfolder which are 100% matches (including tags) will be 
automatically transferred to the project memory — an operation which is in OT is called auto-populate the project 
memory. 
A new OT feature is that when you open your project (or do Reload), those segments are displayed in the Editor, by 
default, highlighted with an orange background colour to call your attention to the fact that they were pre-translated. They 
will remain so highlighted unless you modify those segments.  
The translator’s login from the reference document used for pre-translation (in the example below costami) will remain 
unchanged if you do not open and modify that particular segment. 
If you have the option View — Modification Info — Display for Current Segment active in OmegaT, the identification 
of the pre-translated segments will be displayed with the login of the translator — which may be yours or somebody 
else’s.  

 
Screenshot 63 — New OT feature: By default auto-populated (pre-translated) segments are highlighted with an 

orange background.  
 
This feature is very useful if you have a previous version of a document that has already been released and you want to 
use its memory for pre-translation in a newly created project. However, if you still have the previous project in your 
computer — and you finished your translation using OT — you can just update the old project in the usual manner with 
the new version without the need to create a new project. 

  If it is an ongoing project, there is no need to do pre-translation at all if you have new versions of documents. The 
project memory stored in the \omegat subfolder contains all the segments you translated in that project and they 
are automatically displayed in the Editor when you open that project after updating it via the DGT-OT Wizard. 
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If you want to pre-translate before starting the translation of a new project, it is just a matter of copying the reference 
document(s) you want to use for pre-translation to the \tm\auto subfolder of your project and open the project. 
All the 100% segments (including tags) in that memory will be automatically transferred to the memory of your project 
and displayed in your document(s) in the Editor pane highlighted in a background colour (by default). 
If you want to use this feature after having started the translation of the project, do the same: just copy the memory to 
the \tm\auto subfolder of your project and open the project or do Reload. But in this case, the 100% match segments in 
the memories in that subfolder will be automatically inserted in your document(s) only in segments that you have not 
translated yet and which, therefore, have the untranslated status and are not in your project memory.  
As your project memory has precedence, the segments you had already translated remain untouched and the 100% 
matches (formatting included) from the external memory will be displayed — first according to match rate — in the Fuzzy 
Matches pane. 
This is important if you find a reference memory you want to use for pre-translation purposes after starting the translation 
of a project. Your translation will not be overridden by the segments in the \tm\auto files. 
You can leave the memory there as — contrary to what happens to the files in the tm\enforce subfolder — the 100% 
segments in the external memory in the \tm\auto subfolder do not override the project memory. 
This may even be useful if you receive new versions of one or more documents in the project, as the external memory in 
the \tm\auto subfolder will continue to pre-translate the untranslated segments, if any, in the new document/version that 
have 100% match in the memories in the \tm\auto folder. 

 

OmegaT reads the files in the \tm\auto subfolder by alphanumeric order. So, if more than one memory is copied to the 
tm\auto subfolder and there are several identical source segments with different translations, OmegaT will read all the 
files by alphanumeric order and transfer to the project memory the translation of the last occurrence in the last memory 
in the tm\auto subfolder.  
The other (conflicting) translations will be ignored and will be displayed in the Fuzzy Matches pane when that particular 
segment is opened.  
If there are (many) segments with alternative translations, OT will take the previous and next segments of each 
alternative translation into account and transfer to the project memory the last occurrence in the last memory 
(alphanumeric order) in the tm\auto subfolder which has the same previous and next segments. 
Keep in mind that, in DGT-OmegaT, "alternative translations" are document-independent by default, i.e. OT accepts that 
status for non-unique segments in all the documents of the project without “looking” at the number of the document 
(which is recorded) and only “looking” at the previous and next segments. 
The reason for this default in DGT-OmegaT is that frequently there are new versions of documents arriving during the 
translation or revision process and alternative translations from a previous version of a same document would not be 
taken into account if the “alternative translations” were document-dependent as the number of the new version would be 
different. 
If you want to make it document dependent, just go to the Options → File Filters menu and unclick the option Ignore 
File Context when identifying segments with alternative translations. 

 If this feature is important for your project, check that this option is defined as you wish! 
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To give priority to one or more memories, it is just a matter of renaming the memories in the tm\auto subfolder by 
(re)numbering them in the inverse order of priority so that, in case of different translations for an identical (non-unique) 
segment in the project, the translated segment transferred to the project memory comes from the tm\auto memory to 
which you give priority. 
Example: If you have memories A, B and C, to give priority to the segments coming from memory B in case of identical 
source segments, just rename the memories giving that particular one the last number: 

Ø 1-MEMORY-A; 2-MEMORY-C; 3-MEMORY-B  
and the translated segments from Memories A and C will be ignored and not transferred to the project memory. They will 
be displayed in the Fuzzy Matches pane like any other match, before segments in other memories in the \tm folder (if 
any). 

  This is the opposite of what is done when organising external translation memories to be displayed in the Fuzzy 
Matches pane or to be used with Search! 
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This is a completely new feature specific to DGT-OT which allows you to search by some criteria and pre-translate the 
searched segments, either copying source to target or pre-translating — from the external memories or from machine 
translation output — the selected segments.  
You can select the Expression mode and the Word mode, pre-translate only untranslated segments or also already 
translated segment (if you are already in the middle of your translation), memorize terms/strings/regular expressions and 
filter those entries by author or translator and date. 

You can also configure the display of attributes.  Part O for information on how to do it. 

  Section G.1. for an explanation of the effect of the Expression and Word modes and the other options, as it works  
the same way as for Search Project. 

 
Screenshot 64 — The Search and Pre-translate window 

 Please note that in case you have more than one match with the best score, this screen provides no way to decide 
which one will be inserted as it depends on memory ordering.  

  see Section F.4.3. for more details.  
 Don't forget to check in the screen what will be inserted before confirming! 
 

This feature can be very useful when you have documents with hundreds or thousands of segments only with numbers 
that you may want to “translate” in a batch so that they are counted as translated in the statistics and OT doesn’t open 
them with the command Next untranslated segment as they were previously translated in a batch operation. 
This was in fact the reason why this new feature was first designed: to allow you to “get rid” of segments, for instance, 
only with numbers. 
In the example below, there were almost 5,700 segments (out of 18,000 segments in the project) which were numbers 
(headings of the Combined Nomenclature).  
With this new feature, in a few seconds, all those segments were pre-translated (by copying the source to the target 
segments) using the regular expression ^[^a–zA–Z]*$b 
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Screenshot 65 — Search and Pre-translate of full segments only with numbers 

 

You can translate a project from the memories in the \tm folder defining the minimum match rate — Match minimal score 
— for pre-translation purposes and searching for exact/keyword or regular expressions.  
This may be useful if you have segments with similar text in which — for instance — only the number changes, like 
“article 1” etc., Section 1 etc. Or if you want to pre-translate segments with a certain term or expression. 
 

 
 

Screenshot 66 — Pre-translate with Match from the external memories for segments with a certain term. 
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You can search by regular expression and DGT-OT will display the results — which you can check — of the segments 
filling those criteria and of the translation that will be transferred to your project memory. 
Those segments will be displayed in the Editor with a prefix indicating the match rate (100% or lower) between brackets 
to call your attention to the fact that those segments were pre-translated and to their match rate. 
For OT, those segments are considered translated and counted as such in the statistics. 
When you have verified/changed all those segments, you can do a Search/Replace to eliminate that prefix in a batch 
operation, unless you have done it already segment by segment. 
You can also pre-translate the whole project, just by using — in the Search for field — the simple Regular Expression 
“.”.  
In that case, in the Search and Pre-translate window will be displayed the list of all the segments in the project.  

  If you project is really big, this may take some time. 

 Personally, I don’t recommend using this feature for the whole project unless, for instance, the documents in 
your project are heavily tagged and with a pre-translate below 100% you may get 100% matches in terms of 
content.  

 

The same applies to pre-translate using machine translation output. In this case, all the segments fulfilling your search 
criteria will be pre-translated — if you have the relevant MT tmx files, of course — and the segments in the Editor will be 
displayed with the prefix [MT]  
 

 
 

Screenshot 67 — Pre-translate with Machine Translation for segments with the same term as in the previous 
screenshot. 

 

 Take into consideration that the prefix is really part of what is inserted in the target segments: if you do not delete it 
yourself, it will also appear in the project memory and in all generated files, including the target document! 

 The most practical way is to do a Search/Replace to delete them in a batch operation after checking them all. 
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This is a new feature that can be very useful — if handled with care — when the translation of a project is split among 
several translators and there is a high rate of non-unique segments (repetitions). 
Even working in real-time share mode with TeamBase, it is possible that inconsistencies crop up among documents (or 
parts of documents) translated by different translators and/or that are at different stages in the translation or revision 
process. 
Therefore, the reviser — or the (lead) translator — in a shared project may manage these inconsistencies by using a 
global project with all the parts/documents together and select the memory(ies) that have precedence and even override 
the project memory in the global project.  
This feature may also be useful — even in a project with only 1 translator and 1 reviser — if the revision is done 
progressively (in “cascade”). In that case, the translator may want to override the translation in non-revised documents in 
his/her project with the memories from documents already revised.   
The \enforce subfolder is not automatically created when the OmegaT project is created (either via the DGT-OT Wizard 
or directly in OT). You have to create it manually in Windows Explorer if you want to use this feature. 
You just have to copy to the \tm\enforce folder you create the memory you want to use for this purpose and open the 
project or Reload it. 
The 100% segments (including tags) in the files in this subfolder are the only ones that have priority over the project 
memory and — unlike the files in the \tm\auto subfolder — will even replace any segments already translated (saved in 
the project_save.tmx). Furthermore, that memory will continue to override any changes you make to the segments in 
your project afterwards. 
When you open your project (or do Reload), those segments are displayed in the Editor, by default, also highlighted 
with an orange background colour — as in the pre-translation using the \tm\auto subfolder — since they are considered 
“auto-populated” from an external memory. They will also be identified with the login of the translator of those segments 
in the external memory. 
They will remain so highlighted and with the other login unless you modify them therefore making them your own.  
After opening, or reloading, the project — as the segments are immediately transferred to the project memory — delete 
that folder or transfer that memory to the main \tm folder as otherwise the segments in that subfolder will keep overriding 
the segments you change afterwards and which have a 100% match (tags included) in this memory. 

 So be extremely careful and don’t forget to delete the \tm\enforce subfolder if you don’t want to see your 
subsequent changes continuously overridden.  
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If you have a package that is being translated by several translators, besides working in share mode via TeamBase to send 
and receive — in real-time — the segments translated in that particular project, you may also want to share the external 
memories to be used by all the translators involved in a particular project. 

 If you want to use this in a project while teleworking, check that there are no connection/speed problems. 
Usually it will be the lead translator/coordinator in your Unit that will organise the material for a given project.  
The big advantage is that external memories are organised for everybody and can be changed for all translators involved at 
the same time. 
The disadvantage may be that each translator cannot organise the external memories differently — for instance depending 
on the stage in his/her translation — as those changes will be done centrally and therefore will be used by all the other 
translators. 

 Please also note that memories are fully loaded in the computer memory (RAM): do not use this feature to create a 
very big directory to be shared by several projects, since no computer is yet capable of managing gigabytes of 
translation memories for one single project! 

  As you can at any time change the location of the external memories, you can easily copy the \tm folder organised 
by the coordinator to your computer and organise them differently as you prefer.  

 
 

Screenshot 68 — Changing the location of the external translation memory folder to a server location.  

To change the location of the external memories for your project: 
1 — In DGT-OT, select Project → Properties menu. 
2 — In the field Translation Memory Folder, click on Browse to select the folder in the server where the organised 

external translation memories are stored. 
3 — Click on OK and you will start receiving fuzzy matches from that “central” location. 
 You can change the location again as many times as you want. OT will remember this setting every time you reopen 

this project. 
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The public OmegaT Search is very sophisticated with options very important to translators as they can save a lot of time, 
especially for large projects with a large number of reference memories. 
In DGT-OT, the Search window has been redesigned and further improved with features that really make a translators’ life 
easier! 

 Such a wealth of options may be confusing at first, but — believe me — once you understand how it works you won’t 
be able to live without it ! 

 

In the Search window, you can have all the search options displayed — including the Advanced Options (highlighted in 
blue below) — or just the ones more frequently used, thereby having more space in the window for the display of the 
Search results. 
You can also configure the attributes that identify the results in the Search window.  

 Part O for detailed information on the customization of Attributes. 
 

 
Screenshot 69 — Search window with Advanced Options displayed (highlighted in blue above).  

 
As you can see from the screenshot above, you can search — by exact search, keyword search and regular 
expressions, strings, whole words and lemmas; use the Booleans OR, AND and NOT; search by regular expressions, by 
author/translator, by date — in source or/and target segments in your project (translated and/or untranslated) and/or in 
the translation memories and/or in glossaries and notes, by date and by author or translator.  
You can also limit the search to a subfolder or a translation memory in the \tm folder. 
If you have given priorities to memories or subfolders with memories, you will have the search results displayed by the 
(alphanumeric) order of priority you have set. 
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For a number of settings, you can also memorize searches to be reused in that session, in that particular project or in all 
the projects. This option is particularly useful for regular expressions.  

 in Section G.5. the list of the Regular Expressions already memorized in the Search window for searches In 
Source. You can copy them to other search fields in the Search, Search/Replace, Search Directory and Search and 
Translate windows as the memorize feature is field-dependent. 
In the same window, you can also filter, by those criteria, segments in your project to have them displayed in the Editor 
pane for editing, by clicking on Filter at the bottom of the Search window. 
To do a search, just highlight in the Editor the term/string you want to search and press the relevant icon or Ctrl+F or 
select Search Project in the Edit Menu. 
The Search Project window is displayed, already with the term/string to be search inserted. Just press Return to accept 
the selection or select other options. 
You can also not highlight any term/string and just write the term/expression you want in the field you want. By default, 
OT assumes that a search is made in the In source field. For searches in the In translation or In notes fields, you have 
to copy/paste or write the term/string. 
OT will remember the settings you used in your previous search and will display them in the Search window therefore 
(maybe) saving you time. 

You can search terms/expressions In source and In translation.   
A new OT feature is that you can also search In notes. With the search in notes, OT will display the list of segments 
which have notes with that particular string and you can click on the number at the left of each segment and OT will open 
that segment and you can see the note in the Notes pane 

You can also have the notes displayed together with the matches in the Fuzzy Matches pane.  Part O on Attributes 
customization.  
A DGT-OT specific feature is that you can also search not only in the source or in the translation, but also search in the 
source and in the translation segments of your project or of your translation memories using the Boolean AND. With this 
option you can therefore search a particular term or expression in the source language and associate it with a term or 
expression in the target language to search segments which have both.  
 

Search of “misuse” In Source  Search of “misuse” In source with the term “usurpação” 
In Translation and the Boolean AND 

  

Screenshot 70 — Search using the Boolean OR and the Boolean AND 
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A new feature in DGT-OT is that you can also use the Boolean NOT to exclude terms/strings. This feature can be very 
useful to limit the search if you want to check the terminology/phraseology variants in your external memories.  
So, with the Booleans AND+NOT, you can search a particular term or expression in the source language and associate 
it with a term or expression in the target language to search segments excluding one or the other in order to find variants 
either in the source or in the target language.  
 
Search of “users” In Source Search of “users” In source with the term “utilizadores” In 

Translation and the Boolean AND+NOT 

  

Screenshot 71 — Search using the Booleans AND+NOT 
 

In DGT, the Search feature has been redesigned and improved and you have — besides the Expression mode options 
— the Word mode options which you can associate to widen or limit the search results depending on your needs. 
The options available are: 

Ø Expression mode: Exact search, Keyword search, Regular expressions and Case sensitive  
Ø Word mode: Strings, Whole words and Lemmas. 

The Expression mode describes how the succession of words (separated by spaces) is considered. The possibilities 
are: 

Ø Exact search: the words must all be in the text and in same order, i.e. you look exclusively for the entire 
query string; 

Ø Keywords: one of the words must be present, so "one example" means indeed "one OR example". In other 
words, you look for all the words in the query independently of the order in which they appear in the 
segments being searched; 

Ø Regular expression: what is in the fields is not words but a regular expression.  Section G.5. for 
information. 

The Exact and the Keyword search types support the wildcard characters '*' and '?'. The '*' character matches zero or 
more characters (the search term 'run*' would match 'run', 'runs', and 'running', for example). The '?' character matches 
exactly one character ('run?' would match 'runs' and 'rung', for example, but not 'run' or 'running').  
The Case sensitive option is obvious: you will only have results in which the case matches your search. 
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For the Exact Search and Keywords options, you can then decide how each word will be considered individually. You 
have 3 Word mode options — String, Whole Words and Lemmas — as shown below: 

If the text contains STRING WHOLE WORDS LEMMAS 

 Considers words as a 
simple sequence of 
characters 

The word may not be 
preceded or followed by 
letters 

Uses the tokenizer to 
accept grammatical 
variants of the same word 

Test Yes Yes Yes 

Tested Yes (it contains the word 
“test”) 

No (only the word “test” is 
accepted) 

Yes (if using the English 
tokenizer) 

Protest Yes (it contains the word 
"test") 

No (only the word "test" is 
accepted) 

No (protest is not a 
grammatical variant of "test") 

 
If you are wondering why there are so many options, let’s look at the examples below — where there is not only a word 
but also 2 strings of words to be searched — as it is so much easier to show than to explain! 

SEARCH WITH EXPRESSION MODE EXACT SEARCH AND THE 3 WORD MODES 
 

TERM 
 

EXACT SEARCH + STRING 
 

EXACT SEARCH +  
WHOLE WORDS 

 
EXACT SEARCH + LEMMAS 

 Results No. Results No. Results No 

withdrawal 
1. withdrawal 
2. Withdrawals 

102 1. withdrawal 88 1. withdrawal 
2. withdrawals 
3. withdraw 
4. withdrawing 

192 

arbitration 
panel ruling 

1. arbitration panel rulings 
2. arbitration panel ruling 

187 1. arbitration panel ruling 179 1. arbitration panel ruling 
2. arbitration panel rulings 
3. arbitration panel to rule 
4. arbitration panel rules 

250 

equal 
treatment  

1. equal treatment 
2. unequal treatment 

48 1. equal treatment 45 1. equal treatment 45 

 

SEARCH WITH EXPRESSION MODE KEYWORD SEARCH AND THE 3 WORD MODES 
 

TERM 
 

KEYWORD SEARCH + 
STRINGS 

 
KEYWORD SEARCH + 

WHOLE WORDS 

 
KEYWORD SEARCH + LEMMAS 

 Results No Results No Results No. 

withdrawal 
1. withdrawal 
2. Withdrawals 

102 1. withdrawal 88 1. withdrawal 
2. withdrawals 
3. withdraw 
4. withdrawing 

192 

arbitration 
panel ruling 

1. arbitration panel ruling 
2. arbitration panel rulings 
3. arbitration panel to rule 
4. arbitration panel rules 
5. rulings of the arbitration 
    panel 
6. arbitration panel 
   decisions and rulings 

419 1. arbitration panel ruling 
2. arbitration panel ...ruling 
3. ruling of the arbitration  
   panel 

378 1. arbitration panel ruling 
2. arbitration panel rulings 
3. arbitration panel to rule 
4. arbitration panel rules 
5. rulings of the arbitration panel 
6. arbitration panel decisions and rulings 
7. arbitration panel… Rules of Procedure 
8. arbitration panels ...customary rules 

537 

equal 
treatment  

1. equal treatment 
2. unequal treatment 
3. its treatment is equal 

51 1. equal treatment 
2. its treatment is equal 

47 1. equal treatment 
2. equality of treatment 
3. its treatment is equal 

48 
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You can search by Translated, Untranslated and Translated and Untranslated (the default) segments. This applies, of 
course, to searches that include the project memory (Memory) as in the external memories all the segments are 
translated. 
You can also see just one occurrence (the default) and the number of identical segments found in the memories or you 
can see all duplicate segments by unticking Remove Duplicates if you want to see where those segments came from. 
 

You can search in all — source files, project memory, external memories and glossaries — at the same time or restrict 
the search to one or some. 
The project memory segments have priority over the segments from the external translation memories (if that option is 
also selected) and are displayed first (including orphan segments). 
So, you can select where OT will search for the term/strings in the In source, In translation or In notes fields:  
Ø In the Source files of your project : "translation" and "note" fields also search in what is in the source file itself – 

so it is only useful for bilingual documents, like PO localization files. 
Ø  In the Memory — i.e. the memory of your project — including or not translated segments, depending on your 

selection in the Search options. 
 In the screenshot below is an example of a search with Search scope — Memory — in which the search was 

carried out only in the project memory where the segments translated for that particular project are saved. 
 The results are displayed with the respective segment number in your project. By clicking on that number, OT 

will jump to the Editor and open that segment for editing.  
 

 
Screenshot 72 — Search window display without the Advanced Options and the search restricted to the project 

memory and to Exact search by strings. 
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In the screenshot below, you can see the same search but this time in the external memories only — the tmx files in the 
\tm folder of your project — and the full Search interface with the Advanced Options is displayed.  

 
Screenshot 73 — Search window display with the Advanced Options and the search restricted to the external 

translation memories (TMs) and to Exact search by strings. 
 

Ø  In the Glossaries, thereby allowing you to use the Expression and Word modes to restrict or widen your 
search and obtaining more or less results than those displayed in the Glossary pane. 

 
Screenshot 74 — Search in glossaries 
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Ø  In the File or Folder that you may have selected by filling in its name in the File or folder name field.  
The name of the folder must be exactly its name (without TM:) as seen in the example below — 
2-Norm-Memory — in which are only displayed the results from the Normative Memory folder.  
 

 
Screenshot 75 — Search limiting it to the 2-Norm-Memory subfolder in the \tm folder 

 
If it is a search limited to a single file, it must be the full name of the file (path included if it is a file in a subfolder 
of the \tm folder), extension included as in the example below: 1-MAIN-REFERENCES\NoDG-2009-
32009R0723_EN-PT-DWN.tmx. If the tmx file is not in a subfolder, it is only necessary to have the name of the 
file (in this case it would be: NoDG-2009-32009R0723_EN-PT-DWN.tmx). 

 

Screenshot 76 — Search limiting it to the 2-Norm-Memory subfolder in the \tm folder 
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This is a brand new DGT-OT feature. It applies to several fields as can be seen in the screenshot below. 

 
Screenshot 77 — Memorize feature 

You can memorize your searched terms by pressing the button Memorize in the field you want and selecting if you want 
to memorize the term/expression only For the current session (i.e., it will be deleted after you close the project), For 
the project (and thereby having it available for that project no matter how many times you close and reopen it) or For all 
the projects you translate using OT. 
This feature is available for the fields: In Source, In translation, In notes, File or folder name, Author and Translator. 
You can memorize words/strings and, particularly useful, Regular Expressions. In Section G.5. is available the list of 
regular expressions already memorized for the In Source field. As the feature memorize is field-dependent, if you want 
you can copy those regular expressions to other fields … or write new ones if you know how! 
 

In DGT, there is a difference between the author and the translator in the external memories attributes.  
The author is the person who has made the alignment of the source and target documents, which may be an assistant or 
a translator or an automatic alignment without human checking. The translator is the one defined as such in a dedicated 
field in the tmx files stored in Euramis. 
Search of “spectrum” In Source Search of “Spectrum” In source with Translator: matosca 

    

Screenshot 78 — Search with and without limiting it in the Translator field 
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In DGT released documents, the name of the translator may be missing if a post-alignment is made and that information 
was not recorded in the tmx file. 
There is always an author (of the alignment), but for published legislation there is never a translator. 
In the project memory — and the memories generated from it — the author and the translator are the same of course. 
This difference may be important when you have many external memories and you want to search by the login of the 
translator who may be the “reference” for a particular domain. 

In the Changed after and Changed before fields you can set the data and hour. And of course you can combine it with 
other fields. 
In the example below, the search is made for the term “bands”, translated by matosca, after a certain date thereby 
restricting the search from 127 to 4 results. 
 

Search In source of the term “bands” without other 
search criteria 

Search In source of the term “bands” with the 
Translator matosca and after 9/1/2010 

 

 

 

 

Screenshot 79 — Search in the external memories by date combined with Translator 

You can define the number of matching segments you want OT to display in the Search pane. You can increase it — to 
several thousands — if you want, for instance, to count occurrences of several ways of translating a source terms into 
the target language. 
OT indicates the number of matching segments found. 
If you select a (very) high number, it may slow down the search … but at an acceptable level. By default it is set to 1,000. 
This may save you a lot of time as you can quickly determine which are the frequent/infrequent translations of a term/string if 
you have a large number of reference memories. 
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In fact, the Search feature itself is already a filter as you can limit the search in several ways.  
So filtering in OT really refers to the editing of the searched terms/strings in the project memory and therefore it is — 
obviously — only applicable to searches in the project memory. 
You can, in a single operation, search for words/strings/regular expressions as explained in the previous sections and, 
using the search results, filter those segments for editing. 
Just click on Filter at the bottom of the Search window. Those filtered segments will be displayed in the Editor and you 
can modify them. 
A new OT feature is that, to return to the full document and continue working normally, you click on Remove filter, which 
is now at the top of the Editor. No need to go back to the Search window (which you might have already closed down!) 
as was the case in previous OT versions. 
 

 
Screenshot 80 — Filtering — Editor pane displaying for editing the filtered segments selected with the Search 

feature in the whole project 
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You can do a Replace Interactive (one by one) or a Replace all in all the documents of your project using the same 
options as in Search Project (exact search, keyword search, regular expression, case sensitive, strings, whole words 
and lemmas).  
To search/replace a term/string, just highlight in the Editor the target text you want to replace, press Ctrl+K (or click on 
Search and Replace in the Edit menu or use the icon) and in the field Replacement type the text you want to replace it 
with. 

 
Screenshot 81 — Search displaying matching segments. Option to Replace all  

 
You can “preview” the segments affected. OT will display the segments affected: as they are in the project memory (in 
red) and as they will be after the replacement (in blue). 
To launch the replacement operation, just click on Replace all or Replace Interactive at the bottom of the 
Search/Replace window. 

 It is strongly recommended that — if you choose the option Replace all — you have a look at the results displayed to 
check that your settings do not included unwanted segments as in OT there is no Undo/Redo option for this 
operation. Therefore, be extremely careful!  

 To be on the safe side, do a Save (Ctrl+S) before doing a Replace Interactive/all as, in extremis, if you make a 
really BIG mistake in this operation you can use the last backup of your project memory stored in the project 
\omegat subfolder and not lose any work you did before the replacement operation. If you forget to do it, don’t 
worry, you can always use the last backup without losing much work as OT does automatic backups every 3 
minutes. 

  Part P on Troubleshooting. 
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If you select the option Replace Interactive, just click on Skip — if you don’t want to replace it — or Replace Next if you 
want to replace it. When you finish, click on Finish and OT will display the Editor window with the segment last replaced 
open.  

 
Screenshot 82 — Filter option: Replace Interactive (one by one) 
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You can search monolingual documents in the formats accepted by OmegaT (e.g. Office and PDF) using the Search 
Directory feature. Search Directory does not accept tmx files. 
In DGT-OmegaT, this search is separated from the Search Project feature and has a dedicated window that you can 
access via the Edit → Search Directory menu or with the Ctrl+Shift+K shortcut. 
To use this feature, just: 
1 —  In Windows Explorer, copy your reference document(s) to a new subfolder that you create in your project or 

anywhere in your computer 
2 — In DGT-OT, highlight the term to be search and press Ctrl+Shift+K 
3 — In the Location field, click on Select Folder to browse to the folder where you have your reference document(s) 
 OT will remember that location in future searches. However, when you close and reopen that project, you will have to 

select the location again 
If you have Recursive search checked, it will also search for documents in subfolders of the selected folder. 
This search is quite fast … as long as you don’t have an enormous amount of reference documents! 

  Very useful if you have monolingual reference material in the target language. It saves time as you can search 
directly in OT if a particular term is used in national legislation, for instance. 

As with Search Project, you have a number of options to restrict or limit your search. The options available are, mutatis 
mutantis, as explained in the previous sections. 
 

 
Screenshot 83 — Search in monolingual reference documents 
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In theoretical computer science and formal language theory, a regular expression (abbreviated regex or regexp and 
sometimes called a rational expression) is a sequence of characters that forms a search pattern, mainly for use in pattern 
matching with strings, or string matching, i.e. "find and replace"-like operations.  

 the article in Wikipedia and Chapter 17 of the public OT Help/Guide for an overview of RegEx. 
In DGT-OT, you can use RegEx in Search Project, Search Directory, Search and Replace and Search and Translate. 
Regular Expressions can be very useful if you know how to use them ... and if you are careful! 

 If you use them in Search and Replace all or in Search and Translate, it is highly recommended that you have a 
look at the results displayed to check that your settings do not included unwanted segments. The same 
recommendation applies too: do a Save before launching the replacement operation so that you can use a project 
memory backup if something goes wrong. 

Regular Expressions work only in string mode, implicitly. For that reason, when you select that option, the Words mode box 
disappears and new options are displayed: 
Ø Partial segment: accept any segment containing the regular expression, even if there is something before and after 
Ø Full segment: the segment matches the regular expression, with nothing before or after. This is equivalent to 

adding ^ at the beginning and $ at the end of the expression 
Ø Whole words: equivalent to adding \b at the beginning and end of the segment 

 
Screenshot 84 — Regular expression mode 

To make your life easier, in DGT-OT some regular expressions are memorized and given a more or less understandable 
name. 

 
Screenshot 85 — An example of Search with a Regular Expression: Decimal numbers (2 decimal places) separated 

by comma (,)  

http://en.wikipedia.org/wiki/Regular_expression
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The Regular Expressions in the list below are memorized for Search Project in the In Source field. They will be 
displayed when the Expression mode is set to Regular Expressions and you press the select button to display the 
dropdown menu. 
As the Memorize feature is field-dependent, write/copy the regular expressions you need to other fields in the Search 
Project, Search/Replace, Search Directory or Search and Translate windows.  
If you want to write your own RegEx, you can include a description. For that, use the vertical bar “|” followed by the 
RegEx (like those memorized), making sure that it is not a string that is likely to happen in any text.  
To memorize Regular Expressions, just write or copy the RegEx you want in the field you want, click on Memorize for 
that field and select if you want to save it For this session, For the project or For all projects. 
Regular expression RegEx memorized What it finds 
[\d]{1,},[\d]{1,2} 1–2DECIMALScomma Decimal numbers  (2 decimal places) separated by comma (,) 

[\d]{1,}\.[\d]{1,2} 1–2DECIMALSdot Decimal numbers (2 decimal places) separated by dot (.) 

[\d]{1,}\.[\d]{1,2}% 1–
2DECIMALSdotPERCENTAGE 

Decimal numbers (2 decimal places) separated by dot (.) immediately followed by % 

[\d]{1,2}[\.–
\/][\d]{1,2}[\.–
\/][\d]{4} 

DATES Dates in following formats: (D)D.MM.YYYY, (D)D–MM–YYYY and (D)D/MM/YYYY 
At the beginning of segment :  add ^ at the beginning, e.g. ^[\d]{1,2}[\.–
\/][\d]{1,2}[\.–\/][\d]{4} 
At the end of segment :  add $ at the end, e.g. [\d]{1,2}[\.–\/][\d]{1,2}[\.–\/][\d]{4}$ 

[\d]+ DIGITSall Any number of digits 
W/ NOT ticked: only segments without digits 
W/ "Full segment" activated: segments with digits only (i.e. no spaces, punctuation, 
symbols or letters) 
W/ "Partial segment" activated: segments which possess at least one digit 

[\d]{1,}% DIGITSpercentages Digit(s) immediately followed by %, e.g. 5% 
With a space before %: [\d]{1,}\s% (\s caters for all kinds of spaces and tab) 

[A–Za–z]+ LETTERSall Any number of upper– and lowercase letters (i.e. no spaces, digits punctuation, 
symbols or letters from other alphabets) 
W/ NOT ticked: only segments without any letters 
W/ "Full segment" activated: segments with letters only (i.e. no spaces, punctuation, 
symbols or letters from other alphabets) 
W/ "Partial segment" activated: segments which possess at least one letter 

^\([a–zA–Z]{1,4}\) LETTERSstartBRACKETS Segment starting with characters (case–insensitive) in brackets, e.g. (a), (i), (vi) or 
(VI) 

|^[^a–zA–Z]+$ NoLETTERS  

\([\d]+\) NUMBERSbrackets Numbers in brackets with no spaces 

[\d\.\s,<>t\/]+ NUMBERSdotCOMMAtagSPACE Numbers including dots, OmegaT tags, commas, spaces in any combination. 
W/ "Full segment" activated: segments consisting only of numbers and/or dots 
and/or OmegaT tags and/or commas and/or spaces in any combination 
W/ "Partial segment" activated: not suited 

[\d]{1,}– NUMBERShyphen Numbers followed by a hyphen 

^[^a–zA–Z]*$ NUMBERSonly Segments only with numbers 

[\d]{1,}\s[\d]{3} NUMBERSseparSPACE Numbers with a space between groups of digits, e.g. (10 000) 

\([\d]{1,}\s[\d]{3}\) NUMBERSseparSPACEbrackets Numbers in brackets with a space between groups of digits, e.g. (10 000) 

\s\s+ SPACEdouble Segments with double space 

\b[A–Za–z]+\b $ WORDend Segment ends with word 
W/ NOT ticked: Segment does NOT end with a word 

(\b\w+\b)\s\1\b. WORDSrepeated Segments with repeated words 

^\b[A–Za–z]+\b WORDstart Segment starts with word 
W/ NOT ticked: Segment does NOT start with a word 
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The memorized searches for the project are stored in the main folder of your project and the memorized searches for all 
projects are stored in the _CONFIG–PERSONAL subfolder of the OmegaT_Projects folder in your computer, both in 
files named search.tsv.  
In the example below, you can see the file where the regular expressions are already saved by default in the 
_CONFIG-PERSONAL subfolder. 
In the Search windows you can memorize regular expressions or terms but you cannot delete them. 
If you want to delete regular expressions that you no longer want, just open this file in Notepad++, delete the lines with 
the terms/regular expressions you don’t want anymore and save it. 
 

 
Screenshot 86 — The search.tsv file where the memorized regular expressions are stored (in this case for all the 

projects). Here is also a term (spectrum) that has been memorized. 
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In DGT-OT you have direct access to these EU/DGT applications, just by highlighting the term/string/OJ reference you 
want to search and clicking on the relevant icons or using the shortcuts. 
 

Quest is a metadata engine through which you can search several databases in a single operation. In this example, 3 
databases are selected — IATE, Euramis and Eur-Lex — and there is the indication that there are other 32 databases 
that can be selected and searched.  
 

 
 

Screenshot 87 — Search in Quest in this case showing results from the EU Official Journal 
 
In Help, there is all the information about Quest with (Quick) Guides. 

 The search in Euramis and IATE via Quest only gives access to some of the features of those databases. If you 
want to have the full options available, access them directly using the respective icon.  
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In My profile — at the right top of the screen — you can select other databases by checking the respective boxes. 

 
 

Screenshot 88 — List of databases available via Quest 
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You can search Euramis via Quest and have access to an interface with limited options in terms of number of results and 
other Euramis features. For instance, the only option is to search by exact string or all words. 
 

 
 

Screenshot 89 — Search in Euramis via Quest 
 
But you can also access Euramis directly and have all the options by clicking on the icon or pressing Ctrl+Shift+E. 
 

 
Screenshot 90 — Search in Euramis directly 

 



  

 
183 

In the full-fledged Euramis interface, besides being able to see a larger number of results, you can also limit the search 
in several ways. 
 

 
 

Screenshot 91 — Search in Euramis directly with options 
 
 

 Euramis Help for full information on its features 
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You can search IATE via Quest and have access to an interface with limited options or access it directly and have all the 
options by clicking on the icon or pressing Ctrl+Shift+L. 
The direct link to IATE full interface allows you to use all the search features and also to create entries and add 
comments. 

Section I.7. for more information. 
 

 
 

Screenshot 92 — Search in IATE via Quest 
 

 
 

Screenshot 93 — Search in IATE directly 
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In the full-fledged IATE interface, besides being able to see a larger number of results, you can also limit the search in 
several ways. 
 

 
Screenshot 94 — Search in IATE directly with full options 
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DocFinder gives access to the EU databases shown in the dropdown menu below. 
By highlighting the reference in the Editor and clicking on the DocFinder icon or pressing Ctrl+Shift+F, you can access 
those databases. 
 

 
 

Screenshot 95 — DocFinder results 
 

 DocFinder Help for full information about its features. 
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In OmegaT, using and managing glossaries are very simple operations and, considering that in DGT we have as 
terminology database IATE, simple 3-field glossaries are a sufficient complement to satisfy our needs. 
In DGT-OmegaT, the display of glossary entries has been further improved. 
 

OmegaT allows you to use or create simple glossaries with 3 fields and it can handle very large glossaries (even with more 
than a million entries) without noticeably losing speed.  
Your (writable) glossaries can be bilingual or multilingual, as you prefer. In fact, as OT doesn’t store the language code for 
each entry, you can have any language both for source and target terms. 

You can also use the glossary — or the Notes (  Part J) — to collect information that might be used later to create an 
IATE entry.  
The glossary function finds not only exact matches with the glossary entry, but also inflected forms. It is not perfect, but from 
EN to other languages — which is the bulk of DGT translations — it works … more or less. 
The glossaries for the project are, by default, in the project \glossary folder, but they can also be anywhere else you want — 
as long as they are all together in a folder (even with subfolders). 

 This way you can share the glossaries for a given project in real time by having them in a server location while 
keeping your project in your computer. 

Glossary entries for the segment open in the Editor are displayed in the Glossary pane. They can also be displayed in a 
dropdown menu by right-clicking with the mouse on the source term in the Editor to display the TransTips (Translation 
Tips) suggestions. 

 
Screenshot 96 — Glossary pane and Transtips (Translation Tips) in the Editor in a drop-down menu 
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The glossary entries can also be displayed using the Auto-completion → Glossary feature by positioning the cursor on 
the target term and pressing Ctrl+space until the option Glossary entries is displayed. 

 
Screenshot 97 — Auto-complete — Glossary 

 
In the public OmegaT is available the TaaS service (Terminology as a Service), but for the moment it is not available in 
DGT-OmegaT. 

 the public OT Help or the OmegaT Guide — Chapter 20 for more information on TaaS. 
 

OmegaT accepts glossaries in the following formats: 
Ø UTF-8 format (with the extension .txt), either for read only or read/write glossaries (writable glossary). 
Ø TBX as a read-only glossary (extension tbx). TBX — Term Base eXchange — the open, XML-based standard 

for exchanging structured terminological data, has been approved as an international standard by LISA and 
ISO. 

Ø CSV: This format is the same as the tab separated one: source term, target term. Comment fields are 
separated by a comma ','. Strings can be enclosed by quotes ", which allows having a comma inside a string:  
Example: "This is a source term, which contains a comma","c'est un terme, qui contient une virgule" 

 As the UTF-8 format is the only one that can be used both for read and read/write glossaries, I suggest you adapt 
your (existing) glossaries, if any, to this format as you can at any time use them as writable glossaries. 
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OmegaT can have any number of read-only glossaries — even in subfolders of the project \glossary folder — but it can 
have only 1 writable glossary — also called the priority glossary.  
This glossary is, by default, named glossary.txt and is automatically created when you create the first terminology entry 
in your project. 
The results from the writable glossary are displayed first in the Glossary pane (and in bold) and in Transtips. 
So, in the \glossary folder of your OT project you can have: 
Ø The IATE extraction automatically imported to your project by default (if you have not unticked the IATE box in 

the DGT-OT Wizard when creating or updating a project).  
Ø The writable (priority) glossary that is created for your project in the \glossary folder when you create a first 

glossary entry and which is simply named glossary.txt. 
Ø Personal/Unit/Department glossaries, if any, that you would like to use in your project and which you can 

adapt to be used in OT. You will have to copy them to the project \glossary folder.  
You can also make one of these glossaries your writable glossary — as long as it is in .txt format — just by 
(re)naming it glossary. 

OT accepts the following simple txt file (UTF-8) with 3 fields separated by tabs and ended by a carriage return (the last 
field is optional):  

 <tab>Source term <tab>Target term <Return> 3rd field with whatever you like or empty

 
Screenshot 98 — Writable glossary opened in Notepad++ for editing 

You can convert glossaries that you have — either in table or text format — and save them as a plain text (txt), UTF-8 
file. 
If you want a glossary to be your writable glossary — the glossary where you will create new entries for that project — 
the easiest way is simply to (re)name it “glossary”.  

  If, when converting your glossaries, you make a mistake and have 4 or more fields — instead of 3 — OT will read 
the 3 first fields — displaying them in the Glossary pane — and simply ignore the others. But it will not be 
“blocked”! 
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When you create a project using the DGT-OT Wizard, it will automatically copy to your project — to the \glossary 
subfolder — a filtered extraction of IATE only with the entries relevant for the source terms present in the documents in 
your project. 
 

 
Screenshot 99 — IATE extraction EN-PT with source and target terms only, viewed in Notepad++ (the default when 

you open a txt file) 
 
The entries from IATE will be displayed in the Glossary pane, in TransTips and in Auto-completion → Glossary 
entries. 

 If — while translating — you change your mind and prefer not to have this IATE extraction mixed up with other 
project-specific glossaries you might have, just open the project folder (Ctrl+Shift+F1), open the project 
\glossary folder and delete that file or drag and drop it to another location... in case you change your mind again 
and want to use it after all! 
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You can have the glossaries you want to use in a different location in your computer — and not in the project \glossary 
folder — so that you can use the same writable glossary in all your projects without having to copy it every time you have 
a new project and also in order to be able to use the same writable glossary if you are working in more than one project 
at the same time. 
You just have to change — in the Project → Properties menu — the folder where you want OT to look at.  
In the Glossary Folder field, click on Browse and select the folder where you have the glossaries you want to use in 
that project and in the Writable Glossary File field, select the file you want to use as your writable glossary.  

 Don’t forget that — if the glossaries are in a folder outside the active project — there will be no automatic backups 
of your writable glossary. So don’t forget to do manual backups of your writable glossary to the H:drive! 

 If you want to use this in a project while teleworking, check that there are no connection/speed problems. 
 

Default glossaries location Changed glossaries location to a general folder to be 
used in all OT projects 

  
Screenshot 100 — Properties menu to change the folder path where the glossaries are stored 

 It is also here that you can change the name of the writable glossary even if you don’t want to change its location. 

 Don’t forget that both the read-only glossaries and the writable glossary must be on a same folder. But you can 
have subfolders if you want. 

OT will store the new location and, every time you reopen that project, it will “remember” the location of the glossaries as 
you last defined. You can change the location again at any time. 
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If you are translating a project with other translators using TeamBase to share translated segments, you may also want 
to share glossaries. 
As you can change the glossaries location — either to another folder in your computer or to a server — you can change 
the Glossary Folder and Writable Glossary File fields in the Project → Properties menu to a common folder in a 
server accessible to all the translators you want to share glossaries with. 

 If you want to use this in a project while teleworking, check that there are no connection/speed problems. 
While there is no problem in what read-only glossaries are concerned, with writable glossaries there may be conflicts. So 
it is recommended — to be on the safe side — that each translator has his/her own writable glossary by naming it 
whatever you and your colleagues want and defining it in the respective Writable Glossary File field in each of the local 
projects.  
This way: 

Ø The non-writable glossaries — IATE extraction and other personal/LD/Unit glossaries, if any — are accessed 
in read mode by all the translators 

Ø The writable glossary of each translator is defined as such in the Writable Glossary File field, but for the 
other translators it will be a read-only glossary. 

Also this way each translator is the “master” of his/her own glossary. As several entries for the same term will be 
displayed together, it is easy to spot alternatives/inconsistencies. 
 

 
 

Screenshot 101 — Changing the location of the glossary(ies) to a server location and defining the glossary 
which is the writable glossary 
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The glossaries in OmegaT are very simple to manage and use.  

 If you want to use a single — bilingual or multilingual — writable glossary for all your projects, don’t forget — before 
starting translating a new project — to change the glossary path as explained in Section I.1.6. above.   

 

As already explained, if you do not have a glossary in your project, OT will automatically create a new glossary for that 
project that, by default, will be saved in the \glossary subfolder of your project and named glossary.txt.  

 
Screenshot 102 — Create a new entry in the writable glossary 

To create a new (or first) glossary entry, just highlight the source term you want in the Editor and press Ctrl+Shift+G (or 
select Create glossary entry in the Edit menu or use the icon).  
The highlighted text will be automatically inserted in the Source term field in the Create Glossary Entry window.  
After inserting the source term, you can also insert the target term by highlighting the target term in the Editor pane, 
positioning the cursor in the Target term field of the Create Glossary Entry window (or pressing Ctrl+Shift+G again). 
The target term will be copied too. Or you can just write the target term in the respective field. 
The same happens with the Comment field if, for instance, you want to copy a context. 
 

In OT, it is not possible to modify or delete an entry, i.e., you can create a new entry but you cannot edit nor delete an 
existing entry. 

 If, at first, the edit feature to change or delete entries seems to be missing in OT, on the long run I came to prefer it. In 
fact, it is faster to freely change all the entries you want in a text only file at the same time! 

If you want to do it, open the file that is stored in the \glossary subfolder of your project — or anywhere else — with the 
command Ctrl+Shift+F2 and process it in Notepad++ (the default application for txt files).  

 
Screenshot 103 — Writable glossary open for editing in Notepad++ 
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You can also have that file open in Notepad++ while working with OmegaT and inserting terminology entries in Notepad … 
as long as you respect the format (source term<tab>target term<tab>3rd field<Enter>).  Or you can just add to it a list of 
terms in a batch operation. 
You can make changes to previous entries and do save (Ctrl+S) in Notepad++ and those changes will be immediately 
shown in the Glossary pane, in TransTips and in the Auto-completion → Glossary entries list. 
If you edit the glossary in Notepad++, it is advisable to have the display showing tabs and end of lines by selecting — in 
the View menu — the option Show Symbol → Show All Characters, as shown below, so that you don’t mess up the 3 
fields! 
 

 
Screenshot 104 — Notepad++ View options 

 
You can select entries to send to other translators/your reviser/LD terminologist as you can easily copy the entries you want 
to give/send them or that you want to include in the Tradesk Note.  
Just copy/paste those lines (or the whole glossary) into another application — an email, Word, Excel, Tradesk Note — and if 
you want convert the text to a table to make it more “presentable”. 
 

 
 

Screenshot 105 — Writable glossary open while editing 
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In DGT-OT, the display of entries in the Glossary pane has been improved. 
The Glossary pane now displays the entries in the following way: 
Ø The entries are displayed with source term in blue, target term in green and comment, if any, in black. 
Ø The entries from the writable (priority) glossary are displayed first by alphabetic order and in bold. 
Ø The entries from other glossaries are displayed after the entries from the writable glossary and also by 

alphabetical order. 
Ø Entries can be highlighted and you can use copy/paste or drag/drop to copy them to the segment open in the 

Editor. 
 

 
Screenshot 106 — Entries in the Glossary pane: first from the writable glossary in bold (with comment starting 

with MJM) and then the entries from other glossaries (in this case IATE) by alphabetical order 
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Translation Tips (TransTips) allows you to easily know what terms/strings have entries in the project glossaries.  
The terms/strings with a blue linear and bold underline mean that there is an entry in one of the glossaries (displayed in 
the Glossary pane) if you have this option activated and you have one or several glossaries in the \glossary folder of 
your project or in another folder you define.  

 
 Screenshot 107 — Display of glossary entries with entries from the writable glossary displayed first.  

 
As shown in the screenshot above, a different entry is created if the same term (in this example renewable energy 
sources) is in upper or lower case or in the singular or plural, but they are all displayed both in the Glossary pane and 
in TransTips.  
The lemmatizer works — not always but frequently — and displays the several entries. 
To insert terms from TransTips, just right-click the mouse on the term you want and click on one of the options displayed 
in the dropdown list and it will be inserted in the target segment in the Editor pane at the place the cursor was when you 
left it or will replace the words in your target segment if you have highlighted them first.  
In the dropdown menu you can further select to Add a glossary entry to the project writable glossary and also have 
other features that are explained in other Sections of this Guide. 
If you do not want to see TransTips’ blue lines, in the Options → Glossary menu, uncheck the box Enable Transtips. 
The glossary pane will continue to display the entries in the glossary(ies) but they will not be marked with a blue linear 
underline in the open source segment.  
In this menu you can also select to have TransTips only for exact matches.  
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One of the options of the new OT Auto-completion feature is that you can insert — in the target segment open in the 
Editor — terms in your glossaries in the target language field. 
To use the Glossary feature in Auto-Completion, press Ctrl+space and cycle through the options by repeatedly 
pressing it or pressing Ctrl+Page Down/Page Up to select the desired option: Glossary entries.  
By default, the terms in the project glossaries will be displayed with the source term and target term by alphabetical 
order.  

 Part K on Auto-Completion for information on how to change the display. 
With the Up and Down arrows, you can select the term you want and press Enter. The selected term will be inserted at 
the position of the cursor in the target segment in the Editor. 
You can use this feature in several ways: 
1 — Display all the terms in the glossaries for a particular segment: If you have a target segment empty (without 

any match from translation memories nor MT output), just press Ctrl+space (cycle through if necessary) to 
display all the entries in all the glossaries for that particular segment. 

 
 Screenshot 108 — Display of all the entries in all the glossaries via the Auto-completion feature. 

2 — Display only of terms beginning by a certain character or string: If you write a character (or more) and press 
Ctrl+space, only the entries beginning with that/those characters in the target language will be displayed in the 
dropdown menu. 

 
 Screenshot 109 — Display of the entries beginning by a certain character (in the target language) in all the 

glossaries via the Auto-completion feature. 
 

 
 Screenshot 110 — Display of the entries for the same term but beginning by a string of characters (not one) 

in all the glossaries via the Auto-completion feature. 
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3 — Continuous display of all the glossary entries as you type or move the cursor: When you press Ctrl+space 
(displaying the Glossary entries), you can keep seeing the entries as you type — or move the cursor — until you 
choose to insert a term from the Auto-completion list by pressing Enter. 

  When you select an entry from the Auto-completion list, the drop-down menu will close down. Just do 
Ctrl+space again to continue having auto-suggestions from the project glossaries. 

If you have project-specific glossaries for complex technical projects, this auto-completion from glossaries feature can be 
very useful — both for translating and for revising — as it can save you a lot of time in terminology search. 
The only drawback is that you don’t have the 3rd field — sometimes with important information — displayed. But you can 
have the Glossary pane side-by-side displaying that additional information. 

 
 Screenshot 111 — Display of the entries in all the glossaries via the Auto-complete feature (without 3rd 

field) and in the Glossary pane (with 3rd field, if any). 
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You can also use the Auto-text entries feature of Auto-Completion to insert text from a list of auto-text entries that you 
may which to use or to create. 
As with the Glossary entries feature of Auto-Completion, you can also have the Auto-text entries continuously 
displayed while you type … and as long as you don’t insert an auto-text entry from the list. 
When you do, the dropdown list disappears. Just press Ctrl+Space again and it will be displayed again. 
 
 

 
 Screenshot 112 — Display of auto-text entries via the Auto-complete feature. 

 Section K.3. for information on how to add or delete entries in the Auto-text list.  
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In DGT, translators can create entries directly in IATE or add comments to existing entries. 
It is this interactive capacity that gives IATE its name: Inter-Active Terminology for Europe! 
You can manage terminology issues combining, on one hand, the glossary and notes feature of OmegaT and on the 
other IATE. i.e., terminology in a particular project can be “digested” within OT and maybe at a certain point it will be 
worthwhile to make an IATE entry with that information. 
The translator can also “communicate” terminology problems/solutions to the Language Department Terminologist who 
will process those entries. 
Whatever the option chosen, DGT translators contribute to IATE ... either directly or indirectly. 
 

1 — IATE is not a “shoe box” or personal file for collecting terminology. For that we have the glossary(ies) in OT. 
2 — IATE is about quality, not quantity. Its purpose is not to record/justify all the (dozens, hundreds of) terminological 

decisions a translator makes during the translation of a project, but to single out those that, according to the 
translator: 
Ø Might need further study or the opinion of others on the long run, 
Ø Might deserve clarification, 
Ø Were the object of (some) research (neologisms or problematic terms) which would be of interest to 

share with others, 
Ø Could be proposed for harmonisation. 

3 — An IATE entry must have added value (information) beyond what is obtainable from Euramis matches. 
4 — An IATE entry should normally contain, besides the source and target terms:  
 a)    Domain(s) (mandatory) 
 b) Problem language (important for IATE) (mainly EN/FR for us) 
 c)  Context and/or definition (which, with Internet, is normally possible to find and use (copyright 

restrictions?) 
 d)  Note with explanation of problems it raised, eventually with variants (full and partial synonyms) 

examined/found in the target language and reasons for the choice made   
 e) Related terms (if any) 
 f) Confidentiality (Default: public) 
 g) Synonyms, if any 
5 —  Translators should not be overburdened and validation must be a real added value 

Validation is essential, especially in cases where tentative translations are proposed and used, which require 
further study.  
This happens frequently with non-legislative documents (long reports, communications, working programmes, 
etc.) with a significant amount of new terminology (really new concepts or new terms in Community documents) 
for which there may not be time to make thorough consultations. The reward for the work done by the translator 
in adding these new entries to IATE will be that the next time he/she has the same term to translate, some 
expert may already have provided a better solution or validated the translator’s initial proposal.  
The situation is different with legislative proposals, for which this validation must be carried out before the 
translation of the document is released.  

6 — IATE must satisfy, above all, the needs of the translators of the European Institutions and, more specifically, the 
needs of the institution feeding it (which may vary significantly): Legislative texts and other documents 
translated by the Commission are terminology sources for other institutions and the general public. However, for 
DGT translators (who produce the translations) what is of interest is the upstream process that leads to the 
choice/use of a particular term in the target language.   
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To access IATE’s full interface, just click on the IATE icon or press Ctrl+Shift+L. 
The easiest way is to create a new entry is to use the Basic interface by selecting it in Data Manipulation → Create 
Entry → Basic. 

 
Screenshot 113 — IATE basic interface to create new entries 

You can use the information you collected in the OT glossary or in an OT note and copy/paste it in the relevant fields:  
q Domain — this is a mandatory field as IATE is a concept-oriented database.  

If in doubt, just choose — from the Level 1 dropdown menu — the general domain. In the validation process, 
the terminologist will check and correct it if necessary. 

q Source and target term — mandatory fields, of course 
q Other fields: provide as much information as you can. 

When you finish, just click on Save. The entry is automatically sent for validation. 

 IATE Help for detailed information.  
 

 
Screenshot 114 — IATE basic interface to create new entries 
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You can also add comments to an existing entry by clicking on Add Marks at the bottom of the IATE window displaying a 
particular entry and: 
q Selecting the kind of problem from the dropdown list — normally form, content or merge/deletion 
q Selecting the relevant addressee(s) — normally your Language Department Terminologist, in my case Term PT 

and  
q Writing your comment 

 IATE Help for detailed information.  
 

 
 

Screenshot 115 — Adding comments to an existing IATE entry
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You may want to write notes — in the Notes pane — about a particular segment while translating it.  
By default, a segment with notes is highlighted in pink when that segment is not open. When it is open, the note is 
displayed in the Notes pane and the segment is not highlighted in pink. 
If you don’t want the notes to be displayed in pink, in the View menu untick the option Mark Segments with Notes 
If you want to delete a note, just delete all the text, including spaces, in the Notes pane. The note will be deleted and the 
segment will no longer be highlighted in pink. 
You now have 2 new DGT-specific shortcuts — Ctrl+Shift+A and Ctrl+Shift+B — to easily Go To the Next Note and 
the Previous Note, respectively, and opening the relevant segment for editing. 
 

 
Screenshot 116 — Notes displayed marked with a pink background in the Editor pane when that segment is not 

open and when it is open, the note is displayed in the Notes pane. 
 

If you want to generate a list of all your notes, for example to give to, or discuss with, your reviser/terminologist a list of 
problematic terms/segments, press Ctrl+Shift+F6 or select the Write Notes to File script in the Tools → Scripting 
menu.  
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Screenshot 117 — List of notes (with source and target segment), by document in the project 
The list containing the notes, by document, is displayed as a table with 3 columns — notes, source and target segments 
— and automatically saved as a html file in a new subfolder (\script_out) automatically created in your project folder 
with the name of your project followed by “notes”. If you want you can copy/paste it to a Word or Excel file. 

   Every time you run that script, OT will save a new file, with the same name, in the same folder and it will replace 
the previous one, if any.  

 So, if you want to keep a list of notes, open the project folder and rename this file or move it to another location. 
Then you can run the script again without losing the previous one.  

 

You can also export only certain project notes into a list using another script available under Options → Scripting: 
Write Query Notes to File (Ctrl+Shift+F10).  
By default, if you precede some notes of the term <query> at the very beginning of the note, when you use this feature 
OT will export to the project \script_out subfolder only those notes, by document if it is a multi-document project. 
The list is displayed as an html table with 4 columns — source and target segments, query with your note and a column 
for reply. 

 
Screenshot 118 — List of some notes (with source and target segment), also with a column for replies, by 

document in the project 
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You can also have different sets of notes for different purposes. For instance, notes for the reviser, notes for the 
terminologist, notes to list the words that must be formatted in italics in the translated document in the native 
application... 
In the project used in the example below, there are many segments which have words that in PT must be in italics but 
which are not so in the source segment. As in OT it is not possible to add formatting in the target segment that does not 
exist in the source segment, it is now possible to generate a list with only a subset of notes concerning formatting. 
In this example, notes relating to formatting are preceded by <format> (instead of <query>). 

 
Screenshot 119 — Notes to be exported by subject. In this case to generate a list of segments with words with 

italics in target which are not in italics in source 
 
To extract a list with these segments, in Tools → Scripting, highlight on the left column the name of the Write Query 
Notes to File script to be able to write in the def search field — which by default is = ‘<query>’ — the subset of notes 
you want to export and click on Run at the bottom left of the menu. 
If you run the script by clicking on the number of the script below (<10>), with the shortcut Ctrl+Shift+F10 or selecting it 
in the Tools menu, OT will continue to generate all the notes as described in the previous Section. 

 This way you can have the best of both worlds!  
 

 
Screenshot 120 — Exporting notes by subjects 

 
This is the list generated for the notes preceded by <format> 

 
Screenshot 121 — Exported notes relating to formatting 
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Auto-completion is a new OT feature which allows you to complete words from glossaries (in your project) or auto-text 
(your own list of abbreviations for instance), to add (special/foreign language) characters and also to manage tags by 
pressing Ctrl+Space and cycling through the options with Ctrl+Page Up/Down.  

 Part L on Tags for information on inserting Missing tags from Auto-Completion. 
In Part I on Terminology was already explained how to use the Glossaries entries and Auto-text entries features of 
Auto-Completion. So, in this section are explained the customization options of these features and also how to use and 
customize the Character table.  
 

  

  

  

  
Screenshot 122 — Auto-completion features 
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In the present section is explained how to customize the Glossary entries using the options available in the Options → 
Auto-completion → Glossary menu → Auto-completer Glossary View configuration submenu. 

 Section I.5 for detailed information on using entries from glossaries with Auto-completion. 

 
Screenshot 123 — Auto-completer Glossary View configuration 

The options are self-explaining and you can change these settings any time you want according to your preferences. 
Below are presented the most interesting options. 
 

  
Screenshot 124 — Default display 

 

  
Screenshot 125 — Display changed to Show target term first 

 
 

  
Screenshot 126 — Display with Display source term deactivated  
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In the present section is explained how to customize it using the options available — in Options → Auto-completion 
→ Glossary — Auto-text View configuration submenu. 

 Section I.6. for information on using the Auto-text feature. 
In this menu you can add entries to a new Auto-text file, add new entries to an existing file, remove entries and load 
(other) existing Auto-text files. 

.  
Screenshot 127 — Auto-text configuration menu 

 
To add entries to a new Auto-text file:  
1 — In Options → Auto-completion, select the Auto-text configuration submenu 
2 — Click on Add to open a new entry and fill in, at least, the Shortcut and Full text fields. The field Comments is optional. 
3 — Click on Save and choose the location where you want to save your Auto-text file. 

    I suggest you save it in the _CONFIG-PERSONAL subfolder of the OmegaT_Projects folder. 
You can also choose to have the entries, if more than one, displayed sorted by length or alphabetical order. 
You can also edit the Auto-text file and write directly on it or copy (in a batch operation) a list of entries that you already 
have from another application or delete entries no longer needed. As it is just a text only file — UTF-8, you can easily 
change it. 
 

 
 

Screenshot 128 – What an auto-text file looks like in Word with some abbreviations (namely for non-breaking 
space, non-breaking hyphen, n-dash and m-dash) 
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You can add characters to the open segment in the Editor from the list available in Options → Auto-completion — 
Character table →Character table auto-completer options submenu. 
 
 

 
 

Screenshot 129 — Character table auto-completer options menu 
 
To insert — at the position of the cursor in the open segment in the Editor — a character from this list, just: 
1 — Access Auto-completion by pressing Ctrl+Space and cycling to Character table if necessary. 
2 — Select the character/symbol you want and press Enter.  
 

 
Screenshot 130 — Display of Character table for insertion of a character/symbol 

 in the segment open in the Editor. 
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Furthermore, you can also customize your character table with the characters/symbols you need more frequently. 
You can add characters to your personal list in Options → Auto-complete → Character table →Character table 
auto-completer options submenu: 
1 —  Tick Customize character table 
2 —  Double-click on the character/symbol you want to add to your personal list 
3 —  Click OK 
 

 
 

Screenshot 131 — Custom table with selected characters/symbols 
 
When you press Ctrl+Space, you will only see the characters/symbols you selected to the Custom table.  
 
 

 
Screenshot 132 — Display of the Custom Character table for insertion of a character/symbol 

 in the segment open in the Editor. 
If you want to have displayed the full list again, just click on Clear to delete all characters/symbols in your Custom table. 
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Tags are no longer a problem in DGT-OT with the in-house TagWipe (for Word documents) which eliminates almost all the 
useless tags that would otherwise clutter our documents. And tags in OT almost never block the creation of the target Office 
documents. 

By default, your document will be displayed with formatting codes (tags) that you can insert in the target segments in the 
Editor to have your document converted into its native application correctly formatted with all the bolds, italics, 
underlines, superscripts, subscripts and also the footnote numbers in the right position.  
In OmegaT, tags are not displayed as "what you see is what you get" (WYSIWYG). Tags are displayed in grey (Example: 
<t0/>) and do not indicate what type of formatting they represent, they are just numbered.  
The tags displayed are “inline tags” which are the only ones you will see and which concern formatting inside a segment. 
For all the formatting applied to the full segment (like a whole segment in italics, in a box, with style indents, etc.) you 
don’t see any tags. However, the final document will be properly formatted. 

 
Screenshot 133 — Display of single (in the second segment) and paired tags (in the third segment). 

There are single tags and paired tags which are not obvious as the numbering is continuous. To see which are the paired 
tags, you can use the Auto-completion feature and insert both tags at the same time. 
You also have to indicate with a tag, in the relevant segment, the place where the footnote number will be within a 
paragraph. However, the text of all the footnotes is displayed at the end of each of the documents for translation (much 
like end-notes) in the OT Editor.  
If you insert the footnote tag correctly, when the document is converted into its native format, the footnote number will be 
displayed in the correct paragraph in the correct position and the text of the footnote will be at the bottom of the right 
page.  
An easy way to see what inline tags really are — and how they affect the translated documents in the native 
applications — is to use the Remove Tags option as seen in the example in Figure 2 below. I translated a document with 
lots of formatting — bolds, bolds/italics, boxes, bullets, and style sheet formatting — with Remove Tags activated — and 
the formatting was converted correctly with the exception of:  
Ø The bold in "strategies on gender equality" and  
Ø The position of the number of footnote 45 within the paragraph.   
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Figure 2 — Example of a document translated without inserting the formatting (inline tags) in DGT-OmegaT with Remove Tags activated 
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There are several ways to insert tags:  
1)  Inserting next missing tag: OmegaT now offers the possibility to insert tags sequentially at the position of 

the cursor.  
So, to insert the first tag in a segment, just place the cursor in the position you want the first tag to be and 
press Ctrl+T. The first tag will be automatically inserted. Repeat the process for the following tags 
sequentially.  

  For me, most of the times this is the easiest and quickest way to insert tags. 
2) Inserting paired tags using Auto-completion: Also a new OmegaT feature. You can highlight the string 

you want to format in the open segment in the Editor, press Ctrl+space — cycle with Ctrl+space if 
necessary — and in the Missing tags dropdown menu, select the pair (or the tag) you want. 

 
Screenshot 134 — Inserting (paired) tags using Auto-completion 

3) Choosing each tag in the dropdown menu: Position the cursor where you want to insert the tag and click 
on the mouse right button and a dropdown menu will appear in which you can choose the tag to insert by 
clicking on it. 

 
Screenshot 135 - Insert tags via the dropdown menu 

 

4) Insert missing source tags: Press Ctrl+Shift+T to insert all the source tags at the position of the cursor in 
the target segment. If there is only one or several in a row, this is an easy way to do it.  

5) Icon: Click on the respective icon (Insert source tags); this is another way to insert all the tags (if more 
than one) in the target segment at the position of the cursor. 

6) Drag&Drop or Copy/Paste: Select the tag(s) on the source segment and drag and drop it/them — or 
copy/paste them — in the target segment of the Editor pane.  

Also a new feature is that, if you have a target segment from Fuzzy Matches with lots of tags, but the wrong ones or in 
the wrong places, you can just press Ctrl+Shift+F5 — the Strip Tags script in the Tools menu — and it will clean all 
the tags in the target segment and you can insert the tags on a “clean” segment. 
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 If you really hate to see tags, you can work without any tags at all in DGT-OmegaT by activating Remove Tags in the 
Project → Properties → Edit project menu and afterwards insert the formatting in the final document in its native 
application.   

 You can deactivate Remove tags at any time — as the tags in the original are not displayed, but they have not been 
eliminated.  
In normal documents it will just take you a few minutes to check/insert the formatting in an Office document, and it can 
even be done by the Secretariat.  

  I suggest that you don't switch from tags/no tags in the middle of the translation of a document/project, since 
tags affect segmentation and match rates and you will have previously translated segments that will become 
untranslated (orphans) as they will no longer have a 100% match in the project memory, due to the penalty for 
tags.  

 However, if you really want to switch from no tags↔ tags for some reason, those translated segments are not lost. 
They are in the project memory and will be displayed in the Fuzzy Matches pane as “orphan segments” when you 
open that segment. 
 

After finishing your translation, or at any time during the translation process, to check if OT detected any missing or 
wrong tags either: 

Ø Validate tags in your whole project: Pressing Ctrl+Shift+V or selecting Validate Tags in the Tools menu 
or clicking on the icon 16 (Validate tags), or  

Ø   Validate tags in your current document: A new OT feature is that now you can press Ctrl+Shift+J  
(DGT-OT specific shortcut) or select Validate Tags in the Tools menu  

By clicking on the number of the segment in the window that is displayed on the left, OT will jump to the segment in 
question and open it in the Editor pane and you can correct it if needed.  

 
Screenshot 136 — Tags validation by document or for the whole project  
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The Validate tags check is sometimes overcautious. There are tags that you may ignore... but others not!  
There are tags — apparently useless — for which it is better not even thinking of what they mean. Just insert them, in the 
same position, in the target segment or otherwise it may happen that your translated documents will not be generated. 
Always insert tags that are: 
Ø  At the beginning of the segment (probably due to poor segmentation). 
Ø  Before and after a full stop in the middle of a segment (also probably a segmentation problem or poor 

original).  
Be also careful: 
Ø  Not to repeat tags, i.e. not having more than one tag with the same number 
Ø  Not to miss a tag at the beginning or the end of a word formatted in bold, italics, underline, for instance.  

These are paired tags and, if one is missing, it may happen that OT will not be able to generate the document 
in its native application.  
On the other hand, if you don’t insert both paired tags, the only effect is that the formatting will be lost in the 
translated document in the native application. 

Ø  Not to miss a footnote tag as in that case the footnote — which you translated in OT — will not be in the 
created translated document in its native application.  
You can easily spot the footnote tags by hovering over them. 

 
Screenshot 137 — Description of a footnote tag 

 
However, if you are working with Remove Tags activated, the footnotes will be in the right place at the bottom of the right 
page and the number of the footnote will be in the right paragraph (at the end of the paragraph) … but maybe not in the 
right position. You will have to check and, if necessary, change it in the translated document in its native application. 
If you ignored other tags, the worst that can happen is having some formatting missing in the final document. 
If you create one or more translated documents and you cannot open them in their native application because there is 
an error, run Tag Validation again, correct the segments in which there are tags mismatches and create the translated 
documents again. 
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OmegaT uses the LibreOffice dictionaries for the spellchecking and language checker features. 
You can update your dictionaries with added or ignored words both in the Editor (for each segment) or with the 
Spellchecker feature (for the whole project or for a document). 
In DGT-OT, when you add learned or ignored words for the first time, 2 files are created in the _CONFIG-PERSONAL 
folder: — ignored_words.txt and learned_words.txt — for each language pair. 
The update is recorded in those language-specific “dictionary” files which are used for all your projects.  
 

For translators of the Portuguese Department:  
The LibreOffice speller is quite good but FLIP is the one we are using in case of doubtful interpretation of the Spelling 
Reform 1990 or of double spelling.  
Therefore, as the LibreOffice dictionary (used by OT) does not behave in exactly the same way as the Word dictionary, 
perform the spellchecking also in Word before giving your translation to the reviser and/or sending it to the requester. 
 

The words the LibreOffice dictionaries do not recognise are indicated with a red wavy line below them, just like in 
Office.  
If the speller indicates a misspelled or unknown word and if you want to see its suggestions, just right click over the 
word in question and choose the word in the dropdown menu that opens if you want to correct it with any of the 
suggestions displayed. 
You can also ignore or add a word to the dictionary by right-clicking on the word in the target segment open in the 
Editor and clicking on Ignore all or Add to Dictionary. 

 
Screenshot 138 — Example of a word misspelt/not recognised in the dictionary (in this case it is misspelled). 
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Grammar inconsistencies are indicated by blue wavy lines. Therefore, you do not have to explicitly call the speller and 
grammar checker. Just let the cursor a while over the word(s) with blue wavy underlining and the grammar suggestion 
will appear as a message in the target language of your project. 
 

 
Screenshot 139 — Example of a grammar suggestion given in the target language. In this case, it calls the 

attention to the fact that this word should be hyphenated. 
In the Options menu, you can deactivate the highlight of unknown words or grammar suggestion if you don’t want to 
see it in each open segment by unticking the option Language Checker. 
 

Furthermore, now you can check the spelling in all the documents of your project — with Ctrl+Shift+F7 or selecting 
that option in the Tools menu — and update your dictionaries of ignored or learned words.  
You also have some other options, the most interesting being the possibility to use the project glossary(ies). 
You can click on Ignore or Learn to add it to the relevant dictionaries or click on the number on the left column to 
correct a mistake in a particular segment. 

 Don’t forget to validate the segments you change with Return. 
 

 
Screenshot 140 — Spellchecker for the whole project 
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Using the script QA — Check Rules in the Tools menu (Ctrl+Shift+F3), you can check your documents for a series of 
possible errors: check for inconsistent numbers, shorter target, equal source and target, untranslated segments, etc. 
The options are self-explaining. You can check in the whole project or only in the current document and you can also 
check for spelling errors at the same time. 
By clicking on the segment number in the left column, OT will jump to that segment opening it in the Editor. 

 Don’t forget to validate the segments you change with Return. 
 

 
Screenshot 141 — Quality Check for the whole project — or for a document in the project — with multiple options 
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DGT translators can also use the free-ware version of XBench (version 2.9) which is installed in our computers. 
For DGT translators, ApSIC Xbench is interesting mainly for its Quality Assurance (QA) features: 
Ø Find untranslated segments 
Ø Find segments with the same source text and different target text 
Ø Find segments with the same target text and different source text 
Ø Find segments whose target text matches the source text (potentially untranslated text) 
Ø Find tag mismatches 
Ø Find number mismatches 
Ø Find double blanks 
Ø Find repeated words 
Ø Find terminology mismatches against a list of key terms 
Ø Execute user-defined checklists. 
Ø Spell-check translations 
Ø Checklists are user-defined searches that you can run in batch against your ongoing translation.  

For example, with check lists you can search for banned words or typical translator pitfalls. 
Although OmegaT QA already performs a substantial number of these quality checks, as you can see from the list 
above there are still some missing (in bold). 
So, if you want to do an in-depth quality check — particularly for large projects with several translators — it may be 
worthwhile to use XBench. 

 See the XBench Guide in XBench Help for detailed information. 
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For the revisers who don’t revise in the CAT tool, nothing changes. The generated translated documents can be used as 
usual, either printed or in electronic format. 
For projects in which the reviser wants to revise using DGT-OT, it is possible but with some manipulations as there is no 
automated workflow for the moment. 
In Section A.9 — Revising in DGT-OT in a nutshell ! — is described the simplest workflow for revision in the standard — 
and most frequent — situation in which a (single or multi-document) project is translated by 1 translator and revised by 1 
reviser and the whole project is sent for revision at the same time. 

That may be enough for all (the majority of) your projects… and in that case you don’t even need to read 
this section! 
In Section D.1.21. — Preparing a project for revision in DGT-OT — is further explained how the translator can prepare a 
project to be sent to the reviser, both with all the documents in the project or with only a part of them.  
In this Section is given a global and detailed explanation of DGT-OT features which are relevant for the revision process 
so that you can deal with different situations choosing the more adequate approach to your particular project and work 
method. 
Preparing projects for revision is, in fact, just a matter of moving/deleting and renaming some memory files. 
Both the translator and the reviser will be working in DGT-OT in the same “translation” mode with only a few small 
differences and they can communicate between them via:  

a) The Notes that can be added by either of them to particular segments. 
b) The project writable glossary, if any. 

 In the subsections below are presented: 
Ø The things to keep in mind so that you can choose the most adequate method for a particular situation. 
Ø Workflows to cover other frequent (or less frequent) situations in our complex work environment. 

But of course you are free to do it any other way that suits you. OmegaT is very flexible and simple to manage and maybe 
you will find a better way adapted to your particular project and context! 
The same workflow can be used, mutatis mutantis, for the revision of freelance translations, if tmx files are provided by the 
freelance translators.  
Take into consideration that, in OT, there are no track-changes in the (open or closed) target segment(s) displayed in the 
Editor. There are only track-changes in the segments displayed in the Fuzzy Matches pane which, in the revision stage, 
are from the “draft” translation that is being revised (displayed first for the same match rate) and possibly from other 
external memories. 
As it is possible to display track-changes in the target segments too, the translator who is checking the changes made by 
the reviser — to accept them or not — can see those track-changes in the Fuzzy Matches pane for the segment that is 
open in the Editor. 
Also take into consideration that, if you — as the translator — have the last word, you cannot accept some of the reviser’s 
changes and reject others in a particular segment. You can either accept all the changes made by the reviser or change 
manually the ones you don’t accept. Or you can also reinsert your initial translation (from the Fuzzy Matches pane) and, if 
adequate, do the partial changes to your initial translation manually. 
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To prepare a project for revision the translator can just copy the project used for translation and rename it; copy and 
rename the project memory and copy the project to a server location to be used by the reviser, as explained in Section A.9 
and this may satisfy most or even all of your needs. 
In these sections is explained how you can manage the revision workflow for more complex projects involving many 
documents/pages, several translators and sometimes several revisers with the translation and revision work being done in 
several stages (or in “cascade”) and frequently with several new versions while the documents are being translated. 
For those projects, it may be worthwhile to select only some documents of a project for revision, shuffle some memories 
around and delete files which are of no interest to the reviser.  
 

If you, as a translator, want to send for revision just one or some of the documents in a multi-document project, you can 
choose to extract — from the global project memory — just the segments present in the document(s) you want to send for 
revision. 

 This may be important if you have documents in different translation stages — some ready for revision and others 
still in a “raw” state — and you don’t want to give the reviser the global memory that may display, in the Fuzzy 
Matches pane, below 100% match segments in your project memory that are too “raw”. 

You can generate the individual document memory(ies) pressing Ctrl+Shift+F9 (or Tools → Create OmegaT Export).  
That/those memory(ies) are saved to the project \export-omegat folder and can be copied to the \tm\auto subfolder of the 
project for revision.  
 

 Section F.7. for more detailed information on Pre-Translation. 
1 — The translator or the reviser can copy any number of memories of documents for revision to the tm\auto subfolder 

of the project at any time — even during the revision process — and the 100% match segments (including 
formatting) from those memories will be transferred to the revision project memory. 

 Those segments will have the translated status and are displayed in the Editor pane with an orange background as 
auto-populated segments  if, in the View menu, the option Mark Auto-populated Segments is activated (the 
default) and if, in the Option → Editing Behaviour options menu, the option Save Auto-populated Status is 
activated too (also the default). 

    If you — either as reviser or as the translator who afterwards finalizes the project — don’t like to see the orange 
background, you can deactivate the option Mark Auto-populated segments in the View menu and the orange 
background will not be displayed.   

 You can reactivate it again later on, as long as you don’t deactivate the Save Auto-populated Status. If you do, 
that action cannot be undone and the auto-populated segments can no longer be displayed with an orange 
background. 
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2 — In the Fuzzy Matches pane will be displayed first the segment from the file(s) in the \tm\auto folder (the “draft” 
translation(s) in this case) and after that the segments from external memories, if any.   

 As OmegaT only keeps the last modified translation of each segment in the project memory, this way the reviser 
and the translator can always check the segments revised against the initial translation displayed in the Fuzzy 
Matches pane.   

3 — Lower than 100% matches will not be transferred to the project memory and will be displayed in the Fuzzy 
Matches pane like any other match, but will be displayed (for the same match rate) before other matches in the 
memories in the \tm folder, if any.  

   This may happen if a new version of a particular document has arrived while the project is already being revised 
and the reviser updates the project with the new version(s) and simultaneously revises and introduces the changes 
of the new version, something which can happen in our work environment. 

4 —  If more than one memory is copied to the tm\auto subfolder and there are several identical source segments with 
different translations (but which are not defined as alternative translations), OmegaT will transfer to the project 
memory the translation of the last occurrence in the last memory (alphanumeric order) in the tm\auto subfolder.  

 The other (conflicting) translations will be ignored. They will be displayed in the Fuzzy Matches pane when that 
particular segment is opened.  

   This may happen in the case of projects with documents translated by 2 or more translators as in that case — even 
when working in share mode with TeamBase — inconsistencies may crop up in repeated segments in the global 
project which has been translated by different translators in separate OT projects. 

5 — To give priority to one or more memories, it is just a matter of renaming the memories in the tm\auto subfolder by 
(re)numbering them in an alphanumeric inverse order so that, in case of different translations for an identical 
(non-unique) segment in the project for revision, the translated segment transferred to the project memory comes 
from the (alphanumerically) last tm\auto memory (from the translator) to which priority is to be given 

 Example: If there are memories from translators A, B and C, to give priority to the segments coming from translator 
B in case of identical source segments, just rename the memories giving it the last number: 

   1–TRANSLATOR–A; 2–TRANSLATOR–C; 3–TRANSLATOR–B  
 and the translated segments from Translators A and C will be ignored and not transferred to the project memory. 

They will be displayed in the Fuzzy Matches pane like any other match, before segments in other memories in the 
\tm folder (if any). 

      This is the opposite of what is done when organising external translation memories to be displayed in the Fuzzy 
Matches pane or to be used with Search! 

     For large projects with several translators it may be important to establish the hierarchy of prevailing translation 
memories in the tm\auto folder if the documents (or part of a document) have some/many repeated segments 
(i.e. 100% identical including tags and — for alternative translations — segments with the same previous and 
next segments).  

6 — If there are (many) segments with alternative translations so defined, OT will take the previous and next segments 
of each alternative translation into account and transfer to the project memory the last occurrence in the last 
memory (alphanumeric order) in the tm\auto subfolder which has the same previous and next segments. 

  Keep in mind that, in DGT-OmegaT, "alternative translations" are document-independent by default, i.e. OT accepts 
that status for non-unique segments in all the documents of the project without “looking” at the number of the 
documents (which is recorded) and only “looking” at the previous and next segments. 

 The reason for this default in DGT-OmegaT is that frequently there are new versions of documents arriving during 
the translation or revision process and alternative translations from a previous version of a same document would 
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not be taken into account if the “alternative translations” were document-dependent as the number of the new 
version would be different. 

 If you want to make it document dependent, just go to the Options → File Filters menu and unclick the option 
Ignore File Context when identifying segments with alternative translations. 

7 —  If the reviser had already started the revision and adds another memory to the \tm\auto folder, only the 100% 
match segments (including formatting/tags) for segments that are not in the project memory already (in the 
\omegat subfolder) —  i.e. segments with the untranslated status — will be transferred to the project memory.  

 The segments already in the project memory have prevalence and will not be changed.  

 The only exception to this “rule” is if the enforce feature in OmegaT is used.  Section F.9. 
8 —  Keep in mind that any changes the reviser makes will be auto-propagated to all non-unique (repeated) segments in 

all the documents of the project unless the status of one or more instances of non-unique segments is set as an 
"alternative translation".  

 

1 —  The reviser can open all the segments or just the ones he wants to change (View mode with Display Source 
Segments activated).  

 Only the segments that the reviser opens and changes will be identified with his/her login and will no longer be 
displayed with an orange background. The others will remain with the login of the translator and with the orange 
background.  

2 — At the end of his/her work, the reviser can check the changed segments just by scrolling in the Editor and looking 
at the segments that are no longer with an orange background.  

3 — If the reviser wants to check the changes he has made with track-changes displayed, he can do it by ticking — in 
the Options → External TMX Options menu — the box View diff in target.  

 When he opens a revised segment in the Editor, the track-changes will be displayed in the target segments (from 
the “draft” translation being revised) in the Fuzzy Matches pane.   

    Don’t forget — after finishing the revision — to untick that box if you are afterwards going to do translation (and not 
revision) work. 

4 — If the reviser wants to quickly check the changes he has made — or if the translator wants to quickly check the 
changes made by the reviser — in large projects without having to scroll, they can filter those segments by doing a 
Search by: Regular Expressions (Partial segment) in the Memory only, writing a dot (“.”) in the field In 
translation and his login (respectively the reviser's or the translator's login) in the field Translator.  

 
Screenshot 142 — Searching and Filtering — by the reviser– of the revised segments, by login of the reviser 

(in this example machame-REVISOR) 
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  Don’t forget to tick the box in those 2 fields (and to untick them when you no longer need it). 
 Those segments are displayed in the Search window and the reviser or the translator can filter them for editing in 

the Editor or just click on the number of a particular segment to open it in the Editor. 
5 — The translator can open the segments changed by the reviser using the feature Go To Next/Previous Revised 

Segment (View menu) or with its shortcuts Ctrl+Shift+X and Ctrl+Shift+Y. 
With this feature, what OT does is go to and open the next/previous segment that is identified with the login of 
another user, which will normally be the reviser’s login.  

 The translator’s “draft” translation is displayed in the Fuzzy Matches pane and the track changes are 
automatically displayed in the target (and not in the source) segments. 

   Don’t forget to deactivate the Mark Revised Segments option if you are afterwards going to (continue to) 
translate a new project as this option will remain active, even in other projects, until you deactivate it. 

 
Screenshot 143 — Viewing the changes made by the reviser with the Mark Revised Segments feature 

 

 
Screenshot 144 — Searching and Filtering — by the translator (with Mark Revised Segments active) — of the 

revised segments, by login of the reviser (in this example machame–REVISOR).  
6 — If the translator used pre-translation from previous reference documents during translation, the pre-translated 

segments that he opened (or not) but didn’t change will continue to have the login of the translator, if any, in the 
memory from which they were pre-translated.  If the reviser doesn’t change those segments either, they will 
continue to have that same login.  

 In that case, when the translator is checking the reviser’s changes, the Go To Next Revised Segment (i.e. 
segments which has a different login from the translator) will also open those segments with logins from other 
translators in the memories used for pre-translation. 

  In that case it is better to see the changes made by the reviser using Search and Filter as explained above. 
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If you have a project with a number of documents, new versions and which is not sent for revision at the same time, it 
may be worthwhile to use a different workflow of the one explained in Section A.9. 
Here is explained in more detail a standard workflow for complex projects.  
 

In the original translation project (open in OT): 
1 — Close any generated translated documents from that project that may be open in their native applications. 
2 —  Generate the translated document(s) by pressing Ctrl+D. If your reviser wants the documents printed too, print 

them. 
3 — Copy the translated document(s) to Tradesk (using Tradesk Upload feature) so that they are available there to 

the reviser… and to everybody else. 
4 — You can also export any notes you may have written with the command Ctrl+Shift+F6 (Tools — Write Notes 

to File script) which will be saved in the \script_output folder generated in your project folder when you use 
this feature.  

 This way you can give the notes to the reviser on paper or in electronic format to discuss them. Anyhow, they 
will be displayed when the reviser opens a particular segment which has a note. 

5 —  Generate the project translation memory(ies) to be used for revision by pressing Ctrl+Shift+F9 (or Tools → 
Create OmegaT Export) and selecting the document(s) you want in the window that pops up.  

 OT will generate individual memory files — with notes and alternative translations, if any (but without orphan 
segments) — to the project \export-omegat subfolder. 

6 —  Close OmegaT. 
In Windows Explorer, with Ctrl+C and Ctrl+V, do a copy of your project (to that same OmegaT_Projects folder) and 
rename it (for instance {name-of-the-project}-FOR-REVISION). This way, your original project will remain intact and 
you can always reuse it if you want. 
In the copy of the project for revision: 
7 —  In Windows Explorer or via the DGT-OT Wizard, open the project folder. 
8 — Copy the memories generated in the \export-omegat folder to the \tm\auto folder.  
 You may want (it’s optional) to rename it/them (for instance, {name-of-the-document}-DRAFT) so that there is 

no doubt that these are memories before revision.  
9 — Open the \omegat folder and delete all the memories there. Usually there will be the project_save.tmx file and 

several backups (example: project_save.tmx.201503121120.bak or project_save.tmx.bak).  
 Leave the other files in this folder as they are. 
10 —  You can also delete files — translation memories (retrievals or reference alignments) in the \tm folder, MT 

output in the mt\ folder or any other files — that you consider of no interest to the reviser. 
11 —  Copy this project to a location on a server that you have agreed with your reviser or which is the location used 

in your Unit/Language Department to exchange projects (or to a USB key). 
12 — Inform the reviser that the project is ready for revision and indicate the location. 
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1 —  In Windows Explorer, copy to the OmegaT_Projects folder the project for revision prepared by the translator 
that was copied to the server (or copy it from the USB key provided). 

2 — Open the project as usual via the DGT-OT Wizard to have automatic backups every 10 minutes. 
3 — The process is the same as in translation mode. The only difference is that the documents are considered 

pre-translated and the segments are displayed in the Editor with an orange background to indicate that they 
were “auto-populated”.                                                                                          

4 —  You can open all the segments or just the ones you want to change (View menu with Display Source 
Segments activated). 

    Only the segments that you open and change will be identified with your login and will no longer be displayed 
with an orange background. The others will remain with the login of the translator and with the orange 
background. 

5 — In the Fuzzy Matches pane, you will see first the segment from the files in the \tm\auto folder (the “draft” 
translation) and after them the segments from external memories, if any.  

 As OmegaT only keeps the last modified translation in the project memory, this way you can always recheck the 
segments you revised against the initial translation displayed in the Fuzzy Matches pane. 

6 — You can see the Notes that the translator may have written and you can “communicate” with the translator 
writing your comment/answer or creating new notes.  

7 — You can also add or change entries in the writable glossary, if any.  
8 — At the end you can check the segments you revised just by scrolling in the Editor and looking at the segments 

that are no longer with an orange background and opening them and changing them again if necessary.  
9 — If you want to check the changes you have made with track-changes, you can — in Options → External TMX 

Options menu — tick the box View diff in target. Of course, you will have to open the segment to see the 
track-changes displayed in the target segment(s) in the Fuzzy Matches pane. 

   If you do that, don’t forget — after finishing the revision — to change again this setting if you are afterwards 
going to do translation (and not revision) work. 

10 — If you also want to quickly check the changes you have made and not scroll in the Editor if it is a big project — 
just filter those segments by doing a Search by regular expressions, writing a dot (“.”) in the field In translation 
and your login in the field Translator.  

    Don’t forget to tick the box in those 2 fields (and to untick them when you no longer need it). 
 Those segments are displayed in the Search pane and you can filter them for editing in the Editor or just click 

on the number of a particular segment to open it in the Editor. 
11 — When you finish the revision, rename the project (for instance, {name-of-the-project-REVISED). 
12 —  If you have the last word and you release the translation, just finalize your project sending translated documents 

to Tradesk and translated document memories to Euramis. 
13 — If the revised translation is to be finalized by the translator — or if you want to give the revised translation to the 

translator for information purposes only — copy the whole project to the same server location and inform the 
translator. 
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If you are the translator and you have the last word:  
1 — Copy to your computer the revised project from the server location.  
2 — Open the project as usual via the DGT-OmegaT Wizard to have automatic backups. 
3 — To easily see the segments that have been changed by the reviser, in the View menu activate Mark Revised 

Segments to have those segments marked with a red background. To see the changes made by the reviser, 
use the feature Go To Next/Previous Revised Segment (View menu) or the shortcuts Ctrl+Shift+X or 
Ctrl+Shift+Y. 

 OT goes to and opens the segment that is identified with the login of another user, in this case the reviser’s 
login. You can also do as explained in point 10 of the previous subsection to use the Search and Filter 
features. 

4 —  Accept the changes made by the reviser, reinsert your own translation from the Fuzzy Matches pane and/or do 
partial changes to any of them.   

5 — Finalize your project following the normal procedure.  
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If there are several documents in a project that are translated by different translators and that will be revised by a 
single reviser, the process can be adapted from the one described above. 
This case applies when the documents translated by several translators are individual documents or parts of a large 
split document.  
In the case of a split document, if the revision is to be sent to the translators and finalized by them, then the originals 
must be split into several original documents which will be merged later in the native application. 
If the reviser has the last word and finalizes the whole project, the original document(s) can be split or not. 
In this case, probably there will be a “coordinator” — probably the reviser — of the project who creates a TeamBase 
memory to be shared by the translators and organises the project: specific reference translation memories, glossaries, 
etc. and prepares the individual projects for each translator from a “general” project with all the documents (or divided 
documents) that will be revised together. 
The coordinator will also do the Match Statistics per File in order to have global match statistics between all the 
documents with information on repetitions so as to be able to split the work in the best way.  
Each translator will work in an individual local project, possibly working in share mode via TeamBase.  
 

The process can be done in several ways, but I think there is no point in having several projects prepared for revision. 
The simplest way is for each translator to: 
1 — Close any translated documents from that project that may be open. 
2 —  Generate the translated document(s) by pressing Ctrl+D or Ctrl+Shift+D  .  
3 — Copy the translated document(s) to Tradesk so that they are available there. 
4 —  Generate the project translation memory(ies) to be used for revision by pressing Ctrl+Shift+F9 (or Tools — 

Create OmegaT Export) and selecting the document(s) in the window that pops up.  
OT will generate individual memory files — with alternative translations and notes (but without orphan segments) 
— to the project \export-omegat folder. 

5 — Rename that/those project memory(ies), for instance: RTD-2014-80083-part1-DRAFT-{your login} so that they 
can be easily distinguished from the ones of your fellow translators working in that project. 

6 — Copy that/those memory(ies) to a server location (or send it/them by email) and inform the reviser. 
 

The process is similar to the one described in Section N.3 above — the standard workflow of a complex project — with 
the exception that: 
1 —  The reviser copies the export memory(ies) received from the translators to the tm\auto folder of a “global” project 

that s/he had already created as “coordinator” of that project or that was created by one of the translators and is 
made available in a server location and which has a descriptive name, for instance RTD-2014-70083-80084-
Global. 

2 — If there are repeated segments in the several documents translated by different translators (detected with Match 
Statistics Per File), the reviser may give priority to one or more translators as explained in the Subsection N.2.2.  

3 — If the reviser has the last word, just follow the normal procedure to send translations to Tradesk and memories to 
Euramis. 
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If the revised translation is to be finalized by the translator(s) — or if the reviser wants to give the revised 
translation to the translator(s):  
4 —  The reviser generates the revised translation memory(ies) to be sent to the translators by pressing Ctrl+Shift+F9 

(or Tools — Create OmegaT Export) 
5 —  The reviser selects the document(s) to be sent to the translator(s) in the window that pops up.  
  OT will generate individual memory files — with alternative translations and notes — to the project 

\export-omegat folder. 
7 — The reviser sends those individual memories to the translators for finalization or just for information purposes. 
 

The process is the same as described in Section N.3 — standard workflow — with the exception that you (as the 
translator) should: 
1 — In Windows Explorer, do a copy of your original project — as in this case you did not prepare a project for revision 

— and rename it (for instance RTD-80083-REVISED) 
2 — Copy the memory(ies) you received from the reviser to the \tm\auto folder for pre-translation purposes.  

If you want (it’s optional) rename it/them (for instance, RTD-2014-80083-REVISED) so that there is no doubt that 
it/they is(are) memories after revision. 

3 — Open the \omegat folder and delete all the memories there. Usually there will be a project_save.tmx file and 
several backups (example: project_save.tmx.201503121120.bak). Leave the other files as they are. 

4 — Copy the memory that you sent to the reviser — and that still is in the \export-omegat folder — to the \tm folder. 
      If you prefer, you can delete all the other reference memories in that folder so that you only see in the Fuzzy 

Matches pane the segments as revised by the reviser and your original translation. 
5 — If you have the last word, the rest of the process is the same as described in the standard workflow. 
If you just received the revised memory to be informed of the changes made, but it is the reviser that finalizes the 
document(s) and sends them to Tradesk (and the memory to Euramis), just follow the process if you want to see the 
changes that were made. 
 

If the documents in a project are not sent to the reviser at the same time, the reviser can continue using the same 
project, just by updating it manually. 
The process, seen from the reviser side, can be: 
1 —  The reviser starts the revision of a document in the project. 
2 — The reviser receives a new document for revision in the form of a translation memory sent by the translator. 
3 —  The reviser just copies that memory to the \tm\auto folder, giving it a priority or not, and the segments in that 

memory will auto-populate the “general” project memory (in the \omegat folder) but only for segments that are not 
yet in the memory … and provided the original of the document the memory refers to is already (or is copied) to 
the \source folder in the project. 

 Therefore, the segments already revised — if there are non-unique segments — will not be changed. 
4 — The reviser just resumes the revision within the workflow chosen for that particular project. 
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The revision of the documents (or parts of documents) in a (large) project can be made in a cascading way, i.e. the 
reviser revises a first document, then sends the revised memory to the translator and afterwards receives a second 
document (already with the revision of the first document taken into account) and so on. There may be one or several 
translators involved. 
In this situation, the reviser can continue using the same project, just by updating it manually. 
1 —  The reviser starts the revision of the first document. 
2 — The reviser revises the first document and the changes made are stored in the project memory (in the \omegat 

folder). 
3 —  After finishing revising the first document, the reviser uses the command Ctrl+Shift+F9 (or Tools — Create 

OmegaT Export) to generate a memory of the revised document, which will be saved in the script_output 
folder. 

4 — The reviser sends this memory so generated — and identified as revised — to the translator who will check the 
reviser’s changes and take them into consideration in the next document that s/he sends to the reviser. 

5 — The reviser receives a new document for revision in the form of a translation memory sent by the translator. 
6 —  The reviser just copies that memory to the \tm\auto folder, giving it a priority or not, and the segments in that 

memory will auto-populate the global project memory (in the \omegat folder) but only for segments that are not 
yet in the project memory … and provided the original of the document the memory refers to has been copied to 
the \source folder in the project. 

  Therefore, in case on non-unique (repeated) segments, the segments already revised will not be changed. 
7 — The reviser just resumes the revision work. 
8 — The process can be repeated if there are other documents to be revised in the same project. 

 
 
 
 
 
 

 
 
 
 
 
 



 

 

 
237 

 
 
 
 
 
 
 
 

 



 

 

 
238 

OT displays the segments in the translation memories — called external TMX — of your project which have matches with 
the currently open segment in the Editor pane (MT output is displayed in a different window and not mixed with human 
translation). 
In DGT, we have the IT Unit which takes care of these technical aspects. However, you may want to change some of these 
defaults, namely the way the DGT attributes are displayed in the Fuzzy Matches pane identifying each segment and if you 
want — in the revision/finalizing phase — to see the track-changes in the target segments too. 
 

  
 
 
 
 
 
 

 
 
  

Match display template which defines 
the way segments are identified in the 
Fuzzy Matches pane. See below. 

You can define here the attributes that will be displayed in 
the Fuzzy Matches pane. Just click on the icon to display 
the drop-down list of variables, select the one you want, 
position the cursor in the Match Display Template above 
and click on Insert. You can also write text to identify those 
variables.  See Section O.1.2 for a list of the  variables 
available. 

 

To see track changes in the target 
segments in the Fuzzy Matches pane 
for the revision phase. 
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These are the default attributes so that you can see where the results come from if you organize your translation 
memories by subfolders. 
 
 
DEFAULT ATTRIBUTES: 
 
${fileShortPath} ${initialCreationDate} 
Match: <${score}/${noStemScore}/${adjustedScore}%> — Source: <@{Att::Req. Serv.}–@{Att::Year}–@{Txt::Doc. 
No.}> — Translator: <@{Txt::Translator}> 
(${id}) —> ORI DIFF: ${diff} 
           TM TRA: ${targetText} 
_______________________ 

 
 
 
However, you may prefer to see less information or have it displayed in a different order. Here is an example of a 
minimalist display that you can easily copy/paste to the configuration window if you want. 
 
 
EXAMPLE OF AN ATTRIBUTES VARIANT if you want to see less information, for instance if you don’t 
organise memories by subfolders (example for the same fuzzy match segment). 
Just replace the text in the Match Display Template with copy/paste: 
 
Match: <${score}/${noStemScore}/${adjustedScore}%> — Source: <@{Att::Req. Serv.}–@{Att::Year}–@{Txt::Doc. 
No.}> — <Date ${initialCreationDate} > — Translator: <@{Txt::Translator}> 
(${id}) —> ORI DIFF: ${diff} 
           TM TRA: ${targetText} 
______________________ 
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On the other hand, you might prefer to have more information, for example, see displayed in the Fuzzy Matches pane the 
notes that you have inserted in the segments you translate in the project. 
 
EXAMPLE OF AN ATTRIBUTE VARIANT if you want to see more information, for instance if you want 
to see the notes of translated segments in your project displayed in the Fuzzy Matches pane. 
Just replace the text in the Match Display Template with copy/paste: 
 
${preamble}) - ${creationDate} - Source: <@{Att::Req. Serv.}-@{Att::Year}-@{Txt::Doc. No.}> - Translator: 
<@{Txt::Translator}> - Created by: <${creationId}> 
    ->  ORI: ${sourceText} 
    -> TRA: ${targetText} 
<Note>: ${note} 
_____________________________________________________ 
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In this section is explained the way the variables work so that you can customize the attributes as you wish. 
Variables prefixed by ${…} are based on standard attributes or mark-ups from the TMX file, while those prefixed by 
@{…} are TMX "properties", which mean that they may exist in some files and not in other ones.  
@{Att::…} and @{Txt:…} are typical from Euramis files and will not exist in the segments from the current project's 
memory.  
On the contrary @{file}, @{id}, etc. are Omegat's internals, which should normally not exist in tmx from the \tm folder, 
unless you copy here the project_save.tmx from another project. 
Here is the list of variables available: 
 

DGT Variable Description 
 ${id} The position of the segment in the matches list. Don't confuse with @{id} 

which is an OmegaT-internal feature. 
 ${note} The note, if any, can be displayed together with the segment for segments 

in the project memory or in the external memories. 
 ${sourceText} Source text of the match 
 ${diff} String showing the differences between the source and the match, i.e., 

new text in the segment in the Editor is displayed in the Fuzzy Matches 
pane in blue and text not present in the segment to translate is displayed 
in red with strikethrough.  
Hint: use this if the text you are translating has been updated.  

 ${diffReversed} As its name indicates, it shows the differences in a reverse manner —  
between the match and the source —, i.e. new text in the segment in the 
Editor is displayed in the Fuzzy Matches pane in red with strikethrough and 
text not present in the segment to translate is displayed in blue.  

 ${targetText} Target text of the match 

 
${diffTra} Track changes showing the difference between the target segment open 

in the Editor and the translation memory. Used when — after the 
document(s) have been revised — the translator sees the changes 
introduced by the reviser to accept them or not.  

 ${score} Match percentage taking into account tokenizers 
 ${noStemScore} Percentage without numbers and tags. Default OmegaT match — number 

of matched words — with numerals and tags ignored — divided by the 
total word count 

 ${adjustedScore} Percentage adjusted. OmegaT match, including numbers, tags 
 ${fileNameOnly} Name of the tmx file, without path nor extension 
 ${filePath} Full path of the tmx file 
 ${fileShortPath} Path of the tmx file starting from the root of \tm. 

Note: Important to keep it if you give priority and descriptive names to 
subfolders in the \tm folder. 
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DGT Variable Description 
 ${initialCreationId} Identical to ${creationId}, used by Omegat public version for historical 

reasons.  
 ${initialCreationDate} Identical to ${creationId}, used by Omegat public version for historical 

reasons. 
 ${changedId} The author of the last version of this segment (tmx standard attribute; 

modified by OmegaT when you modify a segment) 
 ${changedDate} The date of the last version of this segment (tmx standard attribute; 

modified by OmegaT when you modify a segment) 
 ${fuzzyFlag} Indicate that this match is fuzzy (currently only for translations from PO 

files with the #fuzzy mark)  
 @{file} Only for alternative translations  

The source file this segment comes from (only for project memory 
segments, not for external memories). Omegat-internal  

 @{id} Only for alternative translations  
For some file formats, such as Java Properties, the key used by 
software. OmegaT–internal. Don't confuse with ${id} which is related to 
the matches list. 

 @{prev} Only for alternative translations  
Only for document files (docx, odf, …) : the previous segment's text 

 @{next} Only for alternative translations  
Only for document files (docx, odf, …) : the next segment's text 

 @{path} Only for alternative translations  
For some file formats, such as PO, the key used by software. OmegaT-
internal. 

 
@{Att::Req. Serv} Identification of the requesting DG 

 
@{Att::Year} Identification of the year in the document 

 
@{Att::Doc. Type} Type of document as defined in Euramis 

 
@{Txt::Doc. No.} Number of the document 

 
@{Txt::Stored by} Person who translated or aligned the document 

 
<@{Txt::Translator}> Translator who translated the document. For Eur-Lex documents there 

is never a translator name 

 
@{Txt::TM Database} Euramis Database in which the translation memory is stored 
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The Search feature in OT is very complete and allows to search by a series of criteria.   
In DGT, this feature has been substantially improved with new features very useful for translators. 

 Part G for detailed information on the Search options. 
In this section are only explained the options to customize the Attributes display in the Search window (your 
preferences). 
You can change them any way you want by clicking on Configure format and choosing the variables — in the Match 
Display Template — ordering them the way you prefer. You can also easily change it any time you want.  

 
 
 
 
 
 
 
 
 

 

DEFAULT ATTRIBUTES: 
${preamble}) — ${creationDate} — Source: <@{Att::Req. Serv.}–@{Att::Year}–@{Txt::Doc. No.}> — Translator: 
<@{Txt::Translator}> — Created by: <${creationId}> 
    —>  ORI: ${sourceText} 
    —> TRA: ${targetText} 

 

You can define here the information that will be displayed 
in the Search window. Just click on the icon to display the 
dropdown list of variables, select the one you want, 
position the cursor in the Match Display Template above 
and click on Insert. You can also write text to identify those 
variables.  See Section O.2.2. for the list of variables 
available. 

 
 



 

 

 
244 

Here is the list of variables available, which is similar, but not identical, to the variables available for the Attributes 
displayed in the Fuzzy Matches pane. 
: 

DGT Variable Description 
 ${preamble} This is the beginning of the message in OmegaT-public: 

– for a memory segment, this is the number 
– for a tmx file, this is the file name. 

 ${creationId} The author of the first translation of this segment (tmx standard 
attribute) 

 ${creationDate} The date of the first translation of this segment (tmx standard 
attribute) 

 ${sourceText} Source text of the match 
 ${targetText} Target text of the match 
 ${note} The note, if any, can be displayed together with the segment for 

segments in the project memory or in external memories. 
 ${fileName} Name of the file, without the path but with the extension 
 ${fileNameOnly} Name of the tmx file 
 ${filePath} Full path of the tmx file 
 ${fileShortPath} Path of the tmx file name starting from the root of \tm.  

Note: Important to keep it if you give priority and descriptive 
names to subfolders in the \tm folder. 

 
@{Att::Req. Serv} Identification of the requesting DG 

 
@{Att::Year} Identification of the year in the document 

 
@{Att::Doc. Type} Type of document as defined in Euramis 

 
@{Txt::Doc. No.} Number of the document 

 
@{Txt::Stored by} Person who translated or aligned the document 

 
<@{Txt::Translator}> Translator who translated the document. For Eur-Lex documents 

there is never a translator name 

 
@{Txt::TM Database} Euramis Database in which the translation memory is stored 
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Here is a list of problems I already had to deal with together and ways to fix it … hopefully. 
If you cannot solve it … call for help! 
 

 
 

PROBLEM 
 

 
 

MAYBE 

 
 

TROUBLESHOOTING 

 
 

SEE SECTION 

The project has been 
created in the DGT-OT 
Wizard but OT gives 
an error and doesn’t 
open the project 

It is a problem with the 
TagWipe 

Create the project again in 
the DGT-OT Wizard with 
TagWipe unticked. 
If it is OK, work with 
Remove Tags activated … 
or ask for Help. 

 
 

The project — which 
had been working 
normally in other 
sessions — doesn’t 
open 

It is a problem with the 
omegat.project file 

Create a new project with 
any document and copy 
the whole project which 
has a problem to the new 
project with the exception 
of the omegat.project file 

See Section P.2. below 

Machine Translation 
and Translation 
Memories were not  
copied to the project 

Maybe you forgot to define 
the correct language 
combination 

If that is the problem, 
create the project again — 
with the correct language 
combination — with a 
different name.  

 

Machine Translation 
not  copied to the 
project 

The MT file was not 
generated because the 
language pair is not 
processed automatically or 
it is a multilingual project. 

Request MT from the 
MT@EC service directly 

 

Target documents not 
created 

You have one or more 
translated documents open 
in their native applications 

Check that there are no 
documents open and 
Create the Translated 
Documents again 

 

You deleted one or 
more files from the 
project by mistake 
and want to get them 
back 

 You can retrieve it from 
the H:drive where a copy 
of your project is kept or 
Restore it from the 
Recycle Bin 

See Section P.3. below 

You did a BIG mistake 
with Replace All and 
you want to do UNDO 

 You can use a backup of 
the project memory in the 
\omegat folder. 

See Section P.4. below 
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This is an essential file to open the project. If this file is corrupted, you will not be able to open the project and OT will 
display an error message. 

 If this file gets corrupted (something which happens very, very rarely in my experience) don’t panic!  
  A fast and practical way to solve this problem is to: 
1 — Create a new project with any document using the DGT-OT Wizard.  
2 —  Delete everything from that project except the omegat.project file.  
3 —  Copy everything from the old project to the new one… with the exception of the corrupted omegat.project file, 

of course!  
 
Hopefully, you will solve the problem painlessly! 
 

 

 

  If you delete, by accident, any file in a OT project, you can use the backup in the H:drive to get it back.  
 The backup that is done every 10 minutes only copies new files or modified files to the H:drive. It does not 

delete files — even if they have been deleted in your project. 
 The projects’ backup is here: H:\CAT\OmegaT_Projects. 

 Another way to retrieve deleted files is to Restore them from the Recycle Bin. 
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As OmegaT Undo/Redo feature only works within an open segment in the Editor, you will have to be careful when 
doing batch operation like Search/Replace or Search/Translate as, if you make a mistake, you cannot go back with 
Undo/Redo. 
So, suggest that you do a Save (Ctrl+S) before doing a batch operation. 

 In extremis — if you made a really BIG mistake — you can use a previous backup of your project memory 
stored in the project \omegat subfolder.  

The segments you translate in your project are saved in the project_save.tmx and OT does automatic backups — 
every 3 minutes — of that memory, which are identified by the year, month, day and hour and have the extension .bak. 

 
 

You can use a previous version of your project memory by: 
1 —  Renaming the project_save.tmx file (for instance, project_save-old.tmx). 
2 — Renaming (one of) the last backups before you carried out the problematic operation as project_save.tmx 
3 — Clicking on Reload. 
 
OT will read the new project memory — “forgetting” the last changes made — and updates the segments displayed in 
the Editor. 
You may lose some work, but not a lot and … hopefully … you will solve the problem in a few seconds/minutes.
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If you want you can change the shortcuts to suit your preferences. This is not covered in this Guide. 

the Appendix H of public OT Help for information on how to customize shortcuts. 
However, as DGT-OmegaT has DGT-specific shortcuts, here is a consolidated list with the public version and 
DGT-specific shortcuts. There is also the indication of the shortcuts that are still free. Not many! 
 

LIST OF SHORTCUTS ordered by shortcut 
 

 
DGT 

 
Public and DGT-specific features Shortcut 

 Select Previous Match Ctrl+↑ 

 Select Next Match Ctrl+↓ 

 Select Fuzzy Match 1 Ctrl+1 

 Select Fuzzy Match 2 Ctrl+2 

 Select Fuzzy Match 3 Ctrl+3 

 Select Fuzzy Match 4 Ctrl+4 

 Select Fuzzy Match 5 Ctrl+5 

 Select all Ctrl+A 

 Free Ctrl+B 

 Copy text Ctrl+C 

 Create Translated Documents Ctrl+D 

 Properties... Ctrl+E 

 Search Project... Ctrl+F 

 View Target File  Ctrl+G 

 View Source File  Ctrl+H 

 Insert Match Ctrl+I 

 Segment number... Ctrl+J 

  Search and Replace... Ctrl+K 

 Project Files... Ctrl+L 

 Replace with Machine Translation Ctrl+M 

 Next Segment Ctrl+N or Enter or 
Tab 

 Open Ctrl+O 

 
Previous Segment 

Ctrl+P or 
Ctrl+Enter or 
Ctrl+Tab 

 Quit Ctrl+Q 

 Replace With Match Ctrl+R 

 Save Ctrl+S 

 Next Note Ctrl+Shift+A  
 Previous Note Ctrl+Shift+B  
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DGT 

 
Public and DGT-specific features Shortcut 

 Export Selection Ctrl+Shift+C 

 Create Current Translated Document Ctrl+Shift+D 

 Euramis  Ctrl+Shift+E 

 DocFinder  Ctrl+Shift+F 

 Create Glossary Entry Ctrl+Shift+G 

 Free Ctrl+Shift+H 

 Insert source Ctrl+Shift+I 

 Validate Tags for Current Document Ctrl+Shift+J  

  Search Directory Ctrl+Shift+K 

 IATE  Ctrl+Shift+L 

 Source of selected match Ctrl+Shift+M 

 Forward in history... Ctrl+Shift+N 

 RTL–LTR switch Ctrl+Shift+O 

 Back in history... Ctrl+Shift+P 

 Quest  Ctrl+Shift+Q 

 Replace with source Ctrl+Shift+R 

 Register Identical Translation Ctrl+Shift+S 

 Insert Missing Source Tags Ctrl+Shift+T 

 Next Translated Segment Ctrl+Shift+U 

 Validate Tags Ctrl+Shift+V 

 Next Revised Segment  Ctrl+Shift+X 

 Previous Revised Segment  Ctrl+Shift+Y 

 Search and Pre–translate  Ctrl+Shift+Z 

 Close Ctrl+Shift+W 

 Open project folder Ctrl+Shift+1 

 Open glossary Ctrl+Shift+2 

 QA — Check Rules Ctrl+Shift+3 

 Show same segments Ctrl+Shift+4 

 Strip tags Ctrl+Shift+5 

 Write Notes to File Ctrl+Shift+6 

 Spellcheck Ctrl+Shift+7 

 Create Euramis Export  Ctrl+Shift+8 

 Create OmegaT Export  Ctrl+Shift+9 

 Write Query Notes to File Ctrl+Shift+10 

 Free Ctrl+Shift+11 
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DGT 

 
Public and DGT-specific features Shortcut 

 Free Ctrl+Shift+12 

 Insert Next Missing Tag Ctrl+T 

 Next Untranslated Segment Ctrl+U 

 Paste text Ctrl+V 

 Delete highlighted words Ctrl+X 

 Redo Last Action Ctrl+Y 

 Undo Last Action Ctrl+Z 

 User Manual... F1 

 Reload F5 

 Cycle Case To... Shift+F3 

 New Shift+Ctrl+N 
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This Annex is an excerpt of the Moses for Mere Mortals Tutorial and is meant for absolute beginners. If you are already 
familiar with Statistical Machine Translation, skip it. 
It was meant to present, in extremely simplistic terms, a general idea of what Moses does so that the several stages of 
using Moses via Moses for Mere Mortals (MMM) could be better understood.  
In this overview are used illustrations in presentations by Philipp Koehn available on the Internet and screenshots from 
Moses for Mere Mortals.  
 

SMT was a breakthrough in the field of Machine Translation with the publication of the seminal paper Statistical 
Phrase-Based Translation by Philipp Koehn, Franz Josef Och and Daniel Marcu in 20031. 
In 2007, the open-source Moses SMT system was first made available within EuroMatrix, a research project co-funded 
by the European Commission. 
As SMT is language-independent — i.e. it is possible to train whatever language pair without the long and consuming 
work demanded by rule-based MT — it soon became the basis for services like Google or Bing. 
The breakthrough was that it builds on the work done by the IBM Labs in the 90’s, evolving from word-based (Figure 1) 
to phrase-based models (Figure 2) … and that made all the difference! 
 

 
Figure 1 — Word-based Models 

  

                                                           
1  http://homepages.inf.ed.ac.uk/pkoehn/publications/phrase2003.pdf 

http://en.wikipedia.org/wiki/Moses_for_Mere_Mortals
https://github.com/jladcr/Moses-for-Mere-Mortals
http://homepages.inf.ed.ac.uk/pkoehn/publications/phrase2003.pdf
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Figure 2 — Phrase–based Models 

 
Very important also is that it became recently viable to have large corpora using a “by–product” of MT research: the 
Translation Memories. 
It is the training of these large corpora built from high-quality human translations — aligned as translation memories 
and later converted — that made possible Statistical Machine Translation. 
Therefore, there is in fact a synergy between human translation and machine translation.  
For professional translators, this can be a “virtuous circle”: machine translation is enriched with human translations 
(that are relevant for a particular domain) and, in turn, machine translation helps translators in their work. 

Parallel data is a collection of sentences in two different languages, which is sentence-aligned, in that each sentence 
in one language is matched with its corresponding translated sentence in the other language. It is also known as a 
bitext. 
To train MT engines with Moses you need (a large amount of) data. 
Now with the widespread use of CAT tools, translated documents are usually stored as translation memory files. 
Translation memories are bilingual files which contain the source segments and the target human perfectly aligned 
translation in Translation Memory eXchange format (tmx) files (Figure 3). 
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Figure 3 — Display of a tmx file 

These tmx files can be merged and subsequently split into 2 files with the application 
EXTRACT_TMX_CORPUS_1.043.EXE included in MMM. 
The resulting 2 files — one with the source segments and the other with the target segments — are perfectly aligned in 
text only (UTF–8) format (i.e., stripped of formatting). This is what a corpus looks like (Figure 4). 

 
Figure 4 — Bilingual corpus in UTF–8 format 
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Moses will process those files, in what is called a ‘training’ and will create what is called ‘MT engines’. When the 
training is finished you will be able to start translating with it.  
There are several corpora freely available which allow building MT engines for all the EU official languages and also for 
some other languages like Chinese, Arabic. 
You can add your domain-specific data to these corpora if you have it. If you don’t have your documents aligned you 
can use open-source tools like hunalign (http://mokk.bme.hu/resources/hunalign/) or LFAligner 
(http://sourceforge.net/projects/aligner/). 
Bilingual corpora can also be aligned at paragraph level, but it is generally thought that it is better to have them aligned 
at sentence (segment) level for MT purposes. 

Important concepts in SMT are tokens and n-gram units. 
Tokens are the basic unit in a machine translation process: tokens are a sequence of characters, such as words, 
punctuation or symbols, separated by a space. When the training is launched, the corpora are first tokenised. 
An n-gram is a subsequence of n number of (1, 2, 3, etc) items in a larger sequence. 
In a Language Model, n-grams are sequences of tokens. In MMM, you can choose the number of n-grams you want to 
use in a training. The default is 7, but you can use values between 3 and 9. Obviously, 7-gram Language Models take 
more time than 3-gram models and generate bigger files. 
In Phrase Tables and Reordering Tables, n-grams are sequences of pairs of source and target language tokens.  
In MMM, the default is 7, but you can choose values between 3 and 9. As for the Language Model, the higher the 
n-grams, the larger the Phrase Table will be, the more time it will take to generate the Phrase Table and the bigger the 
files will be. 
Depending on what you are using MT for, you may prefer speed to quality or vice-versa. 

To train MT engines with Moses you also need monolingual data for certain parts of the training to generate:  
i) the Language Model, which tries to ensure the fluency of the machine translation output 
ii) the Recaser Model so that the machine translation output has the right case in words that have 

capital letters.  
You can use the target language file of the bilingual corpus already extracted (see Figure 5). But you can also add to it 
texts in the target language of the language pair you want to train.  
Monolingual data is much easier to get just by converting documents into the txt (UTF–8) format to be used by Moses 
to generate the language model. 
  

http://mokk.bme.hu/resources/hunalign/
http://sourceforge.net/projects/aligner/
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Figure 5 — Monolingual corpus in UTF–8 format 

 

When you have the corpora, these must be processed by MMM/Moses. The steps involved may differ depending on 
the options concerning language model, tuning, etc.. However, in general terms and just to have an idea, these are the 
steps in a training with the IRSTLM language model: 

1) Corpus preparation: 
a. Tokenisation: insertion of spaces between (e.g.) words and punctuation. 
b. Lowercase data.  
c. Cleaning: long sentences and empty sentences are removed as they can cause problems. 
d. Furthermore, some characters that have proven to give problems are eliminated or converted. 

2) A language model (LM) is generated using one of the LM tools — IRSTLM (by default in MMM) or RANDLM;  
3) Word alignment: The training corpus — which is already aligned at segment level — is further aligned at 

subsegment level using a word aligner.  
In MMM, the word aligner is MGIZA++;   

4) A translation model (phrase table) is generated which contains phrase-to-phrase translations extracted from 
the training corpus; 

5) Other models are also generated like the Reordering and Recasing Models; 
6) Optionally, tuning can also be done to try to improve the quality of MT output; 
7) Optionally, it can also automatically score MT output with automatic metrics.  
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In MMM, are available the BLEU and NIST metrics. 

 
Figure 6 — Example of the report of a training of the 200 000 Demo corpus  (PT–EN) with the MMM defaults 

(without tuning) 
 

The phrase table is a kind of bilingual dictionary with probabilities computed during the training process. The phrase 
table is what is used by the system to try to guarantee the correctness of the translation, i.e. that “the black cat” is 
translated in the target language by its equivalent (“le chat noir”) and not by something like “le chat jaune”. 
Just to have an idea, a 3.4 million segment corpus (with 64.4 million words (EN)), which is available in the MMM 
website, can generate a phrase table with about 200 000 entries ... with different degrees of reliability (probabilities as 
computed during the training).  
Depending on the choice made, the Phrase Table may have entries with up to 9 grams. In MMM, the default is 7. 

 
Figure 7 — Extract of a phrase table of a 7-gram PT–EN training showing entries from 1 to 7 gram and the 

computed probabilities. 
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The Language Model calculates the probability of a word after a given sentence or the probability of a given sentence 
and is generated during the training process. It tries to guarantee the fluency of the MT output, i.e. that “Ich gehe nach 
Haus” is translated in the target language by “I am going home” and not by “I am going house” or something like that. 
Depending on the choice made, the Language Model may have entries with up to 9-grams, that is, a sequence of 9 
tokens (words, punctuation marks or symbols separated by a space). In MMM, the default is 7-grams. 
Just to have an idea, the same 3.4 million segment corpus can generate a 7-gram language model (vocabulary) with 
about 155 million entries. 

 
Figure 8 — Number of entries in a 7–gram Language Model of the 3.4 million segment corpus PT–EN 

This is what a language model looks like: 

 
Figure 9 — Entries in a Language Model from 1-gram to 7-gram (here shown extracts with 1, 3 and 7 n-grams) 

 
Moses supports several different language model toolkits (SRILM, KenLM, IRSTLM, RandLM). In MMM, are available 
the IRSTLM and RANDLM language models.  
KenLM is not available in this version of MMM and SRILM is not automatically downloaded and installed as it requires 
a licence for non-academic purposes. 
Training a Language Model from large/huge amounts of data can be memory and time expensive.  
The IRSTLM features algorithms and data structures suitable to estimate, store, and access very large LMs. 
RANDLM can be used to train really large LMs. It takes a very different approach to IRSTLM. It represents LMs using a 
randomized data structure. This can result in LMs that are ten times smaller than those created using the IRSTLM, but 
the quality of MT output can be lower, at least in our experience. 
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The Reordering Model will be used in the decoding (translation) process to try to get the words in a sentence translated 
in the correct order. For instance, to have the “the black cat” translated as “le chat noir” in French and not as “le noir 
chat”.  
Before the training, all words in the training corpus are lowercased. The Recaser Model is used to recase words so 
that, for instance, “Union Européenne” is not translated as “european union”.  

This is a process that can be done at the end of the training of a corpus and which aims to improve the quality of MT 
output. 
By translating a small tuning corpus (usually about 1000 to 2000 segments) repeatedly, the system will try to find the 
best weights between the components of a training (Phrase Table, Language Model and the other models) to achieve 
the best quality.  
MMM automatically installs 3 tuners: mert (MMM default), pro and kbmira and you can define the number of runs that 
will be done. 
A ‘run’ is the process by which Moses — the Decoder — translates the tuning corpus and afterwards scores it to see if 
it gets a better result. This operation is repeated as many times as defined in the training script.  
In MMM, the default is 25 runs, i.e., in the tuning stage, the tuning corpus will be translated up to 25 times, depending 
on the tuner used. 
This process takes quite some time and there is no assurance that the quality of MT output will be better than without 
it. 
 

Moses is the Decoder  (the “translator”) which translates new sentences by finding the highest scoring sentence in the 
target language in terms of exactness (according to the Translation Model) and fluency (according to the Language 
Model) from a list of candidate translations (the n-best list).  

 
Figure 10 — Example of an n-best list 



 

 

 
262 

It’s like making a puzzle. Some pieces are easier to fit than others! 
In SMT, sometimes Moses translates segments amazingly well — even difficult ones —... and sometimes its translation 
is plain rubbish!  
It all depends on a large number of factors, an important one being the relevance of the data the system has been 
trained with to the document(s) to be translated. 
A large amount of data is important, but equally important is to train the system with relevant (in-domain) data. 
In MMM, you can select some settings that may, or not, improve the quality of MT output for a particular language pair 
and type of documents to translate. 

The golden rule for MT output evaluation is human evaluation and there is lots of literature on that on the Internet.  
But there is nothing better than training a corpus and see how useful it is — in real terms — for your translation work! 
However, as for research and production purposes, human evaluation is time-consuming and expensive, various 
metrics (tests) have been developed to automatically score MT output.  
The BLEU score is one of the most widely used and it indicates how closely the word sequences in one set of data 
correlate with (match) the word sequences in another set of data, such as a reference human translation. The higher 
the score, the better.  
This means that if MT output is identical or near the human translation, the score will reflect it. However, it doesn’t 
always work the other way round as there are generally many different ways of translating a sentence and, just 
because the MT translation is (very) different from the reference human translation, it doesn’t necessarily mean that it 
is worse or incorrect! 
 

 
Figure 11 — The BLEU score — How it works 
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In MMM, the results are presented on a scale of 0 to 1 as generated by the scorer, but it is easier to think of it in a 
scale of 1 to 100. Therefore, a 0.5685 BLEU score may be read as a kind of percentage: 56.85. 
In MMM, it is also available the NIST score. 
To have an idea of the quality of MT output — as measured by the BLEU metrics, see the paper 462 Machine 
Translation Systems for Europe, by Philipp Koehn, Alexandra Birch and Ralf Steinberger (2009)2.  
SMT has evolved since then, but this gives an idea of how different the MT quality levels can be depending — among 
other factors — on the language combination.  
 

 
Figure 12 — Translating between EU official languages  

                                                           
2 http://www.mt-archive.info/MTS-2009-Koehn-1.pdf 

http://www.mt-archive.info/MTS-2009-Koehn-1.pdf
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